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Typographic Conventions 

Type Style Description 

Example Words or characters quoted from the screen. These include field names, screen titles, 

pushbuttons labels, menu names, menu paths, and menu options. 

Textual cross-references to other documents. 

Example Emphasized words or expressions. 

EXAMPLE Technical names of system objects. These include report names, program names, 

transaction codes, table names, and key concepts of a programming language when they 

are surrounded by body text, for example, SELECT and INCLUDE. 

Example Output on the screen. This includes file and directory names and their paths, messages, 

names of variables and parameters, source text, and names of installation, upgrade and 

database tools. 

Example Exact user entry. These are words or characters that you enter in the system exactly as 

they appear in the documentation. 

<Example> Variable user entry. Angle brackets indicate that you replace these words and characters 

with appropriate entries to make entries in the system. 

EXAMPLE  Keys on the keyboard, for example, F2  or ENTER . 
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1 Introduction 

The SAP Business One Administrator's Guide provides a central point of guidance for the technical 

implementation of SAP Business One. Use this guide for reference and instructions before and during the 

implementation project. 

For the latest information that may not appear in this guide, see the following SAP Notes: 

• SAP Note 2826255 (Central Note for SAP Business One 10.0) 

• SAP Note 2830129 (Release Update Note for SAP Business One 10.0) 

• SAP Note 2830158 (Collective Note for SAP Business One 10.0 Upgrade issues) 

• SAP Note 2830193 (Collective Note for SAP Business One 10.0 General issues) 

1.1 Application Architecture  

SAP Business One is a client-server application consisting of a fat client, a database server, and various services. 

The database stores only data and does not use triggers. However, the database does use views, especially for 

reporting and upgrade purposes. 

The following figure provides an overview of the server architecture of SAP Business One: 

 

SAP Business One Server Architecture  

The following figure provides an overview of the client architecture of SAP Business One: 

https://launchpad.support.sap.com/#/notes/2826255
https://launchpad.support.sap.com/#/notes/2830129
https://launchpad.support.sap.com/#/notes/2830158
https://launchpad.support.sap.com/#/notes/2830193
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SAP Business One Architecture 

1.2 Application Components Overview 

This section provides a description of the software components of SAP Business One and how they are used by 

the business processes of SAP Business One. 

 Server Components 

Some server components are essential to the system landscape and are thus mandatory, while the others are 

optional, and you can install them if there's a business need. 

Component Description Type Mandatory? 

SLD (System 

Landscape 

Directory) 

Authenticates users and manages an entire SAP 

Business One landscape. Precondition for all other 

components. 

32-bit Yes 

License Service Manages license requests. 32-bit Yes 

Extension 

Manager 

Manages deployment of lightweight add-ons. 32-bit No 
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Component Description Type Mandatory? 

Job Service Manages alert settings and SBO Mailer settings on the 

server side. 

The SBO Mailer allows you to send documents directly 

from the client application through email. 

32-bit No 

Workflow Service Enables you to implement user-defined business 

processes. 

32-bit No 

Data Interface 

Server (DI 

Server) 

Supports high-volume data integration and enables 

multiple clients to access and manipulate SAP 

Business One company schemas. 

32-bit No 

Repository Includes: 

• System database SBOCOMMON that holds system 

data, version information, and upgrade 

information. 

Unlike company databases, SBOCOMMON does not 

store any business or transactional data. 

• Shared folder B1_SHR that contains central 

configuration data as well as installation files for 

various client components. 

32-bit Yes 

Remote Support 

Platform (RSP) 

Proactively monitors the health of an SAP Business 

One installation and provides automated healing, 

backup support, and download of software patches. 

32-bit Yes 

Integration 

Framework 

A set of business scenarios that enable integration of 

the SAP Business One application with third-party 

software and mobile devices. 

The integration packages include: 

• Mobile Solution 

For more information about mobile scenarios, 

search for the user guide for the SAP Business 

Mobile app on SAP Help Portal. Note that there are 

different user guides for the iOS and the Android 

versions. 

• DATEV HR (Germany only) 

For more information about DATEV HR, see 

Leitfaden zur Personalabrechnung mit DATEV HR 

(German only) on SAP Help Portal. 

• Electronic Invoices (Mexico only) 

• Support for Document Approval (Portugal only) 

• Support for SAP Customer Checkout 

For more information, see the Integration with SAP 

Customer Checkout guide. To display the guide in 

the integration framework, choose Scenarios → 

32-bit No 

https://help.sap.com/viewer/index
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Component Description Type Mandatory? 

Control and for sap.CustomerCheckout, choose 

Docu. 

Add-Ons Add-ons are additional components or extensions for 

SAP Business One. 

SAP Business One provides the 64-bit add-ons as 

follows: 

Electronic File Manager Format Definition 

Microsoft Outlook Integration   

Payment Engine 

64-bit No 

Outlook 

Integration 

Server 

Includes Microsoft Office templates required for the 

Microsoft Outlook integration add-on. 

64-bit No 

Outlook 

Integration 

Standalone 

Standalone installer that allows you to install the 

Microsoft Outlook integration add-on without installing 

the SAP Business One client on your PC. 

64-bit  No 

 Client Components 

Component Description Type Mandatory? 

SAP Business 

One Client 

The application executable. You can also install the 

client application on a terminal server or in a Citrix 

environment. 

64-bit Yes 

SAP Business 

One Client Agent 

• Performs actions that require administrator 

rights on the local system (for example, 

upgrading the SAP Business One client and add-

ons). 

• Moves SAP Business One log files to the central 

log folder in the shared folder. 

 Note 

The client agent is part of the client 

installation process and is installed by 

default. 

32-bit Yes 

DI API Data interface API, a COM-based API and an 

applicative DLL file (OBSever.dll) that enables 

add-ons to access and use SAP Business One 

business objects. 

64-bit Yes 

UI API User interface API, a COM-based API that is 

connected to the running application and which 

enables add-ons to perform runtime manipulation 

64-bit Yes 
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Component Description Type Mandatory? 

and enhancement of the SAP Business One GUI and 

its flow. 

Software 

Development Kit 

Documentation and samples for the SAP Business 

One SDK. 

32-bit No 

DTW Data transfer workbench which enables importing 

and updating data in large volumes. 

64-bit No 

SAP Business 

One Studio Suite 

An integrated development environment based on 

the Microsoft .NET Framework, which supports you 

in developing extensions on top of SAP Business One. 

64-bit No 

Solution 

Packager 

A tool for packaging your industry solutions for fast 

deployment. For example, you can package your 

user-defined tables and fields, queries, reports, and 

configurations, and then use the package to create 

new, but pre-configured, companies in SAP Business 

One. 

64-bit No 

 Note 

If you intend to install the SLD Agent on the server or workstations, you need to run the Components 

Setup Wizard. For more information, see Manually Installing SLD Agent Service. 

1.3 Downloading Software  

Download the SAP Business One product package (installation package or upgrade package) from the SAP 

Support Portal, as follows: 

 Go to the SAP Business One Software Download Center on the SAP Support Portal at 

https://support.sap.com/en/my-support/software-downloads.html. 

 Do one of the following: 

 To download an installation package, click Installations & Upgrades. 

 To download an upgrade package, click Support Packages & Patches. 

 Navigate to and select the relevant download objects. 

 Note 

The package may be divided into several download objects. In this case, select and download all objects 

under the same patch level designation. 

 Add the selected objects to the download basket. 

We recommend that you read the Info file for the selected download objects. 

 Download the selected objects from your download basket. 

 Extract files from the downloaded objects (archives) to your computer. 

If you experience problems when downloading software, send a message to SAP as follows: 

 Go to the Support Launchpad for SAP Business One on apps.support.sap.com/B1support/index.html. 

https://support.sap.com/en/my-support/software-downloads.html
https://apps.support.sap.com/B1support/index.html
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 In the left Customer/partner result list, select your company. 

 In the right navigation panel, click Incidents Create. 

 On the Report an Incident page, write the message and assign it to component SBO-CRO-SUP. 

1.4 Related Websites 

Website Name Website Address Access Permission 

SAP Help Portal • Generic address:  

https://help.sap.com/viewer/index 

You can search across all SAP 

products on this web page. 

• Address for SAP Business One product 

line: 

https://help.sap.com/viewer/p/SAP_

BUSINESS_ONE_PRODUCT_LINE 

You can find all products that belong to 

the SAP Business One product line on 

this web page. 

 Note 

Through selecting the product page, 

you can get an overview of all available 

documentations for a specific product. 

You. You may then filter by version and 

language. 

Access to SAP Help Portal is free.  

You can log on to SAP Help Portal 

with your S-user account to access 

documents that are not available to 

the public. If you do not have an S-

user account, contact your SAP 

Business One partner. Partners can 

request S-user accounts for their 

customers via Support Launchpad 

for SAP Business One. 

SAP Partner Edge • Generic address: 

• https://partneredge.sap.com 

• Address for SAP Business One product 

line: 

https://partneredge.sap.com/en/pro

ducts/business-one/about.html 

Only an SAP partner can access the 

SAP Business One area on the SAP 

Partner Edge web page.  

SAP partners need to register on the 

home page when logging in for the 

first time; and need to select SAP 

Business One in their profile to 

ensure they can get the latest 

information about SAP Business One 

on their home page. 

Support Launchpad 

for SAP Business One 

https://apps.support.sap.com/B1support 

Easy access to SAP Business One support 

applications, such as incident creation, 

SAP Note search, user and system 

management or license key requests. 

To gain access to the Support 

Launchpad for SAP Business One, 

you must be an SAP Business One 

customer or partner, and you need 

an S-user account. If you do not have 

an S-user account, contact your SAP 

Business One partner. 

https://help.sap.com/viewer/index
https://help.sap.com/viewer/p/SAP_BUSINESS_ONE_PRODUCT_LINE
https://help.sap.com/viewer/p/SAP_BUSINESS_ONE_PRODUCT_LINE
https://partneredge.sap.com/
https://partneredge.sap.com/en/products/business-one/about.html
https://partneredge.sap.com/en/products/business-one/about.html
https://apps.support.sap.com/B1support
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2 Prerequisites 

• For information on hardware requirements, see the SAP Business One Hardware Requirements Guide on SAP 

Help Portal. 

• For an overview of support platforms for SAP Business One and related products, see the SAP Business One 

Platform Support Matrix on SAP Help Portal. 

• For information about platform availability, including database platforms and operating systems, see the 

Product Availability Matrix on SAP Help Portal. 

• For compatibility information regarding SAP Business One and SAP Business One Cloud, see SAP Note 

1756002. 

• You have installed one of the following Microsoft operating system versions:  

o Windows 10 

o Windows Server 2016 

o Windows Server 2019 

• You have installed Microsoft SQL Server 2017. 

• You have installed Microsoft ODBC Driver 13.1 on the server as well as on the client workstations: 

 Note 

Workstations that have Microsoft SQL Server installed have already had the SQL Server drivers installed 

automatically. However, you should manually install the SQL Server drivers on workstations that do not 

have Microsoft SQL Server installed.  

• You have installed Microsoft .NET Framework 4.5.2 or the higher version in CLR4 on the server as well as on 

the client workstations. 

 Note 

If you do not have Microsoft .NET Framework 4.5.2 (or the higher version in CLR4) installed, it is installed 

during the SAP Business One installation process. However, you will have to restart your machine. To 

avoid a restart, you may choose to install the framework before starting the SAP Business One 

installation.  

• If you want to access the System Landscape Directory service, be sure to use one of the following Web 

browsers: 

o Microsoft Internet Explorer 9 or later 

o Mozilla Firefox 9 or later 

o Google Chrome 12 or later 

• If you want to access SAP Business One in a Web browser, be sure to use one of the following Web browsers: 

o Mozilla Firefox 

o Google Chrome 

o Microsoft Edge 

o Apple Safari (Mac) 

https://help.sap.com/viewer/index
https://help.sap.com/viewer/index
https://help.sap.com/viewer/index
https://help.sap.com/viewer/index
https://launchpad.support.sap.com/#/notes/1756002
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• To display dashboards in the SAP Business One client application, ensure you have installed Adobe Flash 

Player for the embedded browser Google Chrome on each of your workstations. You can download Adobe 

Flash Player at http://www.adobe.com. 

Note 

The download link provided by Adobe is by default for Microsoft Internet Explorer. To download Adobe 

Flash Player for other browsers, choose to download for a different computer, and then select the correct 

operating system and a Flash Player version for other browsers. 

• You have ensured that the names of the machines on which you want to install SAP Business One do not 

contain one or more non-standard characters (standard characters are letters, digits, and hyphens).  

Using non-standard characters in the name of a machine prevents it from being found on networks and 

causes the installation of SAP Business One to fail. 

2.1 Constraints 

You can run the SAP Business One for 31 days without a license. To continue working with the application after 31 

days, you must install a valid license key assigned by SAP. 

 Note 

If you are a partner, for more information about installing the license key, see SAP Business One License 

Guide on sappartneredge.com. 

The demonstration databases provided are not for productive use. The application supports 40 localizations in 

the demonstration databases. 

2.2 User Privileges 

The following table summarizes the requirements and recommendations for the group setup of the displayed 

operating system: 

Operation Operating System User Group  

 Recommended Minimum 

Client installation Microsoft® Windows operating 

systems 

 

Administrator Administrator 

Client upgrade Administrator Administrator 

Runtime Users Users 

 Note 

For more information about possible installer issues related to the user account control (UAC) in 

Microsoft Windows operating systems, see SAP Note 1492196.  

http://www.adobe.com/
http://sappartneredge.com/
https://launchpad.support.sap.com/#/notes/1492196
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3 Installing SAP Business One 

The overall installation procedure of SAP Business One is as follows: 

 On a Windows server, install server components.  

 On each workstation, install client components. 

 Note 

All SAP Business One components must be installed in the same LAN (local area network). For users 

outside the LAN of the server (for example, those using VPN connection), we recommend that you use a 

remote desktop to access the SAP Business One client instead of installing the SAP Business One client 

directly. 

For demonstration or testing purposes, you can install all components on the same Windows computer. You can 

also install the SAP Business One client on a terminal server or in a Citrix environment. 

3.1 Installing Server Components 

You need to install the following components on the server: 

• Server tools, including the following: 

o SLD, license manager, extension manager 

o Data interface server 

o Job service 

o Workflow service 

• Repository 

It includes the shared folder B1_SHR, the system database SBOCOMMON, and online help files in all supported 

languages 

• Demo databases 

 Note 

Only the installation package provides the option to install demo databases; the upgrade package does 

not. 

 Note 

The system database SBOCOMMON and demo databases can be installed also from the System Landscape 

(SLD) control center. For more information, see Performing Centralized Deployment. 

• Microsoft Outlook integration server 

• Remote support platform 

• Integration framework 

If you want to install the integration framework separately, navigate to the …\Packages.x64\B1 Integration 

Component\Technology folder and run the setup.exe file. 
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• Add-ons 

By installing the SAP add-ons as part of the server installation process, you register them to all companies on 

the server. If you do not install them now, you will have to register the add-ons manually later in the SAP 

Business One client. 

 Caution  

The SAP Business One installation creates a new SQL user and password. Do not modify or delete this 

user ID or password. They are essential for the correct operation of the SAP Business One application. 

Prerequisites 

• The installation computer complies with all hardware and software requirements. For information on 

hardware and software requirements, search for related information on SAP Help Portal. 

• You have administrator rights on the machine on which you are performing the installation. 

 Note 

For more information about possible installer issues related to the user account control (UAC) in 

Microsoft Windows operating systems, see SAP Note 1492196. 

• The host name of the Microsoft SQL Server does not contain any special characters, such as: & (ampersand), 

< (left angle bracket), > (right angle bracket), ” (double quotation mark), ' (single quotation mark), or _ 

(underscore). 

• Your Microsoft SQL Server has been installed with the following settings: 

• You have installed the Microsoft SQL Server database client on the machine on which you are performing the 

installation. 

• [For the Integration Framework] You have not yet configured a default Tomcat installation on your machine; 

otherwise, you cannot proceed with the installation. During the installation process, the setup checks for the 

following registry entry for 64-bit system, and if found, the setup terminates: 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software 

Foundation\Procrun2.0\Tomcat<version> 

Setting Description 

TCP/IP Enabled 

Service Account Use the built-in system account – Local System 

Authentication 

Mode 

Mixed mode (Windows authentication and SQL Server authentication) 

Collation Settings SQL collations – Dictionary order case-insensitive, for use with 1252 Character 

set, Accent - Sensitive (SQL_Latin1_General_CP1_CI_AS). 

 Note  

In some versions of Microsoft SQL Server, this collation may be 

available only for backward compatibility. 

https://help.sap.com/viewer/index
https://launchpad.support.sap.com/#/notes/1492196
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Procedure 

A setup wizard is used for installation as well as for upgrade. The following procedure describes how to install all 

server components (except for the remote support platform) in a clean environment where no SAP Business One 

components exist. 

 Note 

The installation of remote support platform is performed by a separate installation wizard. For more 

information, see Administrator’s Guide to the Remote Support Platform for SAP Business One. You can 

find the guide (RSP_AdministratorGuide.pdf) under ...\Documentation\Remote Support Platform\System 

Setup\ on the SAP Business One product DVD, or search for related information on SAP Help Portal. 

 Navigate to the root folder of the product package and run the setup.exe file. 

If you are using Windows 10, right-click the setup.exe file and choose Run as administrator. 

 In the welcome window, select your setup language and choose Next. 

 

 In the Setup Type window, select Perform Setup and choose Next. 

 

https://help.sap.com/viewer/index
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 In the Setup Configuration window, select New Configuration and choose Next. 

 

 In the System Landscape Directory window, select Install Local System Landscape Directory and choose Next. 

 

 In the New System Landscape Directory window, specify a password for the site super user B1SiteUser, 

confirm the password, and then choose Next. 

For details on which special characters are not allowed for a site user password, see SAP Note 2330114. 

 Recommendation 

For security reasons, you should set a strong site user password, at least as strong as that defined in your 

company’s password policy and change it frequently. For more information, see Managing Security in 

SAP Business One. 

For more information about site users, see User Types. 

https://launchpad.support.sap.com/#/notes/2330114
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 In the Database Server Registration window, enter the database server information as follows: 

 Specify the Microsoft SQL Server version. 

 In the Server Name field, enter the hostname or the IP address of the database server. 

To specify a local machine, enter localhost. Do not enter local. 

If your database server does not use the default TCP port "1433", you must add the alternative port (for 

example, 9033) to the server name as follows: SERVER_NAME,9033. 

 Do one of the following: 

o To use database authentication to validate access to the Microsoft SQL server instance, deselect Use 

Trusted Connection and then specify the database user name and password. 

o To use Windows authentication to validate access to the Microsoft SQL server instance, select Use 

Trusted Connection. 

 Recommendation 

Do not use a trusted connection unless for test or development purposes, as Windows authentication has 

the following limitations: 

o Windows authentication in SAP Business One is a server level configuration. All users on the same 

SAP Business One server can use Windows authentication to connect to Microsoft SQL Server. 

o Windows authentication requires you to maintain each computer added to the domain, while SQL 

Server authentication shares database users (such as sa) on the same SAP Business One server. 

o Windows authentication requires the Microsoft Windows account on which the SLD service runs to 

have administrative permissions on the database. 

Note: 

If you later change the password of the database user used to install the System Landscape Directory 

(SLD), the SLD will stop working. For more information, see the section Cannot change database user 

password for System Landscape Directory in Troubleshooting Security. 

 Choose Next. 
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 In the Component Selections window, select the appropriate components and choose Next. 

 

 In the Demo Database Selection window, select the required demo databases and choose Next. 

Note that demo databases are available only for installation packages, but not for upgrade packages. 
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 In the System Landscape Directory Service Preferences window, enter a valid PKCS12 certificate store and 

password, or select the Use Self-Signed Certificate radio button. 

Communication between the SLD and SAP Business One clients or DI API is encrypted using the HTTPS 

protocol, so a certificate is required for authentication. You can obtain a certificate using the following 

methods: 

o Third-party certificate authority – You can purchase certificates from a third-party global Certificate 

Authority that Microsoft Windows trusts by default. If you use this method, select the Specify PKCS12 

Certificate Store and Password radio button and enter the required information. 

o Certificate authority server – You can configure a Certificate Authority (CA) server in the SAP Business 

One landscape to issue certificates. You must configure all servers in the landscape to trust the CA’s root 

certificate. If you use this method, select the Specify PKCS12 Certificate Store and Password radio button 

and enter the required information. 

o [Not recommended] Generate a self-signed certificate – You can let the installer generate a self-signed 

certificate; however, your browser will display a certificate exception when you access the SLD server, as 

the browser does not trust this certificate. To use this method, select the Use Self-Signed Certificate radio 

button. 
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 If you selected to use trusted connection, another System Landscape Directory Service Preferences window 

appears. In this window, enter the credentials for a domain user. 

 

 For the integration framework, perform the following steps: 

 In the Integration Solution - Change Administration Password window, enter and confirm a new password 

for the integration server administrator account (B1iadmin). 

 Note 

For security reasons, we recommend that you provide the integration server administrator account 

(B1iadmin) to the system administrator only. 

 

 In the Integration Solution - B1i Database Connection Settings window, specify the following: 

o Server Type: Specify the Microsoft SQL Server version. 

o Server Name: Enter the hostname or the IP address of the database server. To specify a named 

instance, enter <hostname\<instance name> and leave the Database Port field empty. 
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o Port: Specify the port for the database server. 

o Database Name: Specify a name for the integration framework database. The default database name 

is IFSERV. 

o Database User ID: Enter the user name of a database administrator account (role: PUBLIC; system 

privilege: CREATE SCHEMA). 

o Database Password: Enter the password for the database administrator account. 

 

 In the Integration Solution - Additional Information window, do the following: 

o Enter the connection credentials. 

If you did not select to use a trusted connection (Windows authentication) for connections to the 

database server instance, specify an SAP Business One user account (B1i by default) and a 

password. This user account will be used for DI calls. 

 



 

24 

CUSTOMER  

© 2019 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Installing SAP Business One 

 

If you selected to use a trusted connection (Windows authentication) for connections to the database 

server instance, in addition to specifying an SAP Business One user account for DI calls and a 

password, enter also the user name and password of a database server administrator account. 

 

o Select the version of SAP Business One DI API to use. 

We recommend using the 64-bit SAP Business One DI API. For more information, see SAP Note 

2066060. 

If a version of DI API is not installed or is not selected for installation, that version of DI API is not 

available for selection. If no DI API is selected or installed, you cannot proceed with the installation of 

the integration framework. 

 In the Integration Solution - Scenario Packages window, select the corresponding checkboxes to activate 

required scenario packages. 

 

 In the Review Settings window, review the settings you have made and choose Next. 

This window provides an overview of the settings that you have configured for the setup process. To modify 

any of the settings, edit the values in the table. 

https://launchpad.support.sap.com/#/notes/2066060
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 In the Setup Summary window, review the component list and choose Setup to start the setup process. 

 

 In the Setup in Process window, wait for the setup to finish.  

 Depending on the results of the setup, one of the following windows is displayed: 

o Setup Result: Successful window: The wizard opens this window if the setup of all components was 

successful. To continue, choose Next. 

o Setup Result: Errors window: The wizard opens this window if the setup of one or more components failed. 

To continue, choose Next and then in the Restoration window, do either of the following: 

o Select the failed component and proceed to start the restoration process. 

o Choose Next to skip the restoration.  

 Note  

If the installation of remote support platform for SAP Business One fails, it does not affect the successful 

installation of SAP Business One. 
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 In the Congratulations window, choose Finish to close the wizard. 

Results 

You can now proceed to install client components on all workstations. 

An operating system user B1_Tech_User (repository access user) is created and used to move log files from 

client machines to a central log folder in the shared folder B1_SHR. You may change the user in the SLD by editing 

the server information. The user must be either a local user or a domain user that has write permissions to the 

central log folder (\B1_SHR\Log) and read permissions to the entire shared folder. 

The installation of remote support platform does not impact SAP Business One business processes. There is no 

technical dependency between SAP Business One and the remote support platform. 

3.2 Installing Client Components 

You can install the following client components on every workstation: 

• SAP Business One client application (together with SAP Business One client agent and DI API) 

• Software development kit (SDK) 

• Data transfer workbench 

• Solution packager 

• SAP Business One studio 

If you want to use the Microsoft Outlook integration features on a workstation without the SAP Business One 

client application, install the Microsoft Outlook integration component (standalone version). For more 

information, see Installing the Microsoft Outlook Integration Component (Standalone Version). 

 Note 

SAP Business One client components can be installed also from the System Landscape Directory (SLD) 

control center. For more information, see Performing Centralized Deployment. 

Prerequisites 

• The installation computer complies with all hardware and software requirements. For information on 

hardware and software requirements, search for relevant information on SAP Help Portal. 

• You have installed Microsoft .NET Framework 4.5.2 or higher version in CLR4.  

 Note 

If you do not have Microsoft .NET Framework 4.5.2 (or higher version in CLR4) installed, it is installed 

during the SAP Business One installation process. However, you must restart your machine. To avoid a 

restart, you may choose to install the framework before starting the SAP Business One installation. 

• You have installed Microsoft Visual C++ 2005 SP1 Redistributable Package. If it is not installed yet, you can 

install it during client installation.  

• You have installed Microsoft Excel. 

https://help.sap.com/viewer/index
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• If the machines on which the SAP Business One client and DI API run use an HTTP proxy for network access, 

you have added the System Landscape Directory server to the list of proxy exceptions. 

Procedure 

A setup wizard is used for installation as well as for upgrade. The following procedure describes how to install all 

client components in a clean environment where no SAP Business One components exist. 

 Navigate to the root folder of the product package and run the setup.exe file. 

If you are using Windows 10, right-click the setup.exe file and choose Run as administrator. 

 In the welcome window, select your setup language and choose Next. 

 In the Setup Type window, select Perform Setup and choose Next. 

 In the Setup Configuration window, select New Configuration and choose Next. 

 In the System Landscape Directory window, do the following: 

 Select Connect to Remote System Landscape Directory. 

 Specify the hostname or the IP address of the server where the SLD is installed. 

 Choose Next. 

 

 In the Site User Logon window, enter the password for the site super user B1SiteUser. 

This site user was created during the installation of the SLD. 
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 In the Database Server Connection window, enter the database server information as follows: 

 Specify the database server type. 

 In the Server Name field, enter the hostname or the IP address of the database server. 

 Choose Next. 

 

 In the Component Selections window, select the required client components and choose Next.  

 In the Review Settings window, review the settings you have made and choose Next. 

 In the Setup Summary window, review the component list and then choose Setup to start the setup process. 

 In the Setup in Process window, wait for the setup to finish. 

In the course of the setup, some additional wizards are displayed to guide you through the setup of 

corresponding components. 

 Depending on the results of the setup, one of the following windows is displayed: 
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o Setup Result: Successful window: The wizard opens this window if the setup of all components was 

successful. To continue, choose Next. 

o Setup Result: Errors window: The wizard opens this window if the setup of one or more components failed. 

To continue, choose Next, and then in the Restoration window, do either of the following: 

o Select the failed component and proceed to start the restoration process. 

o Choose Next to skip the restoration.  

 In the Congratulations window, choose Finish to close the wizard. 

Post-requisites for Excel Report and Interactive Analysis 

To use Excel Report and Interactive Analysis, you must do the following after the installation: 

• In Microsoft Excel, enable all macros and select to trust access to the VBA project object model. 

For instructions, see the Microsoft online help. 

• If the user who installs Excel Report and Interactive Analysis (user A) is different from the user who uses Excel 

Report and Interactive Analysis (user B), user B must start Excel Report and Interactive Analysis from the 

Windows menu the first time. After having done so, user B can start Excel Report and Interactive Analysis 

directly from within the SAP Business One client or from the Windows menu. 

If you have installed Excel Report and Interactive Analysis to a folder that is not in the ProgramFiles directory 

(default installation folder), you must perform some additional steps before using the function. 

3.3 Installing the Microsoft Outlook Integration Component 
(Standalone Version) 

The Microsoft Outlook integration component enables you to exchange and share data between SAP Business 

One and Microsoft Outlook. This component is a standalone version that does not require the SAP Business One 

client to be installed on the same computer. 

If you want to use the Outlook integration features on a computer on which you have installed the SAP Business 

One client, you can install either the Outlook integration add-on or the standalone version. For more information, 

see Assigning SAP Business One Add-Ons. 

 Caution 

The Microsoft Outlook integration component is a standalone version of the Outlook integration add-on 

and they cannot coexist. 

If you install the add-on while you have the standalone version installed on the same computer, a 

subsequent upgrade of the standalone version will be prevented; if you install the standalone version 

while you have the add-on installed on the same computer, the installation fails. 

 Note 

Only the 64-bit version of the Microsoft Outlook integration component is available.  
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Prerequisites 

• You have installed the 64-bit SAP Business One DI API. 

• You have installed the 64-bit Microsoft Outlook. 

• You have assigned the following to the SAP Business One user account which is used for the connection: 

o The Microsoft Outlook integration add-on in the SAP Business One client 

o The SAP AddOns license 

• You have started the Microsoft Outlook integration add-on in the company at least once. This ensures the 

necessary user-defined tables are added to the company database. 

Procedure 

 Navigate to the root folder of the product package and run the setup.exe file. 

If you are using Windows 10, right-click the setup.exe file and choose Run as administrator. 

 In the welcome window, select your setup language and choose Next. 

 In the Setup Type window, select Perform Setup and choose Next. 

 In the Setup Configuration window, select New Configuration and choose Next. 

 In the System Landscape Directory window, do the following: 

 Select Connect to Remote System Landscape Directory. 

 Specify the hostname or the IP address of the server where the SLD is installed. 

 Choose Next. 

 In the Site User Logon window, enter the password for the site super user B1SiteUser. 

This site user was created during the installation of the SLD. 

 In the Database Server Connection window, enter the database server information as follows: 

 Specify the database server type. 

 In the Server Name field, enter the hostname or the IP address of the database server. 

 Choose Next. 

 In the Component Selections window, select Outlook Integration Standalone and choose Next. 

 In the Review Settings window, review your settings and proceed as follows: 

o To continue, choose Next. 

o To change the settings, choose Back. 

 In the Setup Summary window, choose Next. 

 In the Setup Status window, wait for the system to perform the required actions. 

 In the Complete window, choose Finish. 
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4 Installing SAP Crystal Reports, version for 
the SAP Business One Application 

SAP Crystal Reports, version for the SAP Business One application provides integration with the SAP Crystal 

Reports software, which allows you to create, view, and manage reports and layouts.  

SAP Business One 10.0 supports SAP Crystal Reports 2016 SP5, version for the SAP Business One application. 

To use SAP Crystal Reports, version for the SAP Business One application, perform the following operations: 

 Install SAP Crystal Reports 2016 SP5, version for the SAP Business One application 

 Run the SAP Crystal Reports integration script. This step ensures that SAP Business One data sources are 

available in the application. 

 Note 

To use SAP Crystal Reports, version for the SAP Business One application, you must install Microsoft 

.NET Framework 3.5 and 4.5 on the server as well as on the client workstations. 

For more information about working with SAP Crystal Reports, version for the SAP Business One application, see 

How to Work with SAP Crystal Reports in SAP Business One in the documentation area of SAP Help Portal. 

4.1 Installing SAP Crystal Reports, version for the SAP Business 
One application 

Prerequisite 

• You have downloaded the installation package of SAP Crystal Reports, version for the SAP Business One 

application from the SAP Business One Software Download Center on SAP Support Portal at 

https://support.sap.com/b1software. 

• The operating system of the computer on which you want to install SAP Crystal Reports for SAP Business 

One is Windows 7 SP1 or higher. 

• If you already have SAP Crystal Reports installed on your computer, uninstall this software.  

You will also be prompted to uninstall it during the installation procedure.  

Procedure 

 Navigate to the root folder of the product package and run the setup.exe file. 

If you are using Windows 10, right-click the setup.exe file and choose Run as administrator. 

 In the SAP Crystal Reports for SAP Business One setup window, select a setup language and choose OK. 

 The Prerequisites check window appears. If you have fulfilled all critical prerequisites, you can continue with 

the installation; otherwise, follow the instructions in the wizard to resolve any issues before proceeding. 

https://support.sap.com/b1software
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 In the welcome window, choose Next. 

 In the License Agreement window, read the software license agreement, select the radio button  I accept the 

License Agreement, and then choose Next. 

 In the Specify the Destination Folder window, specify a folder where you want to install the software. 

 In the Choose Language Packs window, select the checkboxes of the languages you want to install and choose 

Next. 

 In the Choose Install Type window, select one of the following installation types and choose Next: 

o Typical: Installs all application features. For a typical installation, proceed to step 9. 

o Custom: Allows you to do the following: 

o Select features that you want to install. 

If you have installed SAP Crystal Reports, version for the SAP Business One application, you can 

select the Custom install type to add or remove features. 

o Select whether or not you want to receive the web update service 

o Check the disk cost of the installation 

 

 Note 

If you have done one of the following, the Browse button is inactive because a destination folder already 

exists: 

o You have already installed SAP Business One; that is, before installing SAP Crystal Reports, version 

for the SAP Business One application. 

o You have already installed the SAP Crystal Reports viewer. For example, this may be installed 

automatically when you install the SAP Business One client. 

 In the Select Features window, select the features you would like to install and choose Next. 

The icons in the feature tree indicate whether the feature and its sub-features will be installed, as follows: 

o A white icon means that the feature and all its sub-features will be installed. 

o A shaded icon means that the feature and some of its sub-features will be installed. 
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o A yellow 1 means that the feature will be installed when required (installed on demand). 

o A red X means that the feature or sub-feature is either unavailable or will not be installed. 

SAP Crystal Reports, version for the SAP Business One application uses an "install on-demand" technology 

for some of its features. As a result, the first time a particular feature is used after being installed, there may 

be an extra wait for the "install on-demand" to complete. This behavior will affect new installations only once 

and will not occur when features are restarted. 

To check how much disk space is required for the installation of selected features, choose Disk Cost. 

 In the Web Update Service Option window, you can disable the web update service by selecting the Disable 

Web Update Service checkbox. We recommend, however, that you enable the update service to stay aware of 

updates that can help you enhance your SAP Crystal Reports. 

Choose Next to proceed. 

 In the Start Installation window, choose Next. 

The Crystal Reports for SAP Business One Setup window appears. 

 When the installation is complete, the Success window appears. To exit the installation wizard, choose Finish. 

Next Steps 

Ensure that you also have the 32-bit DI API Legacy Package installed on your workstation; otherwise, you cannot 

connect to SAP Business One data sources or use the Add-ins menu to connect to SAP Business One. 

4.2 Running the Integration Package Script 

To make the SAP Business One data sources and the Add-ins menu available in the SAP Crystal Reports designer, 

run the SAP Business One Crystal Reports integration script. The SAP Business One tables are organized 

according to the modules in the SAP Business One Main Menu. 

Procedure 

 In the SAP Business One product or upgrade package, locate the …Packages.x64\SAP CRAddin 

Installation folder and double-click the SAP Business One Crystal Report Integration 

Package.exe file. If you are using Windows 10, right-click the setup.exe file and choose Run as 

administrator. 

 After the installation is complete, choose Finish to exit the wizard. 
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4.3 Updates and Patches for SAP Crystal Reports, version for 
the SAP Business One application 

 Caution 

Since you are using SAP Business One together with an Original Equipment Manufacturer (OEM) version 

of SAP Crystal Reports, do not apply standard SAP Crystal Reports file or product updates (including Hot 

Fixes and Service Packs) as they are not designed to work with OEM versions of SAP Crystal Reports. 

File or product updates are provided in the following ways: 

• Integrated runtime version: distributed together with SAP Business One 

• Designer: provided separately via a dedicated folder location in the SAP Business One Software Download 

Center on SAP Support Portal at https://support.sap.com/b1software. 

 Note 

If you are using both the integrated runtime version and the designer, make sure that they are either on 

the same patch or Service Pack level or that the Report Designer is on an earlier patch or Service Pack 

level than the Runtime version. If not, inconsistencies may occur. 

To find out if you are using a version of SAP Crystal Reports, start the designer and look for either of these two 

indicators: 

• The title bar of the designer indicates SAP Crystal Reports for a certain product (such as SAP Crystal Reports 

for SAP Business One). 

• In the Help menu, choose About (for example, About Crystal Reports). The technical support phone number in 

the About Crystal Reports box is not listed as (604) 669 8379. 

If either of these indicators exists in your product, you are using an OEM version of SAP Crystal Reports. 

https://support.sap.com/b1software
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5 Uninstalling SAP Business One  

When you uninstall SAP Business One, you remove the application and all its components. 

Procedure 

 Remove the add-ons:  

 From the SAP Business One Main Menu, choose Administration → Add-Ons → Add-On Administration. 

The Add-On Administration window appears. 

 On the Company Preferences tab, under Company Assigned Add-Ons, select the add-ons. 

 Choose the left arrow between the two panels.  

 In the Available Add-Ons list, select the add-ons you want to remove. 

 Choose Remove Add-On, and then choose Update. 

SAP Business One automatically removes the add-ons that you have uninstalled the next time you start the 

SAP Business One application from any workstation that is connected to the server. 

 Note  

You can move XL Reporter to the Available Add-Ons panel but you cannot remove XL Reporter in the Add-

On Administration window. The Remove Add-On button is disabled for XL Reporter. 

 Log on again to SAP Business One. SAP Business One automatically uninstalls the SAP Business One add-

ons that you have removed. This is applicable to all companies on the same server. 

Note that for third-party add-ons, you may need to uninstall them from the Windows Control Panel. 

 Uninstall the server and client components: 

 On your server or client workstation, choose Start → Control Panel → Programs and Features. 

 In the Programs and Features window, select the following items one at a time, and choose 

Uninstall/Change after each selection: 

o SAP Business One Server Tools 

o SAP Business One Client 

o SAP Business One Server  

o Data Transfer Workbench 

o SAP Business One Studio 

o SAP Business One SDK 

o SAP Business One Components Wizard 

 Note 

On Windows machines, you can also uninstall SLD Agent by running the setup.exe file in the path 

C:\Program Files (x86)\SAP\SAP Business One SetupFiles\setup.exe. 

 Remove DI API: 
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o If you installed the DI API as part of the client installation of SAP Business One, the system automatically 

removes the DI API when you uninstall the SAP Business One client. 

o If you installed DI API using the manual setup program in the b1_shf/B1DIAPI folder, you must remove 

it by choosing Control Panel -> Programs -> Programs and Features and selecting SAP Business One DI 

API. 

Result 

SAP Business One entries no longer appear in the Programs menu and any shortcuts that you may have on the 

Microsoft Windows desktop are removed. 

You can now do the following: 

• Manually delete the SAP Business One folders in Microsoft Windows Explorer. 

• Remove SAP Business One databases using your database management application. 

5.1 Uninstalling SAP Business One Client Agent 

The SAP Business One client agent is automatically uninstalled when you uninstall SAP Business One client. 

However, if the client agent cannot be uninstalled successfully, you also can uninstall it manually. 

To uninstall SAP Business One client agent, in the Programs and Features window, select SAP Business One Client 

Agent and choose Uninstall/Change. 

5.2 Uninstalling the Integration Framework  

To uninstall the integration framework, use the Change SAP Business One Integration program. With this program 

you can add or remove features, repair the installation or uninstall the integration framework. 

Prerequisites 

• To disable further event creation for the company databases in SAP Business One, run the event sender setup 

and in step 4, deselect the company databases.  

• You have administrative rights on the PC where you uninstall the integration framework. 

• You have made a backup of the database of the integration framework. 

• You have made a backup of the B1iXcellerator folder. 

To find the folder select IntegrationServer → Tomcat → webapps → B1iXcellerator. 

Procedure 

 Choose Start → All programs → Integration Framework for SAP Business One → Change SAP Business One 

Integration. 
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The SAP Business One Integration Wizard Introduction window opens. 

 In the Maintenance Mode window select Uninstall Product and choose Next. 

The system notifies you that it uninstalls the integration framework. 

 Choose Uninstall. 

The system uninstalls your installation. 

 To finish the procedure, choose Done. 

Result 

The program uninstalls the integration framework, but it does not remove the database. Remove it separately. 
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6 Upgrading SAP Business One 

To upgrade your SAP Business One application to a new minor or major release and run it successfully, you must 

do the following: 

 Upgrade your SAP Business One successfully. 

 Import the license file for the new release. 

If you are using the intercompany integration solution for SAP Business One, make sure the intercompany version 

is compatible with this SAP Business One patch level as specified in SAP Note 2194233. You may need to upgrade 

the intercompany version as well. 

 Note 

If your SAP Business One is of a hotfix version, we strongly recommend that you upgrade to the next 

regular patch once it is available, as hotfixes are intended only as temporary solutions. 

To upgrade to a new minor or major release, you must upgrade to a regular patch first, and then you can 

proceed with the upgrade to the new release. 

6.1 Upgrade Methods 

You can use either of the following upgrade methods to upgrade a previous SAP Business One version: 

• Using the SAP Business One setup wizard in the upgrade package 

You can use the setup wizard to guide you through the process of upgrading SAP Business One to a higher 

major release, a higher minor release, a support package, or a new patch level.  

If any of the upgrade steps fail, you can use the restoration mechanism to reverse all the database changes 

made to your SAP Business One landscape by the wizard and return to the SAP Business One version before 

the upgrade. 

 Caution  

To detect any errors or warnings that may arise in the SAP Business One upgrade process, it is 

mandatory that you perform a trial run. The results of the pre-upgrade tests indicate where you may need 

to correct any errors before performing the actual upgrade. If no issues are found, you may continue with 

the upgrade procedure. 

• Silent upgrade 

You can upgrade SAP Business One in a silent mode using command line arguments. 

• Directly from the upgrade package folders 

You can use the upgrade files in the upgrade package to upgrade the individual SAP Business One 

components, although this method is not recommended and only for advanced users. 

https://launchpad.support.sap.com/#/notes/2194233
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6.2 Supported Releases 

The following major or minor releases are currently supported for upgrade to SAP Business One 10.0: 

• SAP Business One 9.2 

• SAP Business One 9.3 

 Note 

If your SAP Business One version is lower than 9.2 PL00, the direct upgrade to 10.0 is not supported. You 

must first upgrade your system to SAP Business One 9.3 and then upgrade to version 10.0. 

For more information about upgrading from specific patches of supported releases, see the Readme or Patch 

Readme file for the respective SAP Business One version. 

6.3 Upgrade Process 

Prerequisites 

• You have downloaded the upgrade package from the SAP Support Portal.  

• You have ensured that company databases are not connected to any SAP Business One clients, SQL Server 

clients, or other applications.  

• You have the SAP Business One 10.0 license file available. You need this license file for connecting your 

company after the upgrade process is finished. If you do not import a valid license file after the upgrade 

process, you cannot work with your company. 

• You have administrator rights on the computer that runs the SAP Business One setup wizard.  

• If the machines on which the SAP Business One client and DI API run use an HTTP proxy for network access, 

you have added the System Landscape Directory server to the list of proxy exceptions. 

• The SBO-COMMON database that you have installed on your computer is not a later release than the upgrade 

package. 

• If any components of SAP Business One integration for SAP NetWeaver (B1iSN) were previously installed on 

your server, you have uninstalled them manually before installing any integration solutions delivered with SAP 

Business One. This step is required due to compatibility reasons. For more information about uninstalling 

components of B1iSN, see the SAP Business One integration for SAP NetWeaver Installation and Upgrade 

Guide. 

• If you have installed the integration framework, you stopped the following services (in the order given below): 

 SAP Business One integration Event Sender 

 SAP Business One integration DI Proxy Monitor 

 SAP Business One integration DI Proxy 

 Integration Server Service 

 Note 

After you have completed the upgrade process, check whether you must restart the services in reverse 

order. 
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To upgrade only the integration framework, run the setup.exe file under \Packages.x64\B1 

Integration Component\Technology\ in the product package. 

During the upgrade of SAP Business One, you have the option of installing remote support platform for SAP 

Business One. For more information about installing remote support platform for SAP Business One, see 

Administrator's Guide to Remote Support Platform for SAP Business One. You can find the guide 

(RSP_AdministratorGuide.pdf) under …\Documentation\Remote Support Platform\System 

Setup\on the SAP Business One product DVD, or on SAP Help Portal. 

Procedure 

To upgrade SAP Business One, do the following: 

 To determine the upgrade path, read the Overview Note for the required version. 

For example, check which versions are supported for upgrade to the required higher version. If direct upgrade 

is not supported, you first need to upgrade your system to a supported version and perform the server 

upgrade operation for more than one time. 

 On your server, upgrade your operating system to the required version. For more information, see 

Prerequisites. 

 On your server, upgrade Microsoft SQL Server to the required version. For more information, see 

Prerequisites. 

 On your server, run the setup wizard for the required version to upgrade the common database, company 

databases, and all server components.  

 Recommendation  

Upgrade all the server components at one time, and not separately. Otherwise you may have problems 

fixing certain errors in the pre-upgrade test. 

 Note 

On your server machine, if you need to upgrade SAP Business One SLD Agent, you must upgrade it 

separately using the Components Setup Wizard. For more information, see Manually Installing SLD 

Agent Service. 

 On each workstation, do the following: 

o If you have installed such client components as the DTW, run the setup wizard to upgrade these client 

components. For more information, see Upgrading SAP Business One Databases and Components. 

o Upgrade the SAP Business One client application. For more information, see Upgrading the SAP Business 

One Client. 

o Upgrade SAP Business One SLD Agent using the Components Setup Wizard. For more information, see 

Manually Installing SLD Agent Service. 

 Upgrading SAP Business One Databases and Components 

A setup wizard is used for installation as well as for upgrade. The following procedure describes how to upgrade 

the common database, the company databases, server components, and client components. If any of the upgrade 

steps fail, you can use the restoration mechanism to reverse all changes made by the wizard. 

https://help.sap.com/viewer/index
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 Note 

For security reasons, we recommend that you run the SAP Business One setup wizard to upgrade your 

company schemas on a backend server which is well protected.  

Note that the setup wizard does not support remote upgrade and can upgrade only local components. To 

upgrade components on other machines, you must run the setup wizard repetitively. 

In addition, for upgrade of the SAP Business One client within a release family, you can perform silent upgrade 

instead of using the setup wizard. For more information, see Upgrading the SAP Business One Client. 

Prerequisites 

• You have ensured that all SAP Business One clients are closed. 

 Recommendation 

o Complete or terminate all workflow instances before closing SAP Business One client. 

o Lock the company whose database you will upgrade from the SLD control center. For more 

information, see Upgrading Databases. 

Procedure 

 Navigate to the root folder of the upgrade package and run the setup.exe file. 

If you are using Windows 10, right-click the setup.exe file and choose Run as administrator. 

 In the welcome window, select your setup language, and choose Next. 

 In the Setup Type window, select the Perform Setup checkbox, and choose Next. 

The option Test System Environment verifies if the system environment and the company databases are 

ready for an upgrade. The existing installation and data are not changed. For each company database that 

passes the test, you can generate a passcode, which allows you to bypass the pre-upgrade test when 

upgrading the database later. The passcode is in the form of an XML file that contains details on the tested 

company databases. It is valid for three days, and any changes to the company configuration render the 

passcode invalid. 

The Perform Setup option both performs the pre-upgrade tests and upgrades selected components and 

databases. If you carried out a pre-upgrade test for a company database earlier, you can enter the passcode 

to bypass the pre-upgrade tests for this company database. 

 In the Setup Configuration window, select one of the following options and choose Next: 

o New Configuration: Select this radio button to manually enter all the required settings. Go directly to step 

6. 

o Use Settings from the Last Wizard Run – Select this radio button to use the settings from the last wizard 

run, which are stored in the configuration file generated during that run. 

o Load Settings from File – Select this radio button to use the settings stored in a configuration file 

generated during a previous wizard run, and then specify the location of the file you want to use. 

To obtain the required Config.XML file, first run the setup wizard and select the New Configuration 

option. After generating this file, you can make a copy and use a text editor to modify the values for future 

use as required. 
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 If you selected to use the settings from the previous wizard run or a file, the Review Settings window appears. 

This window provides an overview of the settings that you have configured for the upgrade process. To modify 

any of the settings, edit the values in the table. Otherwise, choose Next to proceed with the upgrade. 

 Note 

If you are sure that all the settings are correct, you can select the checkbox Skip Remaining Steps and 

Automatically Start Pre-Upgrade Test and Upgrade to bypass the remaining wizard steps and begin the 

process immediately. 

 In the System Landscape Directory window, do either of the following: 

o If you are upgrading the System Landscape Directory and other components that are installed on the 

same machine, select Connect to Local System Landscape Directory and choose Next. 

Note that the local System Landscape Directory will be upgraded forcibly if it is not already upgraded to 

the required version. 

o If you are upgrading components that are installed on a different machine from that of the System 

Landscape Directory, select Connect to Remote System Landscape Directory, specify the server, and then 

choose Next. 

Note that the remote System Landscape Directory must have already been upgraded to the required 

version. 

 In the Site User Logon window, enter the password for the site super user B1SiteUser. 

 Note 

If you chose to perform only the pre-upgrade test, you also have the option to connect to a database 

server. In this case, you need to specify the information for a database user instead of the site user. 

 In the Database Server Connection window, specify the Microsoft SQL Server version and select the database 

server instance. Then choose Next to proceed. 

If you do not find the database server you want to upgrade in the server list, you can register it in the System 

Landscape Directory. To do so, choose Register New Database Server, specify the relevant information, and 

then choose Back to continue with the upgrade. 

 Note 

If you intend to upgrade the components from a lower version to SAP Business One 10.0 and upgrade the 

database server from a lower version to Microsoft SQL Server 2017 simultaneously, we recommend that 

you perform the following steps: 

1. Upgrade the Microsoft SQL Server from the lower version to Microsoft SQL Server 2017. 

2. Upgrade the SAP Business One Server Tools by running the setup.exe file in the path 

…\Packages\Server Tools\seup.exe from the upgrade package. 

3. Upgrade SAP Business One Components from the lower version to SAP Business One 10.0 by the 

setup Wizard. 

 In the Unsupported 32-bit Components window, you can see the 32-bit components installed previously. We 

recommend that you manually uninstall these components. For more information about uninstalling SAP 

Business One, see Uninstalling SAP Business One. 

 Note 

Add-ons cannot be uninstalled from the SAP Business One Server by the setup wizard 
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 In the Component Selections window, select the corresponding checkboxes of the components that you want 

to upgrade. 

If a component has already been upgraded to the current version, its checkbox is enabled but not selected. If 

you select an already upgraded component, the wizard overwrites all instances of installed components. 

The wizard also lists all third-party add-ons present in the \Packages.x64\Add-Ons Autoreg folders, 

which you can select to upgrade. 

 Note 

Upgrading the repository is a prerequisite for upgrading other components or company databases. If 

there are no installed versions of the SBO-COMMON, Upgrade Database is not allowed. 

If a component is indicated as Not Found, you can select the corresponding checkbox to install the 

component.  

 In the Database Selection window, select the checkboxes of the databases that you want to upgrade. 

 To view additional options and information, select the row of a company database, select the Advanced 

Settings checkbox, and then specify the following: 

o Backup – From the dropdown lists in the Backup column, select whether to back up each database before 

the upgrade. 

 Caution 

If you select not to back up a database before upgrade, you cannot restore the database should the 

upgrade fail. SAP does not provide support for such databases in the case of an upgrade failure; a backup 

of the pre-upgrade database is required to qualify for SAP support.  

o Upgrade By – From the dropdown list, select the SAP Business One superuser that you want to use to 

perform the upgrade. By default, the wizard uses the manager account. 

o Stop on Test Error – Select this checkbox to force the wizard to stop the entire upgrade process if it 

encounters an error during a pre-upgrade test. 

o Stop on Upgrade Error – Select this checkbox to force the wizard to stop the entire upgrade process if it 

encounters an error while upgrading the database. 

 If errors occur which are preventing you from upgrading the company databases, do the following: 

 In the Status column, click the Not Ready link. 

Details about the errors are displayed. 

 Do either of the following: 

o Fix the errors and choose Refresh. 

Such errors are as follows: 

* The wizard finds more than one connection to the company database. 

* The database user registered with the server is either locked or is not a database admin user. 

o If the errors cannot be fixed and you must contact SAP Support, deselect the checkbox. 

Such errors are as follows: 

* The wizard does not support the company database version. 

* The wizard cannot find the localization for the company database from the locale list in the common 

database. 

 When all the selected databases have the status Ready, choose Next. 
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 Note  

o If any of the selected databases has the status Not Ready, the wizard disables the Next button. You 

cannot proceed to the next step until you have fixed the problem. 

o The database statistics on Microsoft SQL Server will not be updated after the company database 

upgrade. 

 In the Upgrade  - Backup Settings window, specify the location where you want to store the backup files 

created before upgrading the selected components. 

o To use the default backup path configured in SQL Server, choose Use the Default SQL Server Backup 

Location. 

o To use another location on the database server, choose Browse directories on database server and click 

Browse to choose a directory.  

o To use a network drive, choose Enter a network path and specify the path.  

After you specify a location for the backup, the wizard displays the amount of space required for database 

backups and the available space on the corresponding drives. 

 If you previously selected the integration framework for upgrade, do the following: 

 In the Integration Solution - B1i Database Connection Settings window, enter the database password. 

 In the subsequent Integration Solution - Scenario Packages windows, if you want to activate any new 

scenarios, select the corresponding checkboxes and specify the necessary information. 

 In the Review Settings window, review your configuration setting. To modify any of the settings, choose Back 

to return to the relevant window; otherwise, choose Next . 

 In the Pre-Upgrade Test window, do the following: 

o To bypass the tests for a database, choose Enter Passcodes and upload one or more of the passcode files 

you saved earlier. After uploading the files, choose Next and proceed to step 23. 

 Note 

A passcode file is only valid for three days. Any changes to the company configuration render the 

passcode file invalid. 

o To perform pre-upgrade tests on each database to ensure its readiness for the upgrade and to reduce the 

possibility of upgrade failure, choose Start. 

 Note  

For the latest information about pre-upgrade tests, see SAP Note 1357462. 

 In the Pre-Upgrade Testing In Progress window, the wizard first checks the common database and then 

checks the company databases one by one.  

 Note  

If the common database does not pass the checks, the wizard does not continue with the rest of the 

checks. 

 The Pre-Upgrade Test window provides a detailed overview of the results of the pre-upgrade tests. You can 

view information about individual checks, possible solutions to errors, and recommendations for dealing with 

warnings by clicking the links to the corresponding notes in the SAP Note column. 

Depending on the results of the pre-upgrade tests, one of the following windows appears: 

o Pre-Upgrade Test: Passed – All components and databases successfully passed the pre-upgrade tests. 

Proceed to the next step. 

https://launchpad.support.sap.com/#/notes/1357462
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o Pre-Upgrade Test: Errors Detected – One or more components or databases contain errors. You cannot 

continue upgrading. You must fix the reported errors or contact SAP for support, and then start the setup 

wizard again. 

o Pre-Upgrade Test: Warnings Detected – One or more components or databases contain warnings. It is 

strongly recommended that you first fix the issues, and then continue the upgrade: 

1. For each component or database that contains warnings, click the corresponding link in the Details 

column. 

2. The Pre-Upgrade Test Result window appears. 

3. In the Pre-Upgrade Test Result window, click the corresponding hyperlink in the SAP Note column 

and follow the recommendations. After fixing the issue, select the checkbox in the Confirmation 

column. 

4. After confirming all the warnings, choose Back to return to the Pre-Upgrade Test window. 

5. After you have confirmed all warnings for all components and databases, choose Next to open the 

Pre-Upgrade Test: Warnings Confirmed window, and then proceed to the next step. 

 The Setup Summary window displays an overview of the components and databases that you have selected 

to upgrade (or install if some selected components are not installed). Do either of the following: 

o To begin the upgrade process, choose Upgrade. 

o To change the settings, choose Back to return to the previous steps. 

The Upgrade in Process window displays the upgrade progress of each component and database. 

 According to the upgrade results, one of the following windows appears: 

o Upgrade Result: Upgraded window: This window appears if the upgrade of all components and databases 

was successful. To continue, choose Next. 

o Upgrade Result: Errors window: This window appears if the upgrade of any component or database fails. 

To continue restoring the failed components and databases, choose Next and then proceed to the 

Restoring Components and Databases section. 

 In the Congratulations window, choose Finish to close the wizard. 

To view a summary report of the various upgrade steps, such as company databases and pre-upgrade test 

results, click the Upgrade Summary link. 

Post-requisites 

 Import the license file for the new release.  

 On each client workstation, upgrade the SAP Business One client. 

6.3.1.1 Restoring Components and Databases 

If the upgrade process fails, the SAP Business One setup wizard restores the databases and certain components. 

The other components must be restored manually. 

 Note  

The procedure below continues from the penultimate step of upgrading databases and components. It is 

relevant for situations only where the upgrade has failed. 
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Procedure 

To restore components and databases, do the following: 

 In the Restoration window, select the checkboxes of the components and databases that you want to restore, 

and choose Restore.  

 Depending on the results of the restoration process, one of the following windows appears: 

o If the restoration is successful, the Restoration Result: Restored window appears. To complete the 

restoration, do the following: 

1. In the Restoration Result: Restored window, choose Next.  

2. In the Congratulations window, choose Finish to complete the restoration process. 

o If the restoration fails, the Restoration Result: Failed window appears. To complete the restoration, do the 

following: 

1. In the Restoration Result: Failed window, choose Next. 

2. In the displayed window, choose Finish to exit. 

 Note  

If the restoration fails, to roll back SAP Business One to the version before the upgrade, you must do a 

manual restoration.  

6.3.1.2 Troubleshooting Upgrades 

• The root user that runs the setup wizard has read, write, and execute permissions to the shared folder 

B1_SHR on the SAP Business One server computer. 

• If you cannot connect to the System Landscape Directory using the server name, use the IP address of the 

server computer.  

• To have SBO Mailer’s signature copied after upgrade, do the following: 

 To open the SAP Business One Service Manager window, in Windows, choose Start → All Programs → SAP 

Business One → Server Tools → Service Manager. 

 In the SAP Business One Manager window, from the Service dropdown list, select SBO Mailer, and then 

choose Connection. 

 In the Connection Settings window, specify values in the DB Type and DB Server fields, and then choose 

OK. 

 Log off SAP Business One and log on to SAP Business One again. You will find that the signature was 

copied. 

 Upgrading the SAP Business One Client 

After the server upgrade, you must upgrade the SAP Business One client on all your workstations. 

For an upgrade from a previous release family (for example, from the 9.3 release to the 10.0 release), run the 

setup wizard on each workstation to upgrade the SAP Business One client. 
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Alternatively, you can uninstall the old client and then install the new client using the client installation program. 

The client installation package is available in the entire product package as well as in the shared folder B1_SHR. 

 Note 

SAP Business One 10.0 supports only the 64-bit SAP Business One client. So if you have installed a 32-bit 

SAP Business One client on a client workstation, you must manually uninstall the 32-bit client first, and 

then install or upgrade to the 64-bit client. 

Prerequisites 

For the SAP Business One client agent to upgrade third-party add-ons in a silent mode, you must recreate the 

ARD file of the add-on using the latest version of the Add-On Registration Data Generator. For more information, 

see Enabling Silent Upgrades for Third-Party Add-Ons. 

Procedure 

 Run the client as the administrator. 

 Log on to a company. 

A system message appears to inform you that the client is not updated. 

 In the system message window, choose OK to upgrade the client. 

 Upgrading SAP Business One Add-Ons 

When you select the Add-On checkbox in the Component Selections window of the setup wizard, the following 

occurs: 

• New versions of all SAP add-ons are automatically registered on the SAP Business One server. 

• New installers are uploaded to the server during the upgrade of the common database. 

Add-ons that were already installed and assigned to a company are reregistered with new releases and assigned 

to the same company. 

On a client computer, upon the next logon to a company assigned with add-ons, installers for the new add-on 

releases run automatically. 

6.3.3.1 Troubleshooting Add-On Upgrades 

When upgrading add-ons in an upgraded company for which the server name was previously something like 

(local), you may encounter a message about installation failure. 

SAP Business One has introduced a license security mechanism, and we do not recommend that you specify a 

server name such as (local). In this case, during an upgrade, the user defines the server name as an IP address 

or a computer name. The application does not find the previous, (local), name of the upgraded company, which 

prevents the previous add-ons from being upgraded. 

To solve this problem, do the following: 

 Go to the …\SAP Business One\ folder and locate the AddonsLocalRegistration.sbo file. 

 Change the server name of each related add-on to the new name specified in the license server.  
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 Example  

o Old name: <Common ID="1" Name="(local)"/> 

o New name: <Common ID=”1” Name=”MyServerName”/> 

6.3.3.2 Enabling Silent Upgrades for Third-Party Add-Ons  

To enable the SAP Business One client agent to upgrade a third-party add-on in silent mode, do either of the 

following: 

• If your add-on needs to be installed, you must recreate the add-on’s ARD file using the latest version of the 

Add-On Registration Data Generator to enable silent upgrades (and installations). 

 Note 

You may be required to rebuild the installation package of the add-on and redesign the installation and 

configuration process. For example, if the add-on uses an installation wizard that requires the user to 

specify some information, then you can perform the configuration steps in the SAP Business One client 

after installing the add-on instead. Alternatively, you can provide the required information as command 

line arguments in the ARD file. 

• If your add-on does not need to be installed, you can use the Extension Manager to manage its upgrade. For 

more information, see the guide How to Package and Deploy Lightweight Extensions for SAP Business One on 

SAP Help Portal. 

The following procedure describes how to enable silent upgrades using the Add-On Registration Data Generator. 

Procedure 

 To start the Add-On Registration Data Generator, run the AddOnRegDataGen.exe file, which is typically 

located in the...\SAP Business One SDK\Tools\AddOnRegDataGen folder. 

 Load an existing file, or enter the mandatory information.  

For more information, see the Create a Registration Data File chapter in the SDK help file. 

 Select the Silent Mode checkbox. 

 If necessary, in the Installer/Uninstaller/Upgrade Command Line field, enter any required command line 

arguments. 

 Choose Generate File. 

6.4 Performing Silent Upgrades 

You can upgrade SAP Business One using a silent mode by calling …\Setup.exe from the upgrade package. 

You can use the silent mode to upgrade the following components: 

• Repository 

• All packages of Server Tools, including: 

https://help.sap.com/viewer/index
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o System Landscape Directory 

o License Manager 

o Extension Manager 

o Data Interface Server 

o Job Service 

o Workflow 

• Databases 

• Integration Solution Components 

• DI API 

• SAP Business One Client 

• All Add-Ons 

To upgrade SAP Business One, provide the following argument:  

setup.exe <Config.XML> <parameter> <value> 

To obtain the required Config.XML file, first run the setup wizard in the interactive mode. After generating this 

file, you can make a copy and use a text editor to modify the values for future use as required.  

You can find the configuration file in the …\%PROGRAMDATA%>\SAP\SAP Business One\Log\SAP Business 

One\SetupWizard\Config folder. 

You can provide several different parameters, or multiple parameters, as shown in the following table. 

Type Parameter Value 

Database Server and License 

Server authentication 

-DbPassword Database server password 

-SitePassword  Site user password 

SLD configuration -SLDCertPassword  SLD certificate password 

-SLDDomainPassword SLD domain user password 

Integration Solution 

Components 

-B1iDBPassword  Integration framework database 

server password 

-B1iAdminPassword  Integration framework Tomcat server 

administrator password 

-B1iDIPassword  Company password for DI calls 

 

 Example 

Setup.exe "C:\my_config\Config.XML" -DbPassword x1Y3s -SitePassword pO3kAnk3 
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7 Performing Post-Installation Activities 

Immediately after installing SAP Business One, you are required to perform the following activities: 

• Configure services  

• Install the license key 

• Assign add-ons 

• Perform post-installation activities for the integration framework 

 Recommendation 

We also recommend you configure a backup strategy for databases and application folders. For more 

information, see Backing Up Databases. 

You can use the remote support platform for SAP Business One to automatically backup data according 

to a defined strategy. For more information, see the Online Help for the remote support platform. 

 Note 

If you use a proxy for your Internet connection, you must add the full hostname or IP address of any Web 

server (for example, SLD) to the proxy exception list of your Web browser; in other words, do not use a 

proxy for these addresses. 

7.1 Working with the System Landscape Directory 

The System Landscape Directory (SLD) control center is a central workplace where you perform various 

administrative tasks.  

You can access the SLD control center in a Web browser for the following:  

• Enabling the Single Sign-on Function  

• Managing Site Users 

• Enabling Dynamic Encryption Keys 

• Exporting and Importing Configuration File 

• Adding Services in the System Landscape Directory 

• Mapping External Addresses to Internal Addresses 

 Logging on to the System Landscape Directory Control 
Center 

After the installation, the SLD service starts automatically. You can then access the SLD control center in a Web 

browser. 
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Procedure 

 In a Web browser, navigate to the following URL: https://<Server Address>:<Port>/ControlCenter 

 Note 

The URL address is case-sensitive. 

The default port number is 40000. 

 In the logon page, enter the name and password for a site user (for example, B1SiteUser). 

 Note 

The site user name is case-sensitive. 

 Choose Log On. 

 Enabling the Single Sign-on Function 

SAP Business One supports single sign-on (SSO) functionality. You can bind an SAP Business One user account 

to a Microsoft Windows domain account. 

After binding SAP Business One users to Microsoft Windows accounts, you can enable the SSO function in the 

SLD. For more information, see Enabling Single Sign-On. 

 Managing Site Users 

The site user account serves as site-level authentication for performing various administrative tasks, as listed in 

the table below: 

Site Users Function 

B1SiteUser Life cycle management : installation, upgrade, uninstallation 

Configuring services installed on Windows (for example, Workflow service) 

Company creation 

All All operations performed in the System Landscape Directory 

Accessing and performing operations in Web-based service control centers (for example, 

job service, Administration Console of the analytics platform) 

B1SiteUser 

The site super user, whose account information should only be known to a few selected system administrators, is 

B1SiteUser. You can update the password of B1SiteUser in the System Landscape Directory, on the Security 

Settings tab, by choosing Change B1SiteUser Password. You will need to provide the old password to make the 

change. 
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The B1SiteUser account cannot be removed. 

 Note 

If you forget the password of the site user and want to reset it, you must log on to the local machine on 

which the System Landscape Directory is installed and on the SLD logon page, click Forgot password? . 

You will need to provide the server name and database user credentials to make the change. 

Domain Users as Less-Privileged Site Users 

You can assign appropriate Windows domain users as site users to perform administrative tasks that require 

fewer privileges in the System Landscape Directory.  

Prerequisite 

You have entered Windows domain user authentication information during the installation of the System 

Landscape Directory. For more information, see Installing SAP Business One. 

Procedure 

To assign a Windows domain user as a less-privileged site user, do the following: 

 In a Web browser, log on to the System Landscape Directory. 

 On the Security Settings tab, choose Manage Site Users. 

 In the Manage Site Users window, in the edit box at the top, enter a domain user account in the format of 

Domain\User. 

 To assign the domain user as a site user, choose Add. 

Result 

You can delete domain-user site users at any time. Additionally, a domain user can even remove himself or herself 

as a site user. After the removal, the domain user can no longer log on to the System Landscape Directory. 

 Enabling Dynamic Encryption Keys 

You can encrypt data in SAP Business One company databases using a static key or a dynamic key.  

 Recommendation 

We strongly recommend that you use a dynamic key to encrypt your company schemas. 

 Caution 

Enabling the use of dynamic keys is an irreversible process. 

Procedure 

 Log on to the SLD control center. 
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 On the Security & Logging tab, in the Encryption Key Management area, choose Enable Dynamic Key. 

 Note 

After enabling the use of dynamic keys, you can generate a new dynamic key at any time. To do so, 

choose Enable Dynamic Key again. 

 Open the SAP Business One client application, log on to each of your companies, and accept to update the 

company schema.  

Note that you must perform this for all company schemas on the servers registered in the System Landscape 

Directory. 

 Exporting and Importing Configuration File 

To secure your data, we recommend that you export your security configuration file right after you finish installing 

the license server and the SAP Business One server. For more information, see Exporting Configuration Files. 

If the server on which you install the SLD service crashes or is corrupted, you must restore all the security settings 

after the new license server is started. For more information, see Importing Configuration Files. 

 Adding Services in the System Landscape Directory 

The Services tab of the SLD displays all SAP Business One services that have been installed and registered on the 

license server. The services include the following: 

• License manager 

• Job service 

• Workflow service 

If you accidentally delete a service from the SLD, you must add the service again; otherwise, you cannot use the 

service. 

Procedure 

 Log on to the SLD control center. 

 On the Services tab, choose Add. 

 In the Add Service window, specify the following information: 

o Service type: Only installed service types are available. 

o Service name: Enter a name for the service 

Service Unit: For Job Service, you must make sure to select a database instance which is already 

registered in the SLD control center. 

o Service URL: Specify the service URLs as below: 

o License: https://<Server Name/IP>:<port>/LicenseControlCenter 

o Job service: https://<Server Name/IP>:<port>/job 
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o Workflow: https://<Server Name/IP>:<port>/workflow 

 Mapping External Addresses to Internal Addresses 

To enable access from outside the local network, you must map an external access URL to each required 

component.  

Procedure 

 Log on to the SLD control center.  

 On the External Address Mapping tab, choose Register. 

 In the Register External Address window, specify the following information: 

 Component 

 Hostname or IP address of the machine on which the component is installed 

 External URL 

The external access URL must have the format <protocol>://<Path>:<Port>. 

 Example 

http://<IP address>:8080 

 

The Hostname/IP Address field for the SLD may display the hostname rather than the FQDN of the SLD 

server, or it may be empty; either is fine and can be ignored. 

 Choose OK. 

Post-requisites 

After finishing mapping the addresses for all required components, you must restart the services on the machines 

on which they're installed. 
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7.2 Configuring Services  

You must configure the services you have installed if they are to operate properly. 

 Note  

The first time you configure any service in the service manager, you must enter the site user password. 

This is not for authentication purposes, but to obtain the database password. After entering the site user 

password once, you do not have to enter it again when configuring other services.  

 License Control Center 

 Caution 

If you have installed a firewall on the license server, make sure that the firewall is not blocking the port 

number you use for the license service; otherwise, the license service and SLD cannot work. 

In addition, if you are using port X, make sure that you open both port X and port (X+1) in the firewall. For 

example, if you are using port 40000, make sure to also open port 40001. 

The license service is a mandatory service that manages the application license mechanism according to the 

license key issued by SAP. Web access to the license service enables you to do the following: 

• Find and copy the hardware key to run your SAP Business One application and apply for SAP licenses 

• Import the license file  

• View the basic license information 

For new installations, you can use the application for a period of 31 days without a license key. After that period, 

the SAP Business One application needs a license key to run. We strongly recommend that you request a license 

key immediately after installing the application. 

You also must install a new license key whenever any of the following occurs: 

• You have additional users or components. 

• The hardware key changes. 

• The current license expires. 

• You installed a new version of SAP Business One. 

To avoid accidentally changing the hardware key, do not perform the following actions on the license server 

computer: 

• Formatting the computer and reinstalling Microsoft Windows. 

• Changing the computer name. 

The following actions are safe and do not change the hardware key: 

• Adding a new user logon. 

• Changing the computer date or time. 

• Changing the hardware configuration. 
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Procedure 

 In a Web browser, navigate to the following URL: 

https://<Server Address>:<Port>/LicenseControlCenter 

Alternatively, on the Services tab in the System Landscape Directory, you can click the license manager link to 

access the license control center. 

 Notes 

o If you use a proxy for your Internet connection, you must add the full hostname or IP address of any 

Web server (for example, SLD) to the proxy exception list of your Web browser; in other words, do not 

use a proxy for these addresses. 

o The URL of the service is case-sensitive. 

 If you have not logged on to the SLD service, in the logon page, enter the site user name and password, and 

then choose Log On. 

 Note 

The site user name is case sensitive. 

 The General Information area displays the details of the license server. 

If you have not yet obtained a license key, apply to SAP for a license key using the hardware key. If you are a 

partner, for more information, see License Guide for SAP Business One 10.0 on SAP Help Portal.  

 To install the license key, choose Browse, select the TXT file you received from SAP, and then choose Import 

License File. 

 Note 

o CORBA license server now is only the proxy of HTTPS license server for compatibility purposes and 

may be removed in future patches. We do not recommend you use SAP Business One Service 

Manager to configure the license service. 

o SAP Business One SLD Service is changed to SAP Business One Server Tools Service that runs both 

SLD and license web services. If you intend to reboot the license server, restart SAP Business One 

Server Tools Service instead of SAP Business One License Manager. 

 Job Service 

The job service manages the following settings on the server side: 

• SBO Mailer settings 

• Alert and scheduling settings 

https://help.sap.com/viewer/index
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7.2.2.1 SBO Mailer 

Prerequisites 

You have installed the SBO Mailer service. 

Procedure 

 To open the SAP Business One Service Manager window, in the Microsoft Windows task bar, double-click 

(SAP Business One Service Manager).  

Alternatively, in Windows, choose Start → All Programs → SAP Business One → Server Tools → Service 

Manager.  

 From the Service dropdown list, choose Job Service - Mailer.  

 Choose   (Play) and select the Start when operating system starts checkbox. 

 Define mail settings: 

 In the SAP Business One Service Manager window, choose Settings. 

The General Settings window appears. 

 In the General Settings window, specify the following: 

o SMTP Server — Enter the name or IP address of your outgoing mail server. To make changes in this 

field later, you must stop the Mailer service. 

o SMTP Port — Specify the port number for mail services.  

o Encoding — Select the language for email text. 

o HTML direction right-to-left — Select this checkbox to define the direction of the email text if you are 

using a right-to-left language. 

o Include Subject in Message Body — Select this checkbox to include the subject line in the body of the 

message. 

o Fax Settings — Select the required fax service. For more information, see Fax Services. 

o Scheduled Report Settings - Specify the required information for configuring SBO Mailer for report 

scheduling and mailing. For more information, see Report Scheduling. 

 Log on to the SAP Business One client as a superuser or a power user and do the following to enable mailing 

services for databases. 

 Select the database for which you want to enable the mailing service. 

 On the Service tab of the General Settings window (Main Menu → Administration → System Initialization → 

General Settings), select the Enable Mailer checkbox. 

 Note 

If you upgrade the SAP Business One job service from a lower version to SAP Business One 9.3 PL09, the 

original enabled databases for mailing services will be disabled. You must reset the databases for which 

you want to enable mailing services in SAP Business One client. 

Alternatively, you can also enable mailing services for databases from the System Landscape Directory 

control center as follows: 

 Log on to the SLD control center. 
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 On the DB Instances and Companies tab, in the Companies area, select the databases on which you intend 

to enable the mailing services and choose Enable Mailer. 

 Set the mail processing schedules: 

 In the SAP Business One Service Manager window, from the Service dropdown list, select SBO Mailer, and 

then choose Schedule.  

 In the Scheduler – SBO Mailer window, select one of the following options: 

o By Intervals — Sets mail and fax processing to start regularly every x hours and y minutes. 

o On Specific Date — Defines mail and fax processing for a specific date and time. 

o Daily — Sets mail and fax processing for a fixed hour of each day. 

o Weekly — Sets mail and fax processing for a fixed hour on a fixed day of each week. 

o Monthly — Sets mail and fax processing for a fixed hour on a fixed day of each month. 

 Choose OK to return to the SAP Business One Service Manager window.  

 In the SAP Business One Service Manager window, choose  (Play), and select the Start when operating 

system starts checkbox. 

 To close the SAP Business One Service Manager window, choose OK. 

Result 

You can now proceed to define the email signature settings. To access the email signature settings, from the SAP 

Business One Main Menu, choose Administration → System Initialization → E-Mail Settings. 

7.2.2.1.1 Troubleshooting 

The following troubleshooting information may be helpful when configuring the mail services: 

• Ensure that you have already set up an email account for the SAP Business One users on your mail server.  

• To verify the connection with the mail server, choose Test Connection. 

• The mail service checks the connection with the specified mail server and email account and displays an 

appropriate message. 

• If the SMTP server requires authentication, for example, if the SMTP server is configured to accept only 

logon-authenticated mails, you must not select the Anonymous Access option in the Mail Settings area. 

• To check whether the connection to the SMTP server works, send a test email. If the connection fails, ensure 

that you have done the following: 

o Entered the correct name of your mail server 

o Entered the correct user ID and password 

o Restarted the SBO-Mailer service after changing any of the settings 
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7.2.2.2 Alert and Scheduling Settings 

To use the alert and scheduling function to have SAP Business One automatically notify selected users whenever 

certain system events occur or have SAP Business One automatically run previously scheduled tasks, you must 

first start the alert service for the companies on the server side. 

Procedure 

 In a Web browser, navigate to the following URL: 

https://<Server Address>:<Port>/job 

Alternatively, on the Services tab in the system landscape directory, you can click the Job Service link to 

access the settings. 

 Notes 

o If you use a proxy for your Internet connection, you must add the full hostname or IP address of any 

Web server (for example, SLD) to the proxy exception list of your Web browser; in other words, do not 

use a proxy for these addresses. 

o The URL of the service is case-sensitive. 

o On the Services tab in the system landscape directory, make sure that the job service is already 

bound to a database instance which is registered in the SLD control center. 

 If you have not logged on to the SLD service, in the logon page, enter the site user name (B1SiteUser) and 

password, and then choose Log On. 

 Note 

The site user name is case sensitive. 

 On the Alert and Scheduling Settings tab, if you want to change the technical user used to execute the alerts, 

enter the user code for an SAP Business One user and then choose Save. 

 Note 

If you want to use a user different from the default user AlertSvc, you must ensure the user is created in 

all the companies. Otherwise, all the alert settings are ineffective for the companies missing this user. 

This technical user is used for database connection and not intended for any business transactions. You 

do not have to assign a license to this technical user, and we recommend that you don't.  

 To start the alert service, choose Start. 

The status changes to RUNNING and the button changes to Stop. 

 Note 

To change the technical user or change the company selection, you must first stop the connection by 

choosing Stop. 

 Log on to the SAP Business One client as a superuser or a power user and do the following to enable the alert 

and scheduling services for databases. 

 Select the database for which you want to enable the alert and scheduling service. 
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 On the Service tab of the General Settings window (Main Menu → Administration → System Initialization → 

General Settings), select the Enable Alert Service checkbox. 

Alternatively, you can also enable the alert and scheduling services for databases from the System Landscape 

Directory control center as following: 

 Log on to the SLD control center. 

 On the DB Instances and Companies tab, in the Companies area, select the databases on which you intend 

to enable the alert and scheduling services and choose Enable Alert. 

Result 

You can now log on to each of your companies in the SAP Business One client and define the alert settings on the 

client side. For more information, see the online help. 

 Pictures Folder 

To display pictures which are stored in the pictures folder in the SAP Business One client, such as company logos, 

you must perform some additional configurations.  

Procedure 

 Create a folder on a Windows machine and grant full permission to the folder, for example: 

\\server\folder\shared_folder. 

 Log on to the SAP Business One client. On the Path tab of the General Settings window (Main Menu → 

Administration → System Initialization → General Settings), specify \\server>\folder\shared_folder as 

the picture folder. 

 In the SQL Server Management Studio , execute the following query against the company schema in 

question: 

select "BitmapPath"from OADP 

The result looks like the following: "\\server\folder\shared_folder ". 

 Copy the query result to a text editor, remove the file name, and replace the backslash (\) with the forward 

slash (/). 

The result is the shared folder path saved in the database, for example: 

//server/folder/shared_folder. 

 Log on to the Linux server where SBO mailer is deployed as root and do the following: 

 Create an empty folder, for example: /mnt/sharedpicture. 

 Caution 

The name of the mount point must not contain underscores (_). 

o Correct example: /mnt/sharedpicture 

o Incorrect example: /mnt/shared_picture 

 Mount the folder in step 4 to the empty folder, using the following command: 
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mount -t cifs -o user=b1service0,pass=b1service0 

'//server/folder/shared_folder' /mnt/sharedpicture 

 Note 

The user (b1service0) and the relevant password in the command are for a Windows machine user in 

step 1. 

 SBO DI Server 

This optional service enables multiple clients to access and manipulate the SAP Business One company database. 

To use it, you are required to have a special license. 

For more information, see the SDK Help Center. 

 Fax Services 

SAP Business One offers fax services through Microsoft Fax Services. For more information, see How To Install 

and Configure Microsoft Fax Services on SAP Help Portal. 

This service can send several attachments as separate fax messages, added to a fax message. For supported file 

types, see the Microsoft documentation at www.msdn.microsoft.com. 

 Report Scheduling 

The report scheduling function of SAP Business One allows you to schedule report execution and send generated 

reports via email. To do so, you must first define the mail settings and scheduled report settings. For more 

information, see How to Schedule Report Execution and Mailing on sapparteredge.com. 

 SAP Business One Workflow 

The workflow service enables you to standardize your business operations to increase overall efficiency. With 

predefined conditions, the system automatically executes various tasks, liberating labor resources for more 

creative activities. 

For more information, see How to Configure the Workflow Service and Design the Workflow Process Templates at 

SAP Help Portal. The guide includes samples and additional reference materials. 

https://help.sap.com/viewer/index
http://www.msdn.microsoft.com/
http://www.sappartneredge.com/
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7.3 Configuring the SAP Business One Client 

After you have installed SAP Business One and logged on to the application for the first time, you must provide the 

System Landscape Directory address and port number in the System Landscape Directory Server Selection 

window. 

To start the SAP Business One client, choose Start → All Programs → SAP Business One → SAP Business One 

Client. To start the SAP Business One Client using the command line, enter the following command: 

“SAP Business One.exe" -DbServerType <Microsoft SQL Server version> -Server <Microsoft 

SQL Server instance name> -CompanyDB <Company Database> -UserName <User ID> -Password 

<Password> -SLDServiceAddress <SLD address:port> 

For the DbServerType parameter, the value depends on the version of Microsoft SQL Server you are using. For 

Microsoft SQL Server 2017, enter 11. 

 Note  

Command line parameters are case-sensitive. 

 Caution  

For security reasons, do not start the SAP Business One client using the command line in productive 

environments. You should use this method only for testing.  

In the SAP Business One toolbar, you can check the log configurations by choosing Help → Support Desk → 

Logger Setting. You can see the relevant configuration log file under …\SAP\SAP Business 

One\Conf\B1logconfig.xml. 

7.4 Assigning SAP Business One Add-Ons 

Add-ons are additional components or extensions for SAP Business One. Installing the server and client 

applications automatically registers the SAP add-ons and makes them available for installation from the SAP 

Business One application. For more information about assigning SAP add-ons to your companies, see the 

Assigning Add-Ons section in the online help document. 

The add-ons run under the SAP Add-Ons license, which is included in the Professional User license. 

SAP Business One provides the 64-bit add-ons as follows: 

• Electronic File Manager 

• Microsoft Outlook integration 

• Payment Engine 

 Note 

The ELSTER Electronic Tax Return add-on is available for download in the SAP Business One Software 

Download Center and is no longer included in the SAP Business One download package. For more 

information, see SAP Note 2064562. 

https://launchpad.support.sap.com/#/notes/2064562
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Prerequisites 

• You have a Professional license from SAP. 

• You have installed Microsoft XML 3.0 Service Pack 4 on your workstation. To ensure that this software is 

installed on the hard drive of the workstation, check that the msxml3.dll file is saved in the system32 directory 

in the main Windows directory. 

• If you chose Custom for the installation of server components, ensure that SAP Add-ons is selected in the 

Select Features window. 

• You must have Power User or Administrator rights, especially in the terminal server environment. 

The following table displays the SAP Business One add-ons and their prerequisites.  

Add-On Prerequisites 

Payment Engine Inbound Functionality is activated only when the Bank Statement Processing 

checkbox is deselected. 

Microsoft Outlook 

integration 

• You have installed the 64-bit Microsoft Outlook on your workstation. 

Supported versions: 2000 SR1 (and higher), 2002, 2003, 2007, 2010, 2013, 

and 2016 

• After installing Microsoft Outlook, you created an email account for sending 

and receiving emails. 

• Microsoft Outlook is set as your default mail client.  

After installing the Microsoft Outlook integration add-on, the SAP Business One 

entry appears in the Add-Ins menu of the following Microsoft Office applications: 

• Microsoft Outlook 

• Microsoft Word 

• Microsoft Excel 

For more information about how to use the feature, see the Microsoft Outlook 

integration online help. The help is available in the Add-Ins menu of the above 

Microsoft Office applications and from within the relevant windows in the SAP 

Business One client application (by pressing F1  in the windows). 

Datev FI Interface You have created a new company to work with the DATEV add-on and deselected 

the checkboxes: Copy User-Defined Fields and Tables and Copy User-Defined 

Objects. 

The DATEV add-on may not work with demo databases. 

7.5 Performing Post-Installation Activities for the Integration 
Framework 

After installation is complete, you can begin using the integration framework. No mandatory post-installation 

activities are necessary.  

However, for certain use cases, you need additional settings in the integration framework. The following sections 

provide information about additional configuration options and settings you can check to ensure a correct setup. 
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 Note 

The integration framework is implemented as a Microsoft Windows service with the SAP Business One 

Integration Service identifier. The service starts automatically after successful installation.  

If you cannot start the integration framework, stop and restart the service.  

You can locate the service by choosing Start → Control Panel → Administrative Tools → Services. 

 Maintaining Technical Settings in the Integration 
Framework 

The integration framework is available as version 1 and version 2. When entering the IP address or host name and 

the port in the Web browser, a Web page opens and offers you to either call framework version 1 or 2. 

The integration framework version 2 offers an Integrated Development Environment (IDE) for integration scenario 

design and enables you to deploy integration scenarios for more than one customer in cloud environments. 

Procedure 

 In the Web browser, enter the IP address or host name and the port of the integration framework on the Web 

page, click the integration framework version link. 

The Logon user interface opens. 

 In the Username field, enter B1iadmin and in the Password field, enter the password that has been provided 

during installation. 

Note that entries in the Username field are case-sensitive. 

 To add or change integration framework technical settings, in the integration framework, choose 

Maintenance. 

o To define proxy settings for your network and provide connection information for your email server, in 

framework version 1, choose Cfg Connectivity. 

In framework version 2, choose Configuration. 

o To get an overview about configuration information for message exchange between SAP Business One 

and the integration framework and about integration packages setup, choose Tools → Troubleshooting, 

and in the Functional Group field, choose B1 Setup.  

For more information about maintenance functions, in the integration framework choose Help → Documents 

→ Operations Part 2, section Framework Administration and Tools 

In framework version 2, choose Help → Documents → Operations 
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 Maintenance, Monitoring and Security 

Monitoring 

For technical monitoring purposes in framework version 1, enter the IP address or host name and the port, choose 

the framework version link. 

• For framework version 1, choose Monitoring.  

You can use the message log, access the error inbox, display SAP Business One (B1) events and use other 

monitoring functions.  

By default, the message log is active after installation. We recommend deactivating the message log in a 

productive environment. 

For additional documentation, choose Help → Documents → Operations Part 1 and Operations Part 2. 

• For framework version 2, choose Monitoring. 

You can use the transaction monitor, access the error inbox, the service monitor, scenario queue monitor, 

and so on. 

For additional documentation, choose Help → Documents → Operations 

System Landscape Directory (SLD) 

 Note 

Do not confuse the SLD for the integration framework with the SLD for the SAP Business One landscape, 

which you access from a Web browser. 

Integration framework version 1 and 2 share the SLD. To maintain systems connecting to the integration 

framework, choose Start → All programs → Integration Framework for SAP Business One → Integration 

Framework, and then choose SLD. 

For all integration packages, SAP delivers the necessary system entries in SLD.  

In SLD, make sure that you keep the entry in the b1Server field for the SAP Business One system in sync with the 

entry in the associatedSrvIP field for the WSforMobile system. 

Integration with SAP Business One integration for SAP NetWeaver 

If your SAP Business One is connected as a subsidiary to the SAP Business One integration for SAP NetWeaver 

server, it is necessary to add entries to the event subscriber manually.  

To configure the SAP Business One event subscriber to send events to a remote integration framework server, 

choose Start → All programs → Integration Framework for SAP Business One → Integration Framework, and then 

choose Maintenance → Cfg B1 Event Subscriber. 

For more information, click the documentation (Book) icon in the function. 
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Security Information 

The integration framework security guide gives you information that explains how to implement a security policy 

and provides recommendations for meeting security demands for the integration framework.  

For more information in framework version 1, enter the IP address or host name and the port, choose the 

framework version link, and choose Help → Documents → Operations: Performance, Security, Sizing section 

Security. 

For framework version 2, choose Help → Documents → Operations: Performance and Security 

 Technical B1i User 

SAP Business One creates a user with the B1i user code for each company database. The default process 

requires that you set the same password for each company database. The integration framework uses the B1i 

user to connect to SAP Business One (for example, to check authentication when using the mobile solution). 

Ensure that the password that you provided during installation of the integration framework is the same you set in 

SAP Business One. 

 Licensing 

Ensure that the SAP Business One B1i user has been assigned with the following two free licenses:  

• B1iINDIRECT_MSS 

• B1i 

No additional licenses are required for the B1i user.  

Mobile users must be licensed to access the SAP Business One system through the mobile channel. License 

administration is integrated with the SAP Business One user and license.  

 Assigning More Random-Access Memory (RAM) 

We recommend checking the performance aspects in the related documentation. 

Choose Start → All programs → Integration Framework for SAP Business One → Integration Framework, and then 

choose Help → Documents → Operations: Performance and Security. 

If you expect your system to run under very high load and to process a high number of messages, you can assign 

more random-access memory (RAM) to the integration framework server to improve performance.  

Procedure 

 On your local drive C:\Program Files\SAP\SAP Business One 

Integration\IntegrationServer\tomcat\bin\ double-click tomcat<version>.exe.  
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If the system denies access, select tomcat<version>.exe, open the context menu and select the Run as 

Administrator option. 

 In a 64-bit operating system, the default is 2048 MB for the maximum memory pool amount for Tomcat. 

Select the Java tab and increase the maximum memory pool amount. 

 Changing Integration Framework Server Ports 

By default, the integration framework server uses port 8080 for http and 8443 for https. If another application is 

already using one of these ports, change the integration framework ports. 

Procedure 

 If SAP Business One Event Sender Service is already running, stop the service. 

 In the …\Program Files (x86)\SAP\ Integration Framework for SAP Business 

One\IntegrationServer\Tomcat\conf folder, double-click the server.xml Tomcat file and in the 

connector port tag, change the settings as necessary. Do not change any other settings in the file. 

 Log on to the integration framework. 

 For framework version 1, choose Maintenance → Cfg Runtime and change the port or ports. 

For framework version 2, choose Maintenance → Configuration and change the port or ports. 

The integration framework also updates the setting in the SLSPP table in SAP Business One. 

 Restart the SAP Business One Integration Service. 

 Choose Start → All Programs → Integration Framework for SAP Business One → Integration Framework → 

Tools → Event Sender, click Setup Wizard, and follow the steps of the wizard. In the Configure Integration 

Framework Parameters section, change the Framework Server Port entry, and then test the connection. 

 Restart the SAP Business One Event Sender Service. 

 To change the properties for the menu entry of version 1, choose Start → All programs → Integration 

Framework for SAP Business One → Integration Framework. Be sure to use the correct port number. 

 Changing Event Sender Settings 

SAP Business One writes events for new data, changes and deletions to the SEVT table. Based on filter settings, 

the event sender accesses the table, retrieves data and hands over the events to the integration framework for 

further processing.  

The installation program installs and sets up the event sender on the SAP Business One server. The SAP Business 

One Event Sender setup is available as an external tool and as of SAP Business One 9.2 PL10, also in the 

integration framework. If you run the event sender on the same machine as the integration framework, we 

recommend using the setup that is part of the integration framework. 

The following section describes event sender settings, although usually no further changes are required. 
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 Note 

Only call the event sender setup in the following cases: 

o You must change the password for database access. 

o You have changed the B1iadmin password for the runtime user. 

o You have moved to another server. 

o To reduce the message load, you want to include or exclude some objects. 

o You want to exclude users. 

To check the settings for the event sender, use the integration framework troubleshooting function. In the 

integration framework version 1, choose Tools → Troubleshooting, and in the Functional Group field, choose Event 

Sender. 

Procedure 

 To call the event sender setup, choose Start → All Programs → Integration Framework for SAP Business One 

→ Integration Framework. 

The Logon user interface opens. 

 In the Username field, enter B1iadmin and in the Password field, enter the password that was provided 

during installation.     

 To open the event sender setup, choose Tools → Event Sender and click the Setup Wizard button. 

 In step 1, in the Choose Database Type field, select the SAP Business One database type. 

 In the DB Connection Settings section, you can set the following: 

o In the DB Server Name field, enter the computer name or IP address of the machine, where the database 

of the SAP Business One server is installed. Do not use localhost. 

 Recommendation 

Use the hostname of the server. Only if you have problems specifying the hostname, use the IP address 

instead. 

 Caution 

In the SAP Business One integration for SAP NetWeaver installation, this setting must be identical with 

the value in the b1Server field. If the values are not identical, they appear in the Filtered section. 

o In the Port field, enter the port number of the database server, where the SAP Business One server is 

installed. 

o In the Setup DB Account and Password fields, the installation has set the database user name and 

password for database access during setup.  

This user must have access rights to create tables and store procedures. 

o In the Running DB Account and Password fields the installation has set the database user name and 

password for database access at runtime.  

This user must have access rights to the event log and event lock tables. 

o Click Test Connection to test the connection to the SAP Business One database. 

 In step 2, the following settings are available in the Monitor Settings section. 
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o In the Idle Time (millisecond) field, you can change the time period the event sender waits until it polls 

events from SAP Business One.  

The default is 3000 milliseconds.  

o In the Batch Count field, you can set the number of events the event sender polls each time.  

The default is 10. 

 In step 3, you can change general settings for the integration framework. 

By default, the installation program sets the Sending Method to Distributed. 

The event sender sends all events to the local server address and the event dispatcher takes over the task of 

distributing the events to other systems.  

For more information, see the Operations Guide Part 2, section Configuring the B1 Event Subscriber 

 In the General Integration Framework Settings, you can configure the following: 

o In the Protocol Type field, select the protocol for the connection between the event sender and the 

integration framework. To enable https, make settings in the Tomcat administration. 

o In the Authentication field, always use the Basic option. This is the default. 

o In the Framework Server Host field, enter the name or IP address of your integration framework or the 

SAP Business One integration for SAP NetWeaver server. 

o In the Framework Server Port field, enter the port number of your integration framework or the SAP 

Business One integration for SAP NetWeaver server. 

o In the User Name field, enter the user name for accessing the integration framework or SAP Business One 

integration for SAP NetWeaver server. The default is B1iadmin. 

o In the Password field, enter the password for accessing the integration framework or SAP Business One 

integration for SAP NetWeaver server. 

o To test the connection, choose Test Connection. 

 In step 4, choose the company databases. 

The setup program displays the company databases in your SAP Business One system. For each company 

database, you can set up the following: 

 Deselect the checkbox in front of the SAP Business One company database, if the company does not use 

the integration framework. If you deselect the checkbox, SAP Business One does not create events for the 

company database in the SEVT table. 

 To define the Include List B1 Object(s) settings based on active scenario packages, click Generate. 

The SAP Business One event filter generator opens. 

o Determine the objects for the include list and click Apply. The wizard displays the list of company 

databases. 

o Select the databases for which you want to set the include filter. Note that for databases with defined 

exclude filter settings, the checkbox is disabled. 

o Click OK and the wizard writes the include filter settings to the selected databases. 

o Alternatively: 

In the Include List B1 Object(s) field, enter the object identifier of the SAP Business One object or 

objects. Separate entries by comma.  

If you enter, for example 22,17, the event sender sends events for purchase orders and orders to the 

integration framework or the SAP Business One integration for SAP NetWeaver server.  

If you leave the field empty, the event sender sends events for all SAP Business One objects to the 

integration framework or the SAP Business One integration for SAP NetWeaver server. 
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In the Exclude List B1 Object(s) field, enter the object identifier of the SAP Business One object or 

objects. Separate entries by comma.  

If you enter for example 85 the event sender excludes events for special prices for groups.  

If you leave the field empty, the event sender sends events for all SAP Business One objects to the 

integration framework or the SAP Business One integration for SAP NetWeaver server. 

 Note 

Use either the Include B1 Object(s) or the Exclude List B1 Object(s) function. Do not use the functions 

together. 

o In the Exclude List B1 User field, enter SAP Business One users for which the event sender does not 

send events to the integration framework. Enter the SAP Business One user name, not the user code. 

Separate entries by comma. 

o If you want the company database to create events based on indirect journal entries, select the 

Create Complete Journal Entry Events checkbox. Standard SAP Business One processing does not 

create events for indirect journal entries. 

  Step 5 gives you a summary of the event sender settings. To save the settings, choose Deploy. 

 Restart the SAP Business One Event Sender service and the SAP Business One client. 

Result 

The setup program stores the settings in the datasource.properties and 

eventsenderconfig.properties configuration files. 

 Changing SAP Business One DI Proxy Settings 

SAP Business One DI Proxy is the SAP Business One-related component that enables data exchange with SAP 

Business One using the DI API. No additional steps are required to set up the SAP Business One DI Proxy service. 

To influence the behavior of the SAP Business One DI Proxy service, parameters are available in the 

diproxyserver.properties file. 

Procedure 

 To change parameters, access the diproxyserver.properties file in the …SAP\SAP Business One 

Integration\DIProxy path. 

Property Description 

RMI_PORT The parameter is obsolete. 

HTTPS_PORT DI Proxy TCP port for HTTPS. 

MAXDIERRORS If this property exists and has a value greater than 0, the value defines 

the number of DI errors that may occur before the DI Proxy restarts. The 

default is 50.  
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Property Description 

RESTARTPERIOD If this property exists and has a value greater than 0, the value 

determines the time in minutes after which the DI Proxy restarts. The 

default is 60.  

ORPHANED This property defines the value in minutes after which the system 

defines a pending and not yet completed DI transaction as orphaned. 

The DI Proxy removes the transaction from the internal transaction list. 

If this property does not exist or does not have a positive value, the 

default is 10. If it exists, the default is 30.  

JCOPATH If this property exists and is not empty, it defines the path the DI Proxy 

uses to search for the JCo installation. In this case the system ignores 

any value coming from B1iP requested by an adapter.  

If the property does not exist, the system uses any value coming from 

B1iP requested by an adapter. In this case the setting is probably not 

definite.  

SAP recommends setting the JCo path in the 

diproxyserver.properties file. 

If you want to change a JCo path that someone has already maintained 

and that the system has used for connection, you can apply this change 

only after you have restarted the SAP Business One DI Proxy Service.  

Use / or \\ instead of \ as a separator in the JCOPATH value. Use for 

example C:\\Program Files\\SAP\\SAP Business One DI 

API\\JCO\\LIB 

JCOVERSION If this property exists and is not empty, it defines the version the DI 

Proxy uses to search for the JCo installation.  

restartAttemptDelay As of DI Proxy version 30002211, you can overlay the default for a 

restart delay (500 milliseconds).  

Provide a value in milliseconds. 

restartAttemptCap As of DI Proxy version 30002211, you can overlay the default number of 

restart attempts (10). 

 If you change any settings, restart the SAP Business One DI Proxy Service. 

 Using Proxy Groups 

The DI adapter allows defining multiple proxy groups in the global adapter configuration properties. This allows 

load balancing by processing requests to multiple proxies. Requests can come from IPO steps that are 

independent of each other. If you process a step using a certain proxy, the step uses the proxy during the 

complete step processing. 

You can find the following information in the proxy log file: 

• The proxy logs the processing start and stop time and describes how the proxy was stopped.  
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• Find a usage statistics summary, which lets you decide whether the proxy suits the processing requirements 

or whether it should be enhanced to a proxy group to fulfill the overall requests.  

7.5.9.1 Providing Further Proxies 

To use proxy groups, provide several DI proxies. 

Procedure 

 To enable a configuration set for a second DIProxy instance, copy the DIProxy folder and paste it. 

The system creates the DIProxy - Copy folder.  

 Rename the folder to DIProxy2.  

 In the ...\DIProxy2 folder, open the service.ini file and change the following entries: 

o ServiceName = SAPB1iDIProxy2  

o DisplayName = SAP Business One DI Proxy 2 Service  

 In the ...\DIProxy2 folder, open the diproxyserver.properties file. 

 Change the HTTPS_PORT parameter to 2098, if port 2098 is available on your machine. 

HTTPS_PORT=2098  

 Choose Start, right-click Command Prompt and choose the Run as administrator option.  

 Run service.exe with the -install parameter in the ...\DIProxy2 folder.  

 Start the SAP Business One DI Proxy 2 Service Monitor service.  

 Repeat the steps above for the number of DI Proxies you want to use. 

7.5.9.2 Adding Proxy Groups to the DI Adapter Global 
Configuration 

In the integration framework, you have the option of defining proxy groups with proxies. Define the proxy groups 

and proxies in the DI adapter global configuration. 

Procedure 

 In the integration framework, choose Tools → Control Center → Configuration → Global Adapter Config. 

 In the Global Adapter Configuration Properties user interface, for the B1DI adapter, click the Edit Global 

Configuration Properties link. 

 For the diProxyGroupList property, define the proxy groups in the following way: 

o [<groupname1> <hostname1>:<port1>,<port2>][<groupname2> 

<hostname2>:<port1>,<port2>] 

o <groupname1,2> are the proxy group names 
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o <hostname1,2> are the host names or IP addresses of the proxies 

o port1,2 are the port numbers 

Example 

You want to provide the following proxy groups:  

• alpha and beta  

• Each group has two proxies 

[alpha abc:2099 def:3701][beta 1.2.3.4:2099,3000] 

7.5.9.3 Using Proxy Groups in SLD 

In SLD, enter the proxy group definition that you want to use for a certain company database in the diProxyhost 

field of the SAP Business One company database entry in the following way, for example: [alpha] 

If you use a proxy group, leave the diProxyport field empty. 

 Integration Framework-Related Information About 
Dashboard Widgets for the Cockpit 

This information applies to integration framework version 1. 

• If the B1i user password is not correct or licenses are not properly assigned to the user, Dashboard widgets 

display the 401 not authorized error. 

In the integration framework, adjust the B1i user password in SLD. Ensure that licenses are correctly 

assigned. 

For more information, see the Licensing section. 

• If Dashboards have been activated, but not properly deployed in the integration framework, the 404 file 

not found error mentioning DASHBOARD is displayed. 

Check that all services for the integration framework are running. 

Deactivate the Dashboard widgets, log off and logon again, and activate the Dashboard widgets. 

• To support the display of dashboards, ensure that Adobe Flash Player 10.0 is installed on the client 

workstation. 

• For information about creating dashboards, see How to Develop Your Own Dashboards for SAP Business One 

on SAP Help Portal. 

https://help.sap.com/viewer/index
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8 Performing Centralized Deployment 

SAP Business One supports the central management of the SAP Business One landscape from the System 

Landscape Directory (SLD) control center. You can perform the following operations remotely through the SLD 

control center: 

•  Register logical machines  

•  Install the SAP Business One components  

• Deploy and upgrade the system database SBOCOMMON and demo databases  

• Register the database instances  

• Check the installed SAP Business One components across the whole SAP Business One landscape 

To implement central management, you should access the SLD control center in a Web browser and follow the 

steps below: 

 Configure global settings 

 Register logical machines on the SLD control center 

 Register database instances on the landscape server 

 Deploy or upgrading databases  

 Install client components 

Prerequisite 

You have copied a SAP Business One product CD on some machine within the SAP Business One landscape. 

8.1 Registering SAP Business One Installation CD 

If you intend to perform remote administrative tasks from the SLD control center, you should have previously 

created the CD repository folder and the central log directory. The CD repository folder is the folder that contains 

SAP Business One product or upgrade CDs; the central log directory can be any folder within the landscape. 

These two folders are SLD related and you should have shared them previously. You need to define the shared 

folders or reconfigure them from the SLD control center.  

 Note 

The CD repository folder and the central log directory are the prerequisites to all operations for landscape 

central management. You must create both shared folders before performing the other operations. 

Procedure 

To define or reconfigure the shared folders of SAP Business One CD repository and the central log directory, 

perform the following steps: 
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 Log on to the SLD control center.  

 On the Global Settings tab, in the Central Deployment area, click  (browse) behind CD Repository. 

 In the Share Settings window, enter the following information to define or reconfigure the CD repository 

shared folder and choose Save. 

o Share Type: The default type is CD Repository. 

o Network Path: Enter the network path of the shared SAP Business One product CD repository. The 

product CD repository could be either the exact shared folder or a subfolder of a shared folder.  

 Example 

If B1_SHR is a shared folder and B1_DEFAULT_REPO is a subfolder of the shared folder, you can specify 

either \\<IP address>\B1_SHR or \\<IP address>\B1_SHR\B1_DEFAULT_REPO as the CD 

repository shared folder. 

o Access User Name: Enter the name of a user who can access the product CD. 

o Access User Password 

 On the Global Settings tab, in the Central Deployment area, click  (browse) behind Central Log Directory. 

 In the Share Settings window, enter the following information to define or reconfigure the central log directory 

and choose Save. 

o Share Type: The default type is Central Log Directory. 

o Network Path: Enter the network path of the shared central log directory. The shared central log directory 

could be either the exact shared folder or a subfolder of a shared folder. 

 Example 

If B1_CEN is a shared folder and B1_LOG_DIRO is a subfolder of the shared folder, you can specify either 

\\<IP address>\B1_CEN or \\<IP address>\B1_CEN\B1_LOG_DIRO as the central log directory. 

o Access User Name: Enter the name of a user who can access the central log directory. 

o Access Password 

 In the Central Deployment area, define the SLD Agent timeouts. 

o SLD Agent Heartbeat Timeout: configure the time interval of the SLD Agent response to the SLD. 

 Example 

When you define the SLD Agent heartbeat timeout to 3 minutes, the SLD Agent will report the hardware 

utilization of the logical machine to the SLD every 3 minutes, and will report the installed SAP Business 

One software components on the logical machine to the SLD every 30 minutes. 

o SLD Agent Operation Timeout: configure the maximum time period for a SLD operation task, such as 

logical machines registration, client components installation.  

 Note 

The SLD Agent operation timeout does not apply to the database operation tasks, such as database 

updates. 

 In the Verbose Logging area, you can choose to enable verbose logging and download log files. 
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8.2 Registering and Unregistering Logical Machines 

SAP Business One supports the central management of the complete pool of machines in the SAP Business One 

landscape from the System Landscape Directory (SLD) control center. To manage a machine remotely, you must 

register it to the SLD. A machine is registered to the System Landscape Directory (SLD) only when the SLD Agent 

is successfully installed on it and connected to the SLD.  

 Note 

The SLD Agent is a key component of centralized deployment. The SLD Agent service executes tasks on 

behalf of the System Landscape Directory, such as performing database deployment and upgrades, 

remote installation and upgrades of SAP Business One client and DI API. The SLD Agent service is 

installed automatically during the logical machine registration in the System Landscape Directory control 

center. You can also manually install the SLD Agent service using the Components Setup Wizard. For 

more information, see Manually Installing SLD Agent Service. 

You can also cancel the registration of logical machines from the SLD control center. When you unregister 

machines, you uninstall the SLD Agent from the relevant logical machines. 

  Registering Logical Machines 

Prerequisite 

• You have defined the SAP Business One CD repository folder and central log directory. If you have not defined 

the share folders, you can go to the Global Settings tab to configure them. For more information, see 

Registering SAP Business One Installation CD. 

• If you intend to use any local account which is added into the local administration group to remotely register a 

logical machine from the SLD control center, you must set a registry key on the logical machine. The registry 

key is the LocalAccountTokenFilterPolicy file in the path 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System. The 

value is 1. 

 Note 

You do not need to set a registry key for remote registration of a local machine if you use either of the 

following types of account: 

o A local administration account. 

o A domain account which is added to the local administration group. 

Procedure 

To register a Windows machine on which the SAP Business One server components or client components are 

installed, you should perform the following steps: 

 Log on to the SLD control center.  

 On the Logical Machines tab, in the Logical Machines area, choose Register. 

 In the Register Machine - Machine Name window, specify the following information: 
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 Hostname or IP address of the machine 

 Note 

Enter the full hostname or IP address. The value of the localhost (127.0.0.1) is not allowed. 

 Machine description 

 In the Register Machine - User Credentials window, specify the following information and choose Next: 

o User name: Enter the domain and user name of a local administrator on the machine. 

o Password: Enter the password of the local administrator. 

o [Optional] Enable Secure Transfer: Select this checkbox to enable secure transfer and enter the following 

required information: 

o Certificate Common Name 

o Absolute path to CA file 

The certificate should be issued by a third-party certification authority (CA). 

 In the Register Machine - Review window, review your settings carefully before starting the machine 

registration process. If you need to change your settings, choose Previous; otherwise, choose Start to start 

the registration process. 

 In the Register Machine - Status window, choose Close to close the window. The wizard continues running in 

the background until the registration completes.  

Result 

When a logical machine is successfully registered from the SLD control center, in the Logical Machines area, you 

can see the following information, which is not shown for machines on which the SLD Agent is installed with a 

separate wizard. 

• Description: shows the description of the machine you defined during the registration process. 

There is not any description for a machine on which the SLD Agent is installed with the installation wizard. 

• Log: shows Successful which links to a log folder. It records the whole operation log during the registration 

process.  

There is no log for a machine on which the SLD Agent is installed with the installation wizard. 

8.2.1.1 Manually Installing SLD Agent Service 

You can manually install the SLD Agent service on the logical machines by using the Components Setup Wizard 

or in silent mode. 

Prerequisites 

• You have installed the SLD. 

• You have administrator rights on the machine on which you are performing the installation. 
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 Note 

For more information about possible installer issues related to the user account control (UAC) in 

Microsoft Windows operating systems, see SAP Note 1492196 

8.2.1.1.1 Wizard Installation 

The following procedure describes how to install the SLD Agent by using the Components Setup Wizard. 

Procedure 

To manually install the SLD Agent Service, do the following: 

 Navigate to the installation folder for the SLD Agent service (default path: 

\Packages.x64\ComponentsWizard) 

 Select one of the executable files to run: 

o Install.exe: enables only GUI mode installation 

o Install-console.exe: enables both GUI mode and silent mode installation. When you start running this file, 

both a GUI screen and a separate console window are opened. The console output contains the full file 

path to the actual log file. 

 In the Setup Wizard window, select Installation and Upgrade and choose Next. 

 

 In the Specify Installation Folder window, specify a folder where you want to install the SLD Agent and choose 

Next.  

 Note 

The SLD Agent is a 32-bit application so it must be installed under the default path Program Files (x86). 

 

https://launchpad.support.sap.com/#/notes/1492196
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 In the Select Features window, select SLD Agent and choose Next. 

 

 In the Network Address window, select an IP address, or use the hostname, as the network address for the 

selected components and choose Next. 
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 In the Landscape Server window, enter the landscape server address and the site user password and choose 

Next. 

 

 In the Review Settings window, review your settings carefully before proceeding to execute the installation. If 

you need to change your settings, choose Previous to go to the relevant windows; otherwise, choose Start to 

begin the installation. 
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 In the Setup Process window, when the progress bar displays 100%, choose Next to finish the installation. 

 

 In the Setup Process Completed window, review the installation results showing SLD Agent has been 

successfully installed. 
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 To exit the wizard, choose Finish. 

 

8.2.1.1.2 Silent Installation 

You can install (or upgrade) the SLD Agent in silent mode using command-line arguments and passing 

parameters from a pre-filled property file. To do so, enter the following command line: 

install-console.exe -i silent -f <property file path> [--debug] 
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Property File Format 

The property file is a text file with a simple structure [Parameter]=[Value]. Each parameter is in a separate 

line. 

For multiple values, you need separate parameter values separated by a comma. The format is as below: 

• Single value: Parameter=Value 

• Multiple values: Parameter=Value1, Value2 

 Example 

SELECTED_FEATURES=B1SLDAgent 

Parameters 

The table below lists all the parameters that are required for SLD Agent installation. 

Parameter Description 

INSTALLATION_FOLDER Installation path for SLD Agent installation (Default 

path: C:\Program Files (x86)\SAP\SAP 

Business One ServerTools\) 

LOCAL_ADDRESS The network address of the current machine. This 

address will be used for registration and 

identification of the logical machine in SLD. 

SELECTED_FEATURES The only supported value is B1SLDAgent 

SLD_SERVER_ADDR Landscape server address. 

SLD_SERVER_PORT Landscape server port number. 

SITE_USER_ID Site user name that will be used to access the 

System Landscape Directory (e.g. B1SiteUser). 

SITE_USER_PASSWORD Password for the specified site user. 

 Unregistering Logical Machines 

You can cancel the registration of logical machines from the SLD control center. When you unregister a logical 

machine, you uninstall the SLD Agent from the machine. 

Prerequisites 

You have activated the SLD Agent on the logical machine which you intend to uninstall from the SLD control 

center. 
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Procedure 

To unregister a logical machine, perform the following steps. 

 Log on to the SLD control center.  

 On the Logical Machines tab, in the Logical Machines area, select the logical machine for which you want to 

cancel the registration, and choose Unregister. 

 Note 

You can select one or multiple logical machines to unregister.  

 In the Machine Availability - Unregister Logical Machine window: 

o If SLD Agent is active on a selected logical machine, the status is Ready. 

o If SLD Agent is not active or is unable to provide access to a selected logical machine, the status is User 

Credentials Required. You are required to enter the user name and password. 

After entering the user credentials for all required machines, choose Start. 

 Note 

Logical machines cannot be unregistered in the following status: 

o You have selected a local machine on which the SLD is installed. 

 In the Status window, choose Close to close the window. The operation continues running in the background 

until it completes.  

The logical machine is removed from the logical machine list and the SLD Agent on the machine is uninstalled 

simultaneously.  

Alternatively, you can log on to the selected logical machine and manually uninstall the SLD Agent. 

8.2.2.1 Manually uninstalling SLD Agent Service 

You can log on to logical machines to manually uninstall the SLD Agent. 

On your Windows machine, in the Programs and Features window (Control Panel →Programs → Programs and 

Features), select SAP Business One SLD Agent and choose Uninstall. Alternatively, you can uninstall the SLD 

Agent by running the setup.exe file in the path C:\Program Files (x86)\SAP\SAP Business One 

SetupFiles\setup.exe. 

 Upgrading SLD Agent Service 

You can upgrade SLD Agent Service from the SLD control center. The operation of upgrading SLD Agent requires 

access to the relevant logical machines. Therefore, you must make sure logical machines are accessible for the 

upgrades. 

To upgrade the SLD Agent, perform the following steps: 

 Log on to the SLD control center.  

 On the Logical Machines tab, in the Logical Machines area, select the logical machine which you want to 

cancel the registration, click Upgrade SLD Agent. 
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 Note 

Upgrading SLD Agent requires access to the logical machine with the online SLD Agent. If SLD Agent is 

offline, you should first start it manually or from the SLD control center.  

You can select one or multiple logical machines to upgrade SLD Agent.  

 In the Machine Availability - Upgrade SLD Agent window: 

o If SLD Agent is active on a selected logical machine, the status is Ready. 

o If SLD is unable to provide access to a selected logical machine, the status is User Credentials Required. 

You are required to enter the user name and password. 

After entering the user credentials for all required machines, click Start. 

 Note 

SLD Agent cannot be upgraded in the following status: 

o The logical machine is unreachable. 

o SLD Agent is not running.  

o The installed SLD Agent is already in the latest version. 

o The installed SLD Agent is in an unknown version. 

o You have selected a local machine on which the SLD is installed. 

 In the Status window, choose Close to close the window. The operation continues running in the background 

until it completes.  

 Starting SLD Agent Service 

When SLD Agent is offline, you can invoke the SLD Agent service from the SLD control center. 

Prerequisites 

You have installed the SLD Agent service in the logical machine and the agent status is offline. 

Procedure 

 Log on to the SLD control center. 

 On the Logical Machines tab, in the Logical Machines area, select the logical machine for which you want to 

start the SLD Agent service, and choose Start SLD Agent. 

 Note 

Starting SLD Agent is performed on the logical machine with the offline SLD Agent. You can select one or 

multiple logical machines to start the SLD Agent service. 

 In the Machine Availability - Start SLD Agent window, provide the user credentials and choose Start. 
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 Note 

SLD Agent cannot be started in the following status: 

o The logical machine is unreachable. 

o SLD Agent is not found on the logical machine. 

o SLD Agent is running. 

o You have selected a local machine on which the SLD is installed. 

 In the Status window, choose Close to close the window. The operation continues running in the background 

until it completes. 

8.3 Installing and Uninstalling Client Components 

After registering a logical machine to SAP Business One System Landscape Directory (SLD), you can centrally 

deploy SAP Business One Client and Data Interface API on the machine from the SLD control center. 

You can also uninstall the client components from the SLD control center. 

 Installing Client Components 

Prerequisites 

• You have defined an SAP Business One CD repository folder and central log directory during the installation 

process. If you have not defined the share folders, you can go to the Global Settings tab to configure them. For 

more information, see Registering SAP Business One Installation CD. 

• In the SLD control center, you have registered the logical machine on which you will deploy the client 

components. For more information, see Registering Logical Machines 

Procedure 

 Log on to the SLD control center.  

 On the Logical Machines tab, in the Logical Machines area, select the machine on which you intend to deploy 

components.  

 Note 

You can select multiple machines to install the client components on different machines simultaneously.  

 In the SAP Business One Components area, choose Deploy. 

 In the Select Components window, choose the required client components.  

If you have selected multiple machines to deploy client components simultaneously, in this window you can 

see the component installation status for each selected machine.  

o If a component has been installed on a machine, you cannot install it again. 
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o If a component has not been installed on a machine, you can select the machine under the specific 

component and choose Next to continue the deployment. 

 Note 

You should install the SAP Business One Client component together with the Data Interface API 

component.  

 In the Review window, review the settings you have made and choose Start.  

 In the next Review window, choose Close to close the window. The deployment operation will continue in the 

background until it is completed. 

 On the Logical Machines tab, in the SAP Business One Components area, you can see the Deployment Status 

of the components is either To be deployed or Deploying. Once the deployment process completes, the status 

changes to Deployed. 

 Note 

If you installed components by running the setup wizard from logical machines, you can see the 

Deployment Status of the components are Deployed Externally. 

If you want an overview of all installed components across the whole landscape, go to the Components tab.  

 Uninstalling Client Components 

You can uninstall SAP Business One Client and Data Interface API which have been installed from the SLD control 

center. 

Procedure 

 Log on to the SLD control center. 

 On the Logical Machines tab, in the Logical Machines area, select the machine from which you intend to 

uninstall components.  

 Note 

You can select multiple machines to uninstall the client components from different machines 

simultaneously. 

 In the SAP Business One Components area, choose Remove. 

 In the Remove and Uninstall Components window, you can choose if you will simultaneously uninstall the 

selected SAP Business One Client and DI API components from logical machines, and then choose Continue. 

 Note 

If you do not enable the checkbox, the selected components will be only removed from the component 

list, but not uninstalled from the relevant logical machines. 

After the uninstallation, you can reinstall SAP Business One Client and Data Interface API from the SLD control 

center. 



 

88 

CUSTOMER  

© 2019 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Performing Centralized Deployment 

 

8.4 Registering Database Instances on the Landscape Server 

For companies to appear on the application's logon screen, you must register the database instances on the 

landscape server using the System Landscape Directory. 

Procedure 

 To access the SLD service, in a Web browser, navigate to the following URL: 

https://<Server Address>:<Port>/ControlCenter 

 On the logon page, enter the site user name and password, and then choose Log On. 

 Note 

The site user name is case sensitive. 

 On the DB Instances and Companies tab, in the DB Instances area, choose Add. 

 In the Add Server window, specify the following: 

o Server Name — Enter the name or IP address of the database server that you want to add. 

 Caution 

Ensure that the name of the server on which you installed Microsoft SQL Server does not contain any 

special characters, such as: &, <, >, ”, or ’. 

o Database User Name: Enter the user name of the administrator account for the database. 

o Database User Password: Enter the password of the administrator account for the database.  

 To add the database server, choose OK. 

 Backing Up Database Instances 

You can manually back up database instances from the System Landscape Directory. 

Procedure 

 Log on to the SLD control center.  

 On the DB Instances and Companies tab, in the DB instances area, select the DB instance on which you intend 

to perform the backup and click Back Up.  

 In the Back Up Instance window, choose OK to start the backup. 

 In the DB instances area, you can choose Show Backup Log to check the log of the backup operation. 
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8.4.1.1 Deleting Older Backups 

You may want to delete older instance backups (older than the last successful backup) to save disk space. You 

can perform this operation via the System Landscape Directory.  

Procedure 

 Log on to the SLD control center.  

 On the DB Instances and Companies tab, in the DB instances area, select the DB instance on which you intend 

to delete the older instance backups and click Delete Older Backups.  

 In the Delete Older Backups window, choose OK. 

The data backups and log backups which are older than the last successful backup are deleted. The backup 

files are physically removed from the backup location. 

8.5 Deploying and Upgrading Databases 

After registering database instances on the landscape server, you can use the System Landscape Directory to 

remotely deploy the system database SBOCOMMON and demo databases, and remotely upgrade the SBOCOMMON 

schema and your company schemas. 

 Deploying Databases 

Prerequisites 

• You have defined an SAP Business One CD repository folder and a central log repository folder during the 

installation process. If you have not defined the share folders, you can go to the Global Settings tab to 

configure them. For more information, see Registering SAP Business One Installation CD. 

• In the SLD control center, you have registered the logical machines on which you will deploy databases. For 

more information, see Registering and Unregistering Logical Machines. 

Procedure 

 Log on to the SLD control center.  

 On the DB Instances and Companies tab, in the DB instances area, select the DB instance on which you intend 

to deploy databases.  

 In the Companies area, choose Deploy. 

 In the Selection of Databases window, select the system database SBOCOMMON or demo databases that you 

want to deploy. 
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 Note 

The Site User and Database Server Connection windows may appear for SLD authentication and DB 

server connection in case of any connection error.  

 In the Review window, review your settings carefully before starting the databases deployment process. If you 

need to change your settings, choose Previous; otherwise, choose Start to start the deployment. 

 In the Review window, choose Close to close the window. The wizard continues running in the background and 

will close automatically after the deployment is finished.  

 Upgrading Databases 

Prerequisites 

• You have ensured that all SAP Business One clients are closed. 

 Recommendation 

We recommend that you complete or terminate all workflow instances before closing SAP Business One 

client. 

• You have defined an SAP Business One CD repository folder and a central log repository folder during the 

installation process. If you have not defined the share folders, you can go to the Global Settings tab to 

configure them. For more information, see Registering SAP Business One Installation CD. 

• In the SLD control center, you have registered the logical machines on which you will upgrade databases. For 

more information, see Registering and Unregistering Logical Machines. 

• You have manually upgraded the System Landscape Directory (SLD) to the new version. 

• You have updated the SAP Business One product CD that is used for the CD repository shared folder to the 

new version. 

Procedure 

 Log on to the SLD control center.  

 On the DB Instances and Companies tab, in the DB instances area, select the DB instance on which you intend 

to upgrade databases.  

 In the Companies area, select the database you intend to upgrade and choose Upgrade. 

 Recommendation 

Before starting upgrades, you should lock the company whose database you will upgrade. To do this, you can 

select the company and choose Lock. The company status then changes from Unlocked to Locked.  

When the company is locked, none of the SAP Business One users can log on to the company from the SAP 

Business One application. Now you can continue the next steps to perform the upgrades from SLD control 

center or start the setup wizard to upgrade the company schemas on the logical machine. 

When the upgrades complete successfully, the company status is automatically changed to Unlocked and 

SAP Business One users can log on to the relevant company again. 



 

 SAP Business One Administrator's Guide 

Performing Centralized Deployment 

 CUSTOMER  

 © 2019 SAP SE or an SAP affiliate company. All rights reserved. 91 

 

 Note 

o SAP Business One database users do not have the authorization to lock companies. Only SAP 

Business One site users can lock companies from SLD control center. 

o You can revert the company status to Unlocked by clicking the same button. 

 In the Setup Type window, select Perform Setup and choose Next. 

 In the Selection of Databases window, select the system database SBOCOMMON or the company databases 

that you want to upgrade and choose Next. 

 Note 

For upgrades, you can select only databases whose status is Ready. 

 In the Backup Settings window, specify the folder in which you want to store the backup files. 

 In the Review window, review your settings carefully before starting the databases deployment process. If you 

need to change your settings, choose Previous; otherwise, choose Start to start the deployment. 

 Choose Close to close the window. The wizard continues running in the background until the upgrades 

complete.  
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9 Maintaining Databases 

This section provides information about checking and maintaining your database system. Database activities 

depend on the nature of your organization's day-to-day work. There are many factors influencing system 

performance, such as disk space availability, the number of transactions occurring each day, and so on. It is 

essential to perform daily and regular checks to ensure the efficient operation of SAP Business One. System 

performance depends on the correct administration of the database. 

This section also lists all the stored procedures quoted in the SAP Business One application. 

9.1 Database Server Administration 

This section provides basic information about the SQL Server environment, the way a database management 

system stores and accesses the data, and the database administration tool. The information comprises the 

following topics: 

• Starting and stopping database services 

• Performing weekly tasks 

• Performing regular tasks 

• Performing backups 

• Performing restoration 

 Starting and Stopping Database Services 

Occasionally, it is necessary to stop and start database services manually, for example, when you perform a 

complete backup of the database. 

Procedure 

To stop database services: 

 Verify that no clients are logged on to SAP Business One. 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL 

Server <Version> → SQL Server Management Studio. 

 In the Object Explorer window, right-click the database server on which your SAP Business One database 

is installed and choose Stop. 

To start database services: 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL 

Server <Version> → SQL Server Management Studio. 
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 In the Object Explorer window, right-click the database server on which your SAP Business One database 

is installed and choose Start. 

 Note  

If you are not able to log on to SAP Business One, and the dialog box for choosing a company contains an 

empty list, check whether Microsoft SQL Server is running. 

If you log off the Microsoft SQL Server services, all user processes are terminated, but the database 

services keep running. 

 Weekly Tasks 

Perform the following tasks on at least a weekly basis: 

• Checking database consistency 

• Running the Update Statistics command  

If the size of the SAP Business One database is large or your company has a large volume of daily or weekly 

transactions in SAP Business One, perform the previous tasks more often. 

9.1.2.1 Checking Database Consistency 

A database consistency check performs a thorough check of the entire database. It examines all tables in the 

database to ensure that index and data pages are linked correctly and that indexes are in the correctly sorted 

order. A database consistency check also ensures that all pointers are consistent and that the data information on 

each page and page offset is reasonable.  

Performing database consistency checks enables you to recognize problems early, and prevent escalations and 

the possible loss of data. 

When performing database consistency checks, ensure the following: 

• Schedule consistency checks with the planning calendar.  

• Run consistency checks outside of normal business hours, for example on the weekends.  

• Do not schedule any other tasks at the same time as you run the consistency check. 

 Note  

On the Microsoft SQL Server level, the SAP Business One database consistency check executes the DBCC 

CHECKDB command, which locks user tables, indexes, and system tables throughout the run. 

In addition, a database consistency check is an I/O intensive process. Therefore, you should not run 

checks during normal business operations, but at times when the system load is low. 

You can use the remote support platform for SAP Business One to automatically perform database consistency 

checks as part of a defined backup strategy. For more information, see the online help for the remote support 

platform. 
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9.1.2.2 Running the UPDATE STATISTICS Statement 

The UPDATE STATISTICS statement defines the storage requirements of tables and indexes as well as the value 

distribution of columns, and stores this information in the database catalog. 

The Optimizer uses these values to determine the best strategy for executing SQL statements. Use the 

sp_updatestats procedure on all user-defined tables in the required database. 

When the UPDATE STATISTICS statement is executed, the following information about the table is stored in the 

database catalog: 

• Number of rows 

• Number of pages used 

• Size of indexes 

• Value distribution within columns or indexes 

You can use the remote support platform for SAP Business One to execute the UPDATE STATISTICS statement 

manually or as part of a scheduled task. You can also configure the remote support platform to create a job in the 

Microsoft SQL Server Agent, which updates statistics according to schedule. 

 Regular Tasks 

Performing scheduled tasks is essential for ensuring database availability and minimizing the risk of data loss. 

Perform the following tasks on a regular basis, as determined by your database size and transaction volumes: 

• Verify that the database server is running 

• Verify that the backups run successfully 

• Check the database 

• Shrink the transaction log 

• Monitor disk space 

9.1.3.1 Verifying Database Servers Are Running 

You must complete this task every morning. SAP Business One clients cannot work if the database server is not 

running. 

Procedure 

Run the SAP Business One client and log on to your database server. If you can log on, the database server is 

running. 

Alternatively, you can use the System Status Report of the remote support platform for SAP Business One to 

automate the database verification process. 
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9.1.3.2 Verifying Backups 

Backups of your database are essential for recovering the SAP Business One system in case of failure. Use this 

procedure to verify that previous backups ran successfully. 

Alternatively, you can use the remote support platform for SAP Business One to automate the backup verification 

process as part of a defined backup strategy. 

Procedure 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

<Version> → SQL Server Management Studio.  

 Select the Management folder and check the SQL server logs. 

 Search for the last backup message.  

 Verify that the backup ran successfully and that the date fits the scheduled settings. 

The following is an example of a successful backup message: 

" Database backed up. Database: myDB, creation date(time): 2005/12/21(10:57:16), 

pages dumped: 502701, first LSN: 37211:18:108, last LSN: 37211:91:1, number of dump 

devices: 1, device information: (FILE=1, TYPE=DISK: {'E:\temp\bck\myDB'}). This is 

an informational message only. No user action is required." 

9.1.3.3 Checking Databases 

The SQL Server database uses disk space to store the database data files and the daily transaction log files. If you 

do not establish a schedule for the backup of the transaction log, the log file can grow too large, causing a decline 

in system performance. Ultimately, this can stop the database system. 

The transaction log should not occupy more than 60–70% of the total available disk size. If it regularly exceeds 

this level between subsequent backups, you must save the transaction log more frequently. In SQL Server 

Management Studio, you can determine whether the data file and transaction log file are set to grow 

automatically. 

In addition, check the utilization of table space and the content of error logs on a regular basis. 

Procedure 

• To check the size of the data file and the transaction log file, do the following: 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL 

Server <Version> → SQL Server Management Studio.  

 Select the database for which you want to check the transaction log size. 

 Right-click the selected database and choose Reports → Standard Reports → Disk Usage. In the right 

pane, you can see the report. 

 Verify that there is enough free space, based on your organization’s needs, for both the data file and the 

transaction log. 
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• To set grow options for database files, do the following: 

 Open SQL Server Management Studio and select a database. 

 Right-click the selected database and choose Properties.  

 In the Properties window, from the menu on the left, choose Files. 

 The database files appear in the right pane. 

 In the Autogrowth field, set a value according to your organization’s needs. 

• To check error logs, do the following:  

 Open SQL Server Management Studio.  

 Select the Management folder and check the SQL Server Logs folder. 

 Check for error messages and verify that no problems have occurred. 

9.1.3.4 Shrinking Transaction Logs 

Shrinking the transaction log file frees up disk space and minimizes the risk of data loss. Shrinking the transaction 

log does not reduce the size of a physical log file. It removes enough inactive virtual logs to reduce the log file to 

the requested size. Use this procedure to shrink the transaction first virtually and then physically. 

In addition, you can use the remote support platform for SAP Business One to shrink the transaction log manually 

or as part of a scheduled task. You can also configure the remote support platform to create a job in the Microsoft 

SQL Server Agent, which shrinks the transaction log according to schedule. 

Procedure  

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

<Version> → SQL Server Management Studio.  

 Select the required system database. 

 Right-click the selected database and choose New Query. 

The right pane displays the Query window. 

 In the Query window, enter the following command: 

BACKUP LOG <sid> WITH NO_LOG 

Where: 

<sid> is name of the database, for example sbodemo_us 

Right-click anywhere on the query tab and choose Execute. 

This statement reduces the size of the logical log. It removes the inactive part of the log, without making a 

backup copy, and truncates the log.  

Specifying a backup device is unnecessary because the log backup is not saved. 

After you back up the log using NO_LOG, the changes recorded in the log are not recoverable. For recovery 

purposes, execute a manual backup of your database. For more information, see SAP Note 557412. 

 To reduce the size of the physical log file, enter the following command: 

DBCC SHRINKFILE (<name_logfile>, <size>) 

 

https://launchpad.support.sap.com/#/notes/557412
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<name_logfile> is the logical name of the shrunk file, for example sbodemo_us_log 

<size> is the required size for the file, in megabytes, expressed as an integer. If the size is not specified, DBCC 

SHRINKFILE reduces the size to the default file size, for example 10 MB. 

Right-click anywhere on the query tab and choose Execute. 

 Note  

In SQL Server, a DBCC SHRINKDATABASE or DBCCSHRINKFILE operation attempts to shrink the physical 

log file to the requested size (subject to rounding). 

9.1.3.5 Monitoring Disk Space 

We recommend that you regularly check the amount of free space available on the disk. You can use the System 

Status Report of the remote support platform for SAP Business One to automate the process of monitoring the 

amount of free disk space. 

 Backing Up Databases 

This section provides an introduction to backups and information about the necessity of a backup strategy. 

Databases are always at risk of damage and it is vital to implement a security strategy. 

To keep the risk of data loss low, ensure that you develop a backup strategy that suits your business and the 

requirements of your customers. An important factor to consider is the volume of data that you process each day. 

In case of data loss, you are required to retrieve this data manually, back to the time of your last backup. 

With SAP Business One, we recommend backing up your application database regularly. 

 Caution  

SAP Business One can save the configuration data only when you have write and read access to the user 

profile folder. 

You can use the following characters for a company database name: 

• A-Z 

• a-z 

• 0-9 

• Underscore (_) 

Note that spaces are not allowed. In addition, the database name must start with A-Z or a-z. 

9.1.4.1 Backup Strategies 

To choose the appropriate backup-and-restore strategy, you need to identify the requirements for the availability 

of your data. Your overall backup strategy should define the type and frequency of backups and the nature and 

speed of the hardware. 
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Consider the complexity of each strategy. Full backups are easy to implement. If you are considering backing up 

your transaction log as well, test all backup-and-restore procedures intensively. 

When choosing your backup strategy, you can use the following methods: 

• Full Backup 

In Microsoft SQL Server, a full backup is a consistent copy of your database at a certain time. Since only used 

objects are saved, normally the copy is smaller than the original database. Full backups should be scheduled 

for a time when there is a low load on the database server. 

• Differential Backup 

A differential backup is a backup of all data that has changed since the last full backup was performed. 

Compared with full backups, differential backups consume less time and disk space, but can result in a longer 

amount of time required to restore data. 

• Transaction Log Backup 

The Transaction Log is a serial record of all the transactions that have been performed on the database since 

the transaction log was last backed up. With transaction log backups, you can recover the database to a 

specific point in time or to the point of failure. 

The transaction log grows over time. If the transaction log exceeds a certain size, it can cause problems in 

Microsoft SQL Server. To prevent those problems, we recommend doing regular backups of the transaction 

log, which truncates the transaction log. 

• Backup of SAP Business One Subdirectories 

To avoid data loss, you must back up regularly the following subdirectories of SAP Business One: 

o ...\Program Files\SAP\SAP Business One\Attachments\ 

o ...\Program Files\SAP\SAP Business One\Bitmaps\ 

o ...\Program Files\SAP\SAP Business One\ExclDocs\ 

o ...\Program Files\SAP\SAP Business One\WordDocs\ 

These directories contain Microsoft Word and Microsoft Excel documents and bitmaps. To store the backed 

up directories, you can use a file archiving application. 

 Recommendation  

Test your backup and recovery procedures thoroughly. Testing helps to ensure that you have the 

required backups to recover from various failures, and that your procedures can be executed smoothly 

and quickly if a failure occurs. 

The frequency of the backups depends on the following factors: 

o Processed data volume 

o Customer requirements 

o Number of users 

Consider how much time you would need to invest in retrieving your data manually after a data loss. After 

installing or upgrading SAP Business One, perform a full backup of the SBO_DB database. 

9.1.4.2 Backup Types 

You can back up your data using the backup functionality of remote support platform for SAP Business One or 

SQL Server Management Studio, using one of the backup types described below: 
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• Full Backup and Differential Backup and/or Transaction Log Backup Using the Remote Support Platform for 

SAP Business One 

This backup type saves backup data to a network folder. The setup is relatively simple, and you can configure 

the remote support platform to automatically perform scheduled backups according to a defined strategy. 

The remote support platform can also backup SAP Business One subdirectories. 

• Full Backup Using Microsoft SQL Server Management Studio 

This backup type can save the backup data directly to tape. If you save the backups on disk, ensure the 

backup is copied to another medium, such as another hard disc, DVD, or tape. 

Do a manual backup of the files and directories of your hard disk. 

• Full Backup and Transaction Log Backup Using Microsoft SQL Server Management Studio 

 Note  

To use SQL Server Management Studio to perform transaction log backups, you should have already 

selected the Full recovery model option. 

The advantage of this type of backup is that the monitoring is partly automated and you can save the backups 

directly to a tape. You can also add alerts. Disadvantages include a relatively complicated setup and the need 

to manually back up the subdirectories of SAP Business One. However, SAP Business One does not fully 

support all of the features available with SQL Server Management Studio; therefore, if you require support 

from SAP in the future, your database backup may not be fully compatible. 

 Note  

o Full Recovery — You can perform accumulated backups and move back to a specific point in time. 

o Simple Recovery — You can back up only the whole database; after the restoration, the database 

goes back to exactly the same point at which it was backed up. 

 Example  

The following table summarizes the main options for each backup type: 

Backup Type Full Backup and 

Differential Backup 

and/or Transaction Log 

Backup 

Full Backup Full Backup and Transaction 

Log Backup 

Tool Remote support 

platform for SAP 

Business One 

Microsoft SQL Server 

Management Studio 

Microsoft SQL Server 

Management Studio 

Recovery model Full Simple Full 

Installation effort Low Medium High 

Monitoring effort Low Medium Medium 

Backup 

destination 

Disk or network share Disk or tape Disk or tape 

Automatic file 

backup 

Yes Yes No 
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Backup Type Full Backup and 

Differential Backup 

and/or Transaction Log 

Backup 

Full Backup Full Backup and Transaction 

Log Backup 

Complexity Low Medium High 

 

 Note  

SAP Business One Product Support only accepts backups on destination disks. If you back up on tape, 

you must first restore it from there, and back it up again, using a destination disk, prior to sending it to 

SAP Support. 

9.1.4.3 Troubleshooting Backups 

To ensure that your database backups are successful, check your server at regular intervals. Ensure that you have 

enough disk space on the server on which your database is stored. If you store your backup on another server, 

check that there is enough free space. 

The basic checks include: 

• Drive space 

• Disk subsystem errors 

• Tape drive errors 

• Event Viewer 

• Regular evaluation of your recovery and restore process 

Procedure 

 To check the disk space, do the following:  

 In the Microsoft Windows My Computer window, right-click Hard Disk Drives and choose Properties.  

The Properties window appears. 

 Check the free space on your hard disk. 

The free space you need on your hard disk depends on the volume of data you process each day. 

Depending on the disk system and the tape drive, scan for disk errors at regular intervals. For more 

information, see your tape drive documentation. 

 To check whether errors occurred in the operating system or on the database server, do the following:  

 In Windows, choose Start → Control Panel → Administrative Tools → Event Viewer. 

o Events that occur in the system are stored in three different logs. Within these logs, events are 

classified as Information, Warning, or Error. 

o Events that occur within the database server are stored in the Application folder. In the Source 

column of the application log, you can see the source application for a specific event. 

 Double-click an event to display more information. 

 In the Application Log, look for error events that may indicate backup failures. 
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If you perform network backups, look for network errors in the System and Application logs. 

 Restoring Databases 

If a failure damages the system, restoring the database restores the integrity of the data in most cases. Ideally, 

the downtime of the system will be minimal and no data should be lost. Develop a restore strategy that considers 

the maximum downtime allowed for your system, and estimate how much time you need to react to a system 

failure. Analyze the problem and take appropriate measures. 

You may be required to change hardware or reinstall the operating system before restoring your database. 

Ensure that an employee familiar with the restore procedures is available at all times. Testing of the restore 

procedures improves the chances of a successful and fast recovery of your data. We recommend doing test 

backups and test restores at regular intervals. 

Restore the database in the following situations: 

• Hardware failure 

• Migration to a new hardware 

• Logical errors 

• Virus 

• Testing 

9.1.5.1 Restore Checklist 

The steps below comprise a general procedure for restoring data. You may find that you do not need to perform 

each step for your particular case. 

 Analyze the problem. 

 If possible, save the current active transaction log. 

 Note  

If the database fails, but Microsoft SQL Server is still available, the transaction log contains data that has 

not been saved yet. You can save it only if the following are not damaged:  

o Hard disk on which the transaction log is saved 

o Hard disk on which the executable files are located 

If you cannot save the transaction log, you can only restore the changes that occurred after the backup of the 

last transaction log. 

 Use the necessary hardware. 

 Configure your database server. 

 Restore your last full backup. 

 Restore the transaction log. 

 Test all executed measures. 

 Release to productive operation. 
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9.1.5.2 Saving Current Transaction Logs 

 Caution  

Before you start the restore process, verify that the installed service pack has not changed since the time 

of the backup. 

Procedure 

 Insert a new tape and, to open SQL Server Management Studio, in Windows, choose Start → All Programs → 

Microsoft SQL Server <Version> → SQL Server Management Studio. 

 Select the relevant database, right-click it, and choose the New Query menu. 

 In the Query window, run the following command: 

BACKUP LOG <sid> TO <tape> WITH NO_TRUNCATE, FORMAT 

Where: 

<sid> is name of the database, for example, sbodemo_us 

<tape> is your backup tape name (case sensitive) 

 After saving the transaction log file, you can change any damaged hardware and, if necessary, reinstall your 

operating system and your Microsoft SQL Server database, as described in Installing SAP Business One. 

 Restore your last full database backup. 

The database is now in the same condition as it was when the backup was carried out. After you restore the 

transaction logs, finished transactions are applied to the database again. 

 Perform a rollforward until the end of the transaction log. 

The database is now in the same condition as it was at the time of the last transaction log backup. Since this 

condition is not consistent, perform a rollback for all unfinished transactions. 

The <msdb> database stores the history of backups and of restore operations in the backup set and backup 

file of the tables. If the msdb database is available, the recovery is based on the saved history in msdb. For 

more information, see Restoring Data When msdb Is Available. 

If the system database msdb is not available, you have to restore it and reconstruct the history. For more 

information, see Restoring Data When msdb Is Unavailable. 

 Recommendation  

To ensure a successful restore operation, you can test the restore process against a test database. If you 

use the transaction log file, we recommend testing all procedures thoroughly. 

9.1.5.3 Restoring Backup Files and Application Folders 

To restore backup files and application folders, perform the following procedures: 

 Extract the files from the backup archive, including: 

o Database backup .zip file 

o Application folder backup archive files 
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 Extract the application folder backup archive files to separate folders. 

 Manually copy the extracted files back to the original shared folders. 

9.1.5.4 Restoring Data When msdb Is Available 

This procedure provides instructions for restoring your database when the database msdb is available. When you 

use the history function, the last backups are selected automatically. 

Procedure 

 To enable the system to restore the database, close SAP Business One. 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

<Version> → SQL Server Management Studio. 

 Right-click the required database and choose Tasks → Restore → Database. 

A list of performed backups appears. The last full backup and the subsequent transaction log backups are 

selected automatically. 

 In the Restore Database window, on the Options tab, select the following options: 

o Overwrite over existing database — To overwrite the existing database, select this option. 

o Preserve the replication settings 

o Prompt before restoring each backup — Prompt the user before restoring each backup to prevent a user 

from inadvertently restoring a backup. 

o Restrict access to the restored database 

o Restore database file as — In the Restore As column, change the path name if you are restoring the 

database on a different server. 

 Note  

To specify the .bu file, do the following: 

1. In the Microsoft SQL Server Management Studio window, on the General tab, select the From Device 

radio button and choose Browse. 

2. In the Specify Backup window, choose Add. 

3. In the Locate Backup File <computer_name> window, from the Files of Type dropdown list, select All 

Files. 

4. In the hierarchy tree, specify the .bu file that you want to restore. 

5. Choose OK. 

 To confirm, choose OK. 

The system starts the database restore process. 

 Wait until the following message is displayed: 

Restore of Database <databasename> completed successfully. 

SQL Server copies the data from the backups, restoring the database and creating all dependent files. 
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9.1.5.5 Restoring Data When msdb Is Unavailable 

This section provides instructions for restoring your database when the history in the database <msdb> is not 

available, for example, after you reinstall SQL Server. For this procedure, you need your last full backup and all 

subsequent backups of the transaction log. 

Procedure 

 To enable the system to restore the database, close SAP Business One. 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

<Version> → SQL Server Management Studio. 

 Create a new database as follows: 

 Right-click the Databases folder and choose Tasks → Restore → Database. 

The Restore Database window appears. 

 Specify a name for your new database (the name of your company in SAP Business One). 

 Right-click the new database and choose Tasks → Restore → Database. 

 Select the Restore: From Device option and choose Browse. 

 In the Specify Backup window, choose Add. 

 In the Locate Backup File window, locate and select the file containing your last full backup. 

Choose OK. 

 In the Specify Backup window that opens, locate and select the file containing your last full backup.  

Choose OK. 

 In the Restore Database window, select the required back sets and on the Options tab make the following 

settings: 

o Select the Overwrite the existing database checkbox. 

o Under the Restore As column, change the path, if necessary, for example, if you are restoring the 

database on a different server where the path name does not exist. 

o In the Recovery completion state area, select the Leave database non-operational but able to restore 

additional transaction logs option. 

Choose OK.  

The system starts restoring the database. 

 Wait for the following message: 

Restore of Database <sid> completed successfully. 

Continue to the procedure for restoring transaction logs. 

9.1.5.5.1 Restoring Transaction Logs 

Procedure 

 Right-click the database you want to restore and choose Task → Restore → Transaction Log. 
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 Select the Restore: From Device option and choose Browse. 

 In the Specify Backup window, choose Add. 

 In the Locate Backup File window that appears, locate and select the file containing your last full backup. 

Choose OK, and do the same in the Specify Backup window that appears. 

 In the Restore Database window, on the Options tab, make the following settings: 

o Select Overwrite the existing database. 

o Under the Restore As column, change the path, if necessary, for example, if you are restoring the 

database on a different server where the path name does not exist. 

o In the Recovery completion state area, select the Leave database not operational but able to restore 

additional transaction logs option. 

o Choose OK. 

The system starts to restore the database. 

 Repeat this procedure for all transaction logs. 

When you reach the last transaction log, in the Recovery Completion State pane, select the Leave database 

operational option. No additional transaction logs can be restored. 

9.1.5.6 Troubleshooting Restore 

The only way to verify that you can do so is to regularly restore backups using the same medium that you would 

use in disaster recovery. 

 Recommendation  

At regular intervals, perform the procedures that would take place in case of a disaster, including the 

restore process of full and transaction log backups. 

9.2 Data Transfer Workbench for SAP Business One 

SAP Business One implementations require you to move data from legacy systems to the new SAP Business One 

system. Business data (such as customers, vendors, and products) must be available in the new system before it 

goes live. 

Data Transfer Workbench provides a wizard that imports new data into SAP Business One and updates existing 

data. To simplify the preparation of data for the import, SAP provides predefined data file templates. Data 

Transfer Workbench records import activities so you can track the data migration process. 

For more information, see the Data Transfer Workbench online help file in the document resource center. 

The data migration process consists of the following tasks: 

 Extracting data files from your legacy system 

 Cleaning data 

 Mapping data and converting data 

 Importing data into SAP Business One 

 Checking the results of the import 
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9.3 Stored Procedures 

The stored procedures listed below are all used in the SAP Business One application. The first table is for the SBO-

COMMON database and the second one is for the company database. 

 Caution  

You must not rename or remove any of the items in the list; otherwise, errors may occur when running 

SAP Business One. 

SBO-COMMON Database Procedures 

SBO- COMMON Procedures  

ClearEnumValues 

DeleteAllEnumsAndClasses 

DeleteAllObjects 

DeleteAllPropertyDefs 

DeleteClassDef 

DeleteDependentProperties 

DeleteEnumType 

DeleteMetaObject 

DeleteMetaProperty 

DeleteMetaRelation 

DeletePropertyDef 

InsertClassDef 

InsertClassDefId 

InsertEnumType 

InsertEnumTypeId 

InsertEnumValue 

InsertMetaObject 

InsertMetaProperty 

InsertMetaRelation 

InsertPropertyDef 

InsertPropertyDefId 

NumberPropertyDefs 
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SBO- COMMON Procedures  

NumberRelations 

OBSSp_GetNextExecFromSchedule 

OBSSp_GetServiceRecord 

OBSSp_UpdateScheduleRecord 

OBSSp_UpdateServiceExec 

RGSp_UpdateInstance 

RGSp_UpdateLicense 

TmSp_AliasUpdate 

TmSP_CheckDiskSpace 

TmSp_CopyCompany 

TmSp_GetCompList 

TmSP_GetDbSizeByDrives 

TmSp_GetServerTime 

TmSp_GetUsers 

TmSp_Installer_CreateTmSp 

TmSp_Installer_SetFieldValue 

TmSp_RefreshCompList 

TmSp_RestoreCompany 

UpdateClassDef 

UpdateEnumType 

UpdateMetaObject 

UpdateMetaProperty 

UpdateMetaRelationSeqNo 

UpdatePropertyDef 

UpdatePropertyDefSeqNo 

ClearEnumValues 

DeleteAllEnumsAndClasses 

DeleteAllObjects 

DeleteAllPropertyDefs 

DeleteClassDef 

DeleteDependentProperties 
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SBO- COMMON Procedures  

DeleteEnumType 

DeleteMetaObject 

DeleteMetaProperty 

DeleteMetaRelation 

DeletePropertyDef 

InsertClassDef 

 

Company Database Procedures 

Company Database Procedures  

_TmSp_AliasUpdate_OUSR 

_TmSp_AliasUpdateAfter 

_TmSp_AliasUpdateBefore 

_TmSp_ControlAccountUpgrade_OCRD 

_TmSp_ConvertGrpLine_OACT 

_TmSp_ExpnsUpdateOnDocs 

_TmSp_FormattedSearchUpdate 

_TmSp_MthDate_Update_JDT1 

_TmSp_RestoreIsCommited_OIBT 

_TmSp_SetCategoryAtOFPR 

_TmSp_SetLineNumAtADO3 

_TmSp_SetLineNumAtDOC3 

_TmSp_SetLineNumAtDOC5 

_TmSp_SetLineSeqAtDOC4 

_TmSp_SetLineSeqAtPMN5 

_TmSp_SetUniqueDocEntryAtOCRD 

_TmSp_ShekelUpdate 

_TmSp_UpdateCreateDateOnOINM 

_TmSp_UpdateDoubleName 

_TmSp_VariableUpdate_OUQR 

_TmSp_VatSumCalc 
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Company Database Procedures  

SBO_SP_PostTransactionNotice 

SBO_SP_PostTransactionSupport 

SBO_SP_TransactionNotification 

SBO_SP_TransactionSupport 

TmSp_adding_To_OITW 

TmSp_AddSqlUser 

TmSp_ChooseCIN4Correction 

TmSp_ChooseINV4Correction 

TmSp_ConGrpLine_OACT_recurs 

TmSp_ConvertGrpLine_OACT 

TmSp_CorrActReport 

TmSp_CorrActReport_BP 

TmSp_CorrActReport_BP_Split 

TmSp_CorrActReport_Split 

TmSp_DragOn 

TmSp_DragOnPk 

TmSp_FifoGetINM_Records 

TmSp_GetDocVatTotals 

TmSp_GetMaxRange 

TmSp_GetOpenRCTs 

TmSp_GetOpenRINs 

TmSp_GetUsers 

TmSp_GetWDD 

TmSp_Installer_SetFieldValue 

TmSp_OpportAnalysis 

TmSp_OpportAnalysis_CRD 

TmSp_OpportAnalysis_ITM 

TmSp_OpportAnalysis_SLP 

TmSp_OutboxSync 

TmSp_PicknPackCreateTempTable 

TmSp_Purch_An_Crd_Det_Y 
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Company Database Procedures  

TmSp_Purch_An_Crd_Grp_M 

TmSp_Purch_An_Crd_Grp_Y 

TmSp_Purch_An_Crd_Sng_M 

TmSp_Purch_An_Crd_Sng_Y 

TmSp_Purch_An_Itm_Det_Y 

TmSp_Purch_An_Itm_Grp_M 

TmSp_Purch_An_Itm_Grp_Y 

TmSp_Purch_An_Itm_Sng_M 

TmSp_Purch_An_Itm_Sng_Y 

TmSp_Purch_An_Slp_Sng_M 

TmSp_Purch_An_Slp_Sng_Y 

TmSp_RebuildAcctMatch 

TmSp_RebuildMatchHistory 

TmSp_Replace_Table 

TmSp_Sales_An_Crd_Det_Y 

TmSp_Sales_An_Crd_Grp_M 

TmSp_Sales_An_Crd_Grp_Y 

TmSp_Sales_An_Crd_Sng_M 

TmSp_Sales_An_Crd_Sng_Y 

TmSp_Sales_An_Itm_Det_Y 

TmSp_Sales_An_Itm_Grp_M 

TmSp_Sales_An_Itm_Grp_Y 

TmSp_Sales_An_Itm_Sng_M 

TmSp_Sales_An_Itm_Sng_Y 

TmSp_Sales_An_Slp_Sng_M 

TmSp_Sales_An_Slp_Sng_Y 

TmSp_SetBalanceByJdt 

TmSp_SetBgtAccumulators_ByJdt 

TmSp_SetGlStamp 

TmSp_SetVendorDeductPercent 

_TmSp_AliasUpdate_OUSR 
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Company Database Procedures  

_TmSp_AliasUpdateAfter 

_TmSp_AliasUpdateBefore 

_TmSp_ControlAccountUpgrade_OCRD 

_TmSp_ConvertGrpLine_OACT 

_TmSp_ExpnsUpdateOnDocs 

_TmSp_FormattedSearchUpdate 

_TmSp_MthDate_Update_JDT1 

_TmSp_RestoreIsCommited_OIBT 

_TmSp_SetCategoryAtOFPR 

_TmSp_SetLineNumAtADO3 

_TmSp_SetLineNumAtDOC3 

_TmSp_SetLineNumAtDOC5 

_TmSp_SetLineSeqAtDOC4 

_TmSp_SetLineSeqAtPMN5 

_TmSp_SetUniqueDocEntryAtOCRD 

_TmSp_ShekelUpdate 

_TmSp_UpdateCreateDateOnOINM 

_TmSp_UpdateDoubleName 

_TmSp_VariableUpdate_OUQR 

_TmSp_VatSumCalc 

SBO_SP_PostTransactionNotice 

SBO_SP_PostTransactionSupport 

SBO_SP_TransactionNotification 

SBO_SP_TransactionSupport 

TmSp_adding_To_OITW 

TmSp_AddSqlUser 

TmSp_ChooseCIN4Correction 

TmSp_ChooseINV4Correction 

TmSp_ConGrpLine_OACT_recurs 

TmSp_ConvertGrpLine_OACT 

TmSp_CorrActReport 



 

112 

CUSTOMER  

© 2019 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Maintaining Databases 

 

Company Database Procedures  

TmSp_CorrActReport_BP 

TmSp_CorrActReport_BP_Split 

TmSp_CorrActReport_Split 

TmSp_DragOn 

TmSp_DragOnPk 

TmSp_FifoGetINM_Records 

TmSp_GetDocVatTotals 

TmSp_GetMaxRange 

TmSp_GetOpenRCTs 

TmSp_GetOpenRINs 

TmSp_GetUsers 

TmSp_GetWDD 

TmSp_Installer_SetFieldValue 

TmSp_OpportAnalysis 

TmSp_OpportAnalysis_CRD 

TmSp_OpportAnalysis_ITM 

TmSp_OpportAnalysis_SLP 

TmSp_OutboxSync 

TmSp_PicknPackCreateTempTable 

TmSp_Purch_An_Crd_Det_Y 

TmSp_Purch_An_Crd_Grp_M 

TmSp_Purch_An_Crd_Grp_Y 

TmSp_Purch_An_Crd_Sng_M 

TmSp_Purch_An_Crd_Sng_Y 

TmSp_Purch_An_Itm_Det_Y 

TmSp_Purch_An_Itm_Grp_M 

TmSp_Purch_An_Itm_Grp_Y 

TmSp_Purch_An_Itm_Sng_M 

TmSp_Purch_An_Itm_Sng_Y 

TmSp_Purch_An_Slp_Sng_M 

TmSp_Purch_An_Slp_Sng_Y 



 

 SAP Business One Administrator's Guide 

Maintaining Databases 

 CUSTOMER  

 © 2019 SAP SE or an SAP affiliate company. All rights reserved. 113 

 

Company Database Procedures  

TmSp_RebuildAcctMatch 

TmSp_RebuildMatchHistory 

TmSp_Replace_Table 

TmSp_Sales_An_Crd_Det_Y 

TmSp_Sales_An_Crd_Grp_M 

TmSp_Sales_An_Crd_Grp_Y 

TmSp_Sales_An_Crd_Sng_M 

TmSp_Sales_An_Crd_Sng_Y 

TmSp_Sales_An_Itm_Det_Y 

TmSp_Sales_An_Itm_Grp_M 

TmSp_Sales_An_Itm_Grp_Y 

TmSp_Sales_An_Itm_Sng_M 

TmSp_Sales_An_Itm_Sng_Y 

TmSp_Sales_An_Slp_Sng_M 

TmSp_Sales_An_Slp_Sng_Y 

TmSp_SetBalanceByJdt 

TmSp_SetBgtAccumulators_ByJdt 

TmSp_SetGlStamp 

TmSp_SetVendorDeductPercent 

TmSp_UpdatingOIT 
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10 Managing Security in SAP Business One 

Your security requirements are not limited to SAP Business One but apply to your entire system landscape. 

Therefore, we recommend establishing a security policy that addresses the security issues of the entire company. 

This section offers several recommendations to help you meet the security demands of SAP Business One. 

• Data Storage Security — Provides recommendations for secure data storage in SAP Business One. 

After establishing a security policy, we recommend that you dedicate sufficient time and resources to 

implementing and maintaining the required level of security. 

10.1 Technical Landscape 

In SAP Business One, the System Landscape Directory serves as the security server, which saves database 

credentials in the SLD database. 

Database credentials are obtained by supplying SAP Business One logon credentials for authentication against 

the SLD service. Upon successful authentication, connections to common and company databases are 

established using database credentials from the SLD service.  

The following figure provides an overview of the security workflow for SAP Business One. 
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10.2 User Administration and Authentication 

This section provides an overview of how SAP Business One supports an integrated approach to user 

management and authentication. 

The table below shows the tools to use for user management and user administration with the SAP Business One. 

User Management Tools 

Tool Detailed Description Prerequisites 

System Landscape Directory 

 

The System Landscape 

Directory (SLD) control center is 

a central workplace where you 

perform various administrative 

tasks. For more information, see 

Working with the System 

Landscape Directory. 

You have the account 

information for the site super 

user (B1SiteUser). 

SAP Business One Client The application executable. For 

more information, see Client 

Components. 

You have the SAP Business One 

user account with the user 

related permissions. 

 

 User Types 

It is necessary to specify different security policies for different types of users. For example, your policy may 

specify that individual users who perform tasks interactively have to change their passwords on a regular basis, 

but not users who process job runs. Therefore, SAP classifies these types of users in the application as follows: 

10.2.1.1 SAP Business One Site Users 

The site user is not a company user type that can log on to the SAP Business One client application, but serves as 

site-level authentication for performing the following activities: 

• Creating new companies 

• Installing or upgrading SAP Business One 

• Configuring security settings in the SLD service 

• Registering database instances in the SLD service 

For more information, see Managing Site Users. 
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10.2.1.2 SAP Business One Company User 

Superusers 

A superuser can access all windows and perform all functions in SAP Business One, as well as limiting the 

authorizations of users that are not superusers. When you create a company, some predefined superusers exist in 

the system. For more information about superusers, see Standard Users. 

Regular Users 

You can define company regular users according to different business role requirements. 

The responsibilities of a regular user are to perform the relevant business work in the SAP Business One 

application. 

10.2.1.3 Microsoft Windows Domain User 

You can assign appropriate Microsoft Windows domain users as SAP Business One site users to perform 

administrative tasks that require fewer privileges in the System Landscape Directory. One site user can be bound 

with more than one Windows domain account. For more information, see Managing Site Users. 

You can also bind an SAP Business One company user account to a Microsoft Windows domain account. After 

starting the SAP Business One client, users can start using the application without being prompted to enter their 

SAP Business One logon credentials. One Windows domain account can be bound with more than one company. 

But in one company, one windows domain account can be bound with only one company user. For more 

information about the Microsoft Windows domain account authentication enablement, see Microsoft Windows 

Domain Account Authentication Enablement. 

 Standard Users 

The table below shows the standard users that are necessary for operating SAP Business One. 

 Recommendation 

For security reasons, we recommend that at the first logon, you create another standard user account as a 

substitute for the default standard user and disable the default user. 

 Recommendation 

For security reasons, we recommend that at the first logon, you create another standard user account which is 

assigned only necessary authorizations as a substitute for the default standard user and disable the default 

user. 



 

 SAP Business One Administrator's Guide 

Managing Security in SAP Business One 

 CUSTOMER  

 © 2019 SAP SE or an SAP affiliate company. All rights reserved. 117 

 

System User ID Type Password Description 

System 

Landscape 

Directory 

B1SiteUser Site user The 

password 

defined 

during the 

SLD 

installation 

process. 

It serves as site-level authentication for 

performing various administrative tasks 

with the following functions: 

• Life cycle management: installation, 

upgrade, uninstallation 

• Configuring services installed on 

Windows (for example, Workflow 

service) 

• Company creation 

For more information, see Managing Site 

Users. 

SAP 

Business 

One 

Company 

manager Company 

superuser 

manager: 

All except 

Hebrew 

 Only :מנהל

for Hebrew 

When you create a company, a 

predefined superuser named manager 

exists in the system. Due to the 

password policy, you must change the 

password of the manager user at the first 

logon. 

You can also create new superusers. The 

responsibilities of a superuser include: 

• Defining users in companies and 

setting user permissions 

• Assigning licenses 

• Configuring password policy at the 

company level 

• Upgrading companies 

AlertSvc Company 

superuser 

A randomly 

generated 

password. 

You can 

change it 

when logging 

on with 

another 

superuser 

account. 

The AlertSvc user is a default technical 

user used for the alert service. This 

technical user is used for database 

connection and not intended for any 

business transactions. You do not have 

to assign a license to this technical user, 

and we recommend that you don't. 

You can change the default user to 

another user to execute the alerts. 

 Note 

If you want to use a user 

different from the default user 

AlertSvc, you must ensure the 

user is created in all the 

companies. Otherwise, all the 

alert settings are ineffective for 

the companies missing this user. 
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System User ID Type Password Description 

For security reasons, we 

recommend that at the first 

logon you change the default 

user to another user and disable 

the AlertSvc user. 

For more information about 

changing the default user 

AlertSvc, see Alert and 

Scheduling Settings. 

B1i Company 

superuser 

A randomly 

generated 

password. 

You can 

change it 

when logging 

on with 

another 

superuser 

account. 

The B1i user is a default technical user 

for the integration framework. The 

integration framework uses the B1i 

user to connect to SAP Business One (for 

example, to check authentication when 

using the mobile solution).  

For more information, see Technical B1i 

User. 

Workflow Company 

superuser 

A randomly 

generated 

password. 

You can 

change it 

when logging 

on with 

another 

superuser 

account. 

The Workflow user is a default technical 

user used for the workflow service. This 

technical user is used for logging in to DI 

and running the workflow script. 

For more information about activating 

the Workflow user in SAP Business One 

Client, see How to Configure the 

Workflow Service and Design the 

Workflow Process Templates at SAP Help 

Portal. 

Support  Company 

superuser 

A randomly 

generated 

password. 

You can 

change it 

when logging 

on with 

another 

superuser 

account. 

A Support user (user code: Support) is 

created upon the installation or upgrade 

of SAP Business One companies. This 

new user is provided for support and 

consulting purposes.  

The Support user does not require a 

license to access the system. This can 

minimize the disruption to business 

where a user may previously have 

needed to log off the system to free up a 

license for support. 

 Note 

Certain advanced features (such 

as the analytics features) are not 

available for the Support user.  

https://help.sap.com/viewer/index
https://help.sap.com/viewer/index
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System User ID Type Password Description 

While the Support user does not need a 

license, he has the same access rights as 

those of a user with a Professional User 

license. Therefore, strict usage rules are 

applied to the Support user to prevent 

misuse, as follows: 

• After logging on to the company 

using the Support user account, the 

user must identify him/herself by 

entering his/her real name and 

selecting a login reason in the 

Support User Login window. 

• The Support user account can only 

be used if the remote support 

platform (RSP) is active (an RSP 

system status report was uploaded 

within the last 7 days). 

• The usage of the Support user is 

recorded (including the real name 

and the login reason). You can review 

the log records in the Support User 

Log window under Administration -> 

License. 

 Note 

If you had already created a user 

account Support before 

upgrading companies, the 

Support user will have the 

features described above after 

the upgrade. The licenses 

assigned to the original user 

account, the password and all 

other settings for the original 

user account remain unchanged. 

You can transfer any license 

assignments of this account to 

another user because they are 

no longer required by the 

Support user. 
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 User Management 

This section provides an overview of user administration within SAP Business One. 

10.2.3.1 Site User Management 

The site user account serves as site-level authentication for performing various administrative tasks. This section 

provides information about how to change the site user password and how to assign a Windows domain user as a 

less-privileged site user. 

10.2.3.1.1 Password Encryption 

In SAP Business One, a strong algorithm is used for data encryption and decryption. The site user ID and 

password are encrypted/hashed and saved in the System Landscape Directory. 

For security reason, we recommend that the site user password be a strong password that has the following 

characteristics: 

• Contains alphabetic, numeric, and special characters 

• Is at least seven characters in length 

• Is NOT a common word or name 

• Does NOT contain a name or user name 

• Is significantly different from previous passwords 

 Recommendation 

If you have enabled single sign-on (SSO) functionality, we recommend that you bind the SAP Business 

One site user with a domain user. Then, when you start the SAP Business One System Landscape 

Directory control center, you can enter the control center without being prompted to enter the logon 

credentials.  

Alternatively, for security reasons, we recommend that you change the length of the site user password 

to a longer one (for example, twenty characters in length) since you do not need to use the site user 

password frequently. 

You can change the site user password using the System Landscape Directory. To do so, proceed as follows: 

 To access the SLD service, in a Web browser, navigate to the following URL: 

https://<Server Address>:<Port>/ControlCenter 

 In the logon page, enter the site user name (B1SiteUser) and password, and then choose Log On. 

 Note 

The site user name is case sensitive. 

 On the Security Settings tab, in the Site Password area, choose Change. 

 In the Change Site Password window, enter the current password, and then enter and confirm the new 

password you want to use. 
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 To save the new password, choose OK. 

10.2.3.1.2 Domain Users as Less-Privileged Site Users 

In the System Landscape Directory control center, you can assign a Windows domain user as a less-privileged site 

user. For more information, see Managing Site Users. 

10.2.3.2 Company User Management 

In SAP Business One, you can define, change or delete company users or change passwords according to 

different business role requirements. 

10.2.3.2.1 Defining Users 

To define users, start the SAP Business One client A and navigate to the Users-Setup Window. For more 

information about defining users, see the online help of SAP Business One. 

10.2.3.2.2 Updating Users 

Procedure 

To update a defined user, do the following: 

  Log on to the SAP Business One client. 

 From the SAP Business One Main Menu, choose Administration → Setup → General → Users.  

 In the Users-Setup window, click the Find button on the toolbar and switch to Find mode. 

 Navigate to the user you want to update.  

 Update the user’s information and click the Update button. 

10.2.3.2.3 Deleting Users 

Prerequisites 

• You have removed the licenses assigned to the user you want to delete. For more information, see the SAP 

Business One online help. 
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• You have unbound the employee associated to the user you want to delete. For more information, see the 

SAP Business One online help. 

Procedure 

To delete a defined user, do the following: 

 Log on to the SAP Business One client. 

 From the SAP Business One Main Menu, choose Administration → Setup → General → Users.  

 In the Users-Setup window, click the Find button on the toolbar to switch to Find mode. 

 Navigate to the user you want to delete.  

 Right-click anywhere in the Users-Setup window and choose Remove.  

The user is deleted, and it is not possible to add a new user with the same user code.  

 Note 

When you remove a company regular user in SAP Business One, the user is just marked as Removed but 

is not completely deleted from the database. If you have any requirement for data protection and privacy, 

see How to Manage the Protection of Personal Data in SAP Business One on SAP Help Portal. 

10.2.3.2.4 Changing Passwords 

As standard practice, SAP Business One authenticates users based on their user accounts and passwords. 

You can change your password at any time. In addition, the application checks the password validity of each logon 

attempt according to the selected security level. 

 Note 

To change your password, choose Administration → Setup → General → Security → Change Password. 

If you are required to change your password, the application displays the Change Password window. You must 

change the password to log on. 

The new password must comply with the settings of the selected security level, containing at least: 

• x characters 

• x lowercase 

• x uppercase 

• x digits 

• x non-alphanumeric 

The application saves passwords in the database in encrypted form. The last n passwords are also encrypted. 

When appraising a new password, the application first encrypts and then compares it with the saved ones. 

The password policy defines global guidelines and rules for password settings, such as the following: 

• Time interval between password changes 

• Required and forbidden letters and characters 

• Minimum required number of characters 

• Number of logon attempts before the system locks the user account 

https://help.sap.com/viewer/index
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The password policy improves the security of SAP Business One and enables administrators to apply the required 

security level for their organization. 

 Note 

Only a superuser can change the security level. You can use the Password Administration window to 

change the security level. To open the window, choose Administration → Setup → General → Security → 

Password Administration. 

SAP Business One supports the following approaches to raising the security level of user authentication: 

• Increase the complexity of the password. 

• Increase the frequency of password changes. 

For more information about working with passwords in SAP Business One, see SAP Note 978292. 

10.2.3.3 Microsoft Windows Domain Account Authentication 
Enablement 

SAP Business One supports single sign-on (SSO) functionality. You can bind an SAP Business One user account 

to a Microsoft Windows domain account.  

 Note 

SAP Business One supports only Microsoft Windows accounts to be bound with SAP Business One user 

accounts.  

After starting the SAP Business One client, you can start using the application without being prompted to enter 

your SAP Business One logon credentials. 

 Caution 

To be able to use the single sign-on function, you must have specified a domain user and password during 

installation of the System Landscape Directory. Otherwise, even if you have performed all the following 

steps to set up single sign-on, you still cannot single sign-on to SAP Business One using domain user 

accounts. 

To use the single sign-on function, you must complete the following steps: 

 Register a Service Principal Name (SPN). 

 Bind SAP Business One users to Microsoft Windows accounts. 

 Enable the single sign-on function in the SLD. 

10.2.3.3.1 Registering the Service Principal Name 

To enable Windows domain single sign-on with SAP Business One, you must register a service principal name 

(SPN) for the SLD service. The SPN can be registered before or after you install the System Landscape Directory. 

Nevertheless, if you register the SPN after the installation, the domain user account used for installation must be 

used for SPN registration. 

https://launchpad.support.sap.com/#/notes/978292
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 Recommendation 

As this domain user is a service user that functions purely for the purpose of setting up single sign-on, we 

highly recommend that you create a new domain user and do not assign any additional privileges to the 

user other than the logon privilege. In addition, keep the user’s password unchanged after enabling single 

sign-on; otherwise, single sign-on may stop working. 

Prerequisites 

You are a domain administrator or have been delegated the appropriate authority. 

Procedure 

 On a Windows computer, run the command prompt as an administrator. 

 Run the following setspn command: setspn -U -A <SPN> <Domain User Name>. 

An example of an SPN is SLD/Domain.com. 

10.2.3.3.2 Binding SAP Business One Users to Microsoft 
Windows Accounts 

After you bind SAP Business One users to Microsoft Windows domain accounts, the users can log on to SAP 

Business One without specifying their user credentials. 

Manual Binding 

The following procedure describes how to bind SAP Business One users individually: 

 From the SAP Business One Main Menu, choose Administration → Setup → General → Users.  

 In the Users - Setup window, in the User Code field, specify the user that you want to bind.  

 In the Bind with Microsoft Windows Account field, enter the domain and user name of the Microsoft Windows 

domain account to which you want to bind the user. 

 Caution 

The domain user name is case-sensitive. Therefore, you must ensure that you enter the domain user 

name exactly as it was created in the domain, including the letter case. 

 Choose Update. 
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10.2.3.3.3 Copying User Mappings Between Companies 

You can copy user mappings between two companies provided that the same user exists in both companies. Each 

user is identified by the user code (not the user name). 

Typical scenarios for this function are as follows: 

• You have moved your company schema from a test system to a productive system. 

• You have moved your company schema to another server. 

• You have imported and renamed your company schema (the old schema also exists on the same server). 

To copy user mappings, do the following: 

 Log on to the System Landscape Directory in a Web browser. 

 On the Security Settings tab, in the Authentication section, choose Copy User Mappings. 

 In the Copy User Mappings Between Companies window, specify the source and target companies. 

 Note 

To be available for selection, the servers must be registered in the System Landscape Directory. 

However, the company schema versions do not matter. 

 To display SAP Business One users whose mappings can be copied, choose Check. 

If a user exists only in the source company but is bound to a domain account, the user is displayed as missing 

in the target company. However, if a user exists only in the target company, the user is not displayed. 

 To copy user mappings to the target company, choose Copy. 

10.2.3.3.4 Enabling Single Sign-On 

After you enable SSO, the Choose Company window displays only the companies to which your Windows account 

is bound. 

 Caution 

Enabling SSO in the SLD activates this functionality for all companies in the landscape. 

Procedure 

 In a Web browser, navigate to the following URL: https://<Server 

Address>:<Port>/ControlCenter. 

A Web browser opens and displays the logon page for the SLD service. 

 In the logon page of the Web browser, enter the site user name and password, and then choose Log On. 

 Note 

The site user name is case sensitive. 

 On the Security Settings tab, select the checkbox Enable Single Sign On (Log On Using Windows Domain 

Account). 
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If you did not choose to activate the single sign-on function during installation of the System Landscape 

Directory, this checkbox is deselected and not editable. 

 If you want to prevent logons using SAP Business One user accounts and enforce single sign-on using domain 

accounts, select the checkbox Disable logons with SAP Business One User Accounts. 

If you keep this checkbox deselected, users can log on using both SAP Business One user accounts and 

Windows domain accounts. 

 Choose Update. 

Result 

Each user must confirm the binding upon first logon. After confirmation, the user can log on to SAP Business One, 

using the bound Windows account. 

 Caution 

The first time you single sign-on to SAP Business One using your domain user account, ensure you have 

logged on to the Windows system using the correct domain user name (case sensitive). If not, log off and 

then log on again using the correct user name; otherwise, single sign-on will not work. 

If the system administrator has not disabled logons using SAP Business One user accounts, you can still log on 

with an SAP Business One user account (which does not have to be bound to a Windows account), as below: 

 In the logon window, deselect the Logon with Windows Account checkbox (or in the Choose Company window, 

deselect the checkbox Log on with Current Domain User). 

 Manually enter the company schema name. 

 Enter your SAP Business One user name and password. 

 Choose OK. 

 Caution 

If the system administrator has disabled logons using SAP Business One user accounts, you must bind 

each SAP Business One user to a Windows account and each user must confirm the binding; otherwise, 

logon is not possible. 

 User Authentication 

As standard practice, SAP Business One authenticates users based on their user accounts and passwords. You 

can change your password at any time. For more information about working with passwords in SAP Business One, 

see Changing Passwords. 

Simultaneously, SAP Business One supports single sign-on (SSO) functionality by using the following approaches: 

• On Web pages, SSO is accomplished using Security Assertion Markup Language (SAML) 2.0 and the System 

Landscape Directory (SLD) is the Identity Provider. 

 Example 

In a Web browser, when you navigate to the SAP Business One job service URL, http://<Server 

Address>:<Port>/job, you are redirected to the SLD logon page. After finishing the authentication on 

the SLD logon, you go back to the previous job service page. 
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• On native applications, for example, on the SAP Business One client, if you enabled Microsoft Windows 

domain account authentication, SSO is accomplished using Kerberos. For more information about binding an 

SAP Business One user account to a Microsoft Windows domain account and enabling single sign-on, see 

Microsoft Windows Domain Account Authentication Enablement. 

10.3 Authorization  

Authorizations allow users to view, create, and update documents that you assign to them, according to data 

ownership definitions. By default, a new user has no authorizations. Each user can have only one manager who 

assigns permissions. 

You can define users as either regular users or superusers. 

• Regular Users: 

o Can perform certain actions, for example, award discounts, change prices, or access confidential 

accounts, with the proper authorizations. 

o Cannot assign authorizations to other users. 

• Superusers: 

o Have full and unrestricted authorization to access users in the system, apart from to their own logins. 

o Automatically have full authorization to access all functions in the system. 

o Can define authorizations and permissions for other users. 

For more information about SAP Business One user authorization, see the SAP Business One online help. 

10.4 Network and Communication Security 

We strongly recommend using SAP Business One in trusted environments only (corporate LAN with firewall 

protection).  

To work with SAP Business One outside your corporate networks, you can use Citrix or similar third-party 

solutions. 

 Communication Channels 

TCP/IP provides the communication channels between the following: 

Client Side Server Side Protocol Used 

Agent of SAP Business One 

Clients 

System landscape directory HTTPS 

Agent of SAP Business One 

Clients 

The shared folder b1_shf SAMBA 
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Client Side Server Side Protocol Used 

Agent of SAP Business One 

remote support platform 

SAP Business One server ODBC 

IM service Company database JDBC 

Integration framework Company database JDBC 

Integration framework Integration framework database JDBC 

Integration framework SAP Business One license server HTTPS 

Job service Company database JDBC 

Job service SMTP server SMTP 

Job service System landscape directory HTTPS 

Mobile service System landscape directory HTTPS 

SAP Business One Clients Company database ODBC 

SAP Business One Clients IM service HTTPS 

SAP Business One Clients System landscape directory HTTPS 

SAP Business One Clients The shared folder B1_SHR SAMBA 

SAP Business One Clients Workflow service HTTPS 

SAP Business One DI API Company database ODBC 

SAP Business One DI API System landscape directory HTTPS 

System landscape directory Domain controller LDAP, Kerberos 

System landscape directory Service unit database JDBC 

System landscape directory System landscape directory 

database 

JDBC 

(can be encrypted via SSL) 

Web browser Integration framework HTTP or HTTPS 

Web browser System landscape directory HTTPS 

Web browser Workflow service HTTPS 

Workflow service Company database JDBC 

 

 Configuring Services with Secure Network Connections 

To make communication safer, we recommend that you configure the SAP Business One services with secure 

network connections. 
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10.4.2.1 Server Tools 

10.4.2.1.1 CORBA License Server 

The default port for the CORBA license server is 30000 or 30001. The CORBA license server enforces secure 

connection via CORBA. 

The CORBA license server now is the proxy of the HTTPS license server only for compatibility purposes and may 

be removed in future patches. We do not recommend you use SAP Business One Service Manager to configure 

the license service. 

10.4.2.1.2 Components in Shared Tomcat  

In SAP Business One, the following components share the same Tomcat: 

• System Landscape Directory 

• License Service (HTTPS) 

• Job Service 

• Extension Manager 

• You can configure the components with the same network security settings as follows: 

• The default port is 40000. This port should be exposed to the Internet if you need to use some SAP Business 

One components on Internet.  

• The components enforce secure connections via HTTPS encryption with TLS version 1.0 or 1.1 or 1.2; the 

corresponding TLS cipher suites are listed as follows: 

o TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256, 

o TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA384, 

o TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA, 

o TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256, 

o TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA384, 

o TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA, 

o TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA256, 

o TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384, 

o TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA, 

o TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA256, 

o TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384, 

o TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA, 

o TLS_RSA_WITH_AES_128_GCM_SHA256, 

o TLS_RSA_WITH_AES_128_GCM_SHA384, 

o TLS_RSA_WITH_AES_128_GCM_SHA, 

o TLS_RSA_WITH_AES_128_CBC_SHA256, 

o TLS_RSA_WITH_AES_128_CBC_SHA384, 
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o TLS_RSA_WITH_AES_128_CBC_SHA, 

o TLS_RSA_WITH_AES_256_GCM_SHA256, 

o TLS_RSA_WITH_AES_256_GCM_SHA384, 

o TLS_RSA_WITH_AES_256_GCM_SHA, 

o TLS_RSA_WITH_AES_256_CBC_SHA256, 

o TLS_RSA_WITH_AES_256_CBC_SHA384, 

o TLS_RSA_WITH_AES_256_CBC_SHA 

The components need a valid PKCS 12 certificate to function properly. The default certificate option is a self-

signed certificate. However, for security reasons, we strongly recommend that you specify a valid certificate 

during the installation process or change the certificate to a valid one after the installation.  

10.4.2.1.3 Workflow 

The default port for SAP Business One Workflow is 60000. The workflow enforces secure connections via HTTPS 

encryption with TLS version 1.1 or 1.2. The corresponding TLS cipher suites are listed as follows: 

• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256, 

• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA384, 

• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA, 

• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256, 

• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA384, 

• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA, 

• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA256, 

• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384, 

• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA, 

• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA256, 

• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384, 

• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA, 

• TLS_RSA_WITH_AES_128_GCM_SHA256, 

• TLS_RSA_WITH_AES_128_GCM_SHA384, 

• TLS_RSA_WITH_AES_128_GCM_SHA, 

• TLS_RSA_WITH_AES_128_CBC_SHA256, 

• TLS_RSA_WITH_AES_128_CBC_SHA384, 

• TLS_RSA_WITH_AES_128_CBC_SHA, 

• TLS_RSA_WITH_AES_256_GCM_SHA256, 

• TLS_RSA_WITH_AES_256_GCM_SHA384, 

• TLS_RSA_WITH_AES_256_GCM_SHA, 

• TLS_RSA_WITH_AES_256_CBC_SHA256, 

• TLS_RSA_WITH_AES_256_CBC_SHA384, 

• TLS_RSA_WITH_AES_256_CBC_SHA 
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The default certificate option is a self-signed certificate. However, for security reasons, we strongly recommend 

that you specify a valid certificate during the installation process or change the certificate to a valid one after the 

installation. 

10.4.2.1.4 SBO Mailer 

The SBO Mailer is connected to the SMTP server. We recommend that you use SSL/TLS encryption for the SMTP 

server connection. 

If you use SSL/TLS encryption, you must select Microsoft .Net for SMTP Client during the SBO Mailer 

configuration. The version of the SSL/TLS protocol depends on your operating system and the version of the 

installed Microsoft .Net Framework. For more information about securely configuring the SSL/TLS protocol, see 

Transport Layer Security (TLS) best practices with the .Net Framework. 

10.4.2.2 Reverse Proxy 

A reverse proxy works as an interchange between internal SAP Business One services and external clients. All the 

external clients send requests to the reverse proxy and the reverse proxy forwards their requests to the internal 

SAP Business One services. To handle external requests, we recommend that you deploy a reverse proxy rather 

than using NAT/PAT. 

The default port for reverse proxy is 443. 

The reverse proxy enforces secure connection via HTTPS encryption with TLS version 1.0 or 1.1 or 1.2 and the 

corresponding TLS cipher suite is ECDHE-RSA-AES256-SHA384:AES256-

SHA256:RC4:HIGH:!MD5:!aNULL:!EDH:!AESGCM  

10.4.2.3 Integration Framework 

By default, the integration framework server uses port 8080 for HTTP and 8443 for HTTPS. You do not need to 

expose the port to the Internet.  

If you choose the HTTPS connection, use TLS version 1.0 or 1.1 or 1.2; the corresponding TLS cipher suites are 

listed as follows: 

• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256, 

• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA384, 

• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA, 

• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256, 

• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA384, 

• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA, 

• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA256, 

• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384, 

• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA, 

https://docs.microsoft.com/en-us/dotnet/framework/network-programming/tls
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• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA256, 

• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384, 

• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA, 

• TLS_DHE_RSA_WITH_AES_128_GCM_SHA256, 

• TLS_DHE_RSA_WITH_AES_128_GCM_SHA384, 

• TLS_DHE_RSA_WITH_AES_128_GCM_SHA, 

• TLS_DHE_RSA_WITH_AES_128_CBC_SHA256, 

• TLS_DHE_RSA_WITH_AES_128_CBC_SHA384, 

• TLS_DHE_RSA_WITH_AES_128_CBC_SHA, 

• TLS_DHE_RSA_WITH_AES_256_GCM_SHA256, 

• TLS_DHE_RSA_WITH_AES_256_GCM_SHA384, 

• TLS_DHE_RSA_WITH_AES_256_GCM_SHA, 

• TLS_DHE_RSA_WITH_AES_256_CBC_SHA256, 

• TLS_DHE_RSA_WITH_AES_256_CBC_SHA384, 

• TLS_DHE_RSA_WITH_AES_256_CBC_SHA, 

• TLS_RSA_WITH_AES_128_GCM_SHA256, 

• TLS_RSA_WITH_AES_128_GCM_SHA384, 

• TLS_RSA_WITH_AES_128_GCM_SHA, 

• TLS_RSA_WITH_AES_128_CBC_SHA256, 

• TLS_RSA_WITH_AES_128_CBC_SHA384, 

• TLS_RSA_WITH_AES_128_CBC_SHA, 

• TLS_RSA_WITH_AES_256_GCM_SHA256, 

• TLS_RSA_WITH_AES_256_GCM_SHA384, 

• TLS_RSA_WITH_AES_256_GCM_SHA, 

• TLS_RSA_WITH_AES_256_CBC_SHA256, 

• TLS_RSA_WITH_AES_256_CBC_SHA384, 

• TLS_RSA_WITH_AES_256_CBC_SHA 

The integration framework service needs a valid JKS format certificate. The default certificate option is a self-

signed certificate. However, for security reasons, we strongly recommend that you perform the following steps: 

 Disable the HTTP protocol by removing the following parameters from the Tomcat configuration file: 

<Connector port="8080" protocol="HTTP/1.1" connectionTimeout="20000" 

redirectPort="8443" enableLookups="false" server=" "/> 

 Restart the integration framework service 

 Change the self-signed certificate to a valid one. For more information, see SAP Note 2405043. 

 Note 

If you already have disabled the HTTP protocol or changed the port, check the protocol and port value in the table 

SLSPP of database SBO-COMMON (SBOCOMMON). 

https://launchpad.support.sap.com/#/notes/2405043
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 Security Certificate Verification During SSL 
Communication  

You can configure the security certificate verification during the SSL communication between SAP Business One 

services. 

Prerequisites 

In SAP Business One Server Tools, the hostname or FQDN must match the common name of the security 

certificate and the mapping must be valid. 

Procedure 

 Prepare a PKCS12 format keystore file, for example, keytool.exe -genkey -alias b1trust -keyalg 

RSA -keystore tust.p12 -keysize 2048 -storetype PKCS12. 

 Import all certificates that are used in SAP Business One Services (such as System Landscape Directory) into 

this keystore file, for example, keytool.exe" -import -trustcacerts -alias <servicename> -

file <service.cer> -keystore tust.p12 -storetype PKCS12. 

o If there is a chain for the certificates, import all certificates on this chain into the keystore. 

o If you are using IP address, hostname and FQDN for server configuration, you need to issue a new 

certificate that includes Subject Alternative Name (SAN) for IP address/hostname/FQDN, and then 

import the certificate into SAP Business One Server Tools. For more information about updating the 

certificates, see SAP Note 2046101. 

 Log on to the Microsoft SQL server, and navigate to the folder <server tools install 

folder>\Common\tomcat\bin>. 

 Rename tomcatw.exe to B1ServerToolsw.exe and run as administrator. 

 Add the two lines below into Java Options on the Java tab. 

o -Dcom.sap.b1.ssl.trustStore=<path to keystore> 

o -Dcom.sap.b1.ssl.trustStorePassword=<password> 

 Restart SAP Business One Server Tools. 

 SSL Encryption 

You can secure the following communication channel using SSL encryption: 

• SAP Business One server ⇔ SAP Business One clients 

 Note  

Using SSL encryption may degrade network performance. SSL encryption requires certificates, which are 

time limited and require annual renewal. You can acquire the necessary certificates using either of the 

following methods: 

o Third-party Certificate Authority 

https://launchpad.support.sap.com/#/notes/2046101
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You can purchase certificates from a third-party global Certificate Authority that Microsoft Windows 

trusts by default. 

o Certificate Authority Server 

You can configure a Certificate Authority (CA) server to issue certificates. If you choose this method, 

you must configure all machines in your SAP Business One landscape to trust the CA’s root 

certificate. 

10.4.4.1 Encrypting Communication with Databases 

To secure the TCP/IP communication channel between the database server and SAP Business One clients, you 

can implement SSL encryption. This prevents SAP Business One application data, including the database 

credentials, from being exposed. 

SAP Business One fully supports SQL SSL. We recommend that you implement SSL in SAP Business One without 

making configuration changes in SAP Business One. For more information, see 

http://support.microsoft.com/kb/316898 or contact your IT administrator. 

For information about Microsoft SSL encryption guidelines, see www.msdn.microsoft.com and search for the 

following topics: 

• Net-Library Encryption 

• Client Net-Libraries 

10.5 Data Storage Security 

The security of the data saved in SAP Business One is generally the responsibility of the database provider and 

your database administrator. As with your application infrastructure, most of the measures that you should take 

depend on your strategy and priorities.  

There are a few general measures, as well as database-specific measures, that you can take to increase the 

protection of your data. Details are provided in the following sections: 

• Exporting the Configuration File 

• Importing the Configuration File 

• Configuration Logs and User Settings 

 Data Storage 

In SAP Business One, according to the different types and purposes, the data is stored in different databases, as 

follows: 

• SLD Database 

The SLD database stores the SLD data and contains the persistent landscape information and security 

settings. The SLD database must be protected with the highest priority. 

• Company Database 

http://support.microsoft.com/kb/316898
http://www.msdn.microsoft.com/
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Company database stores business or transactional data. 

• System Database (SBOCOMMON) 

System database holds system data, version information, upgrade information, and shared data of each 

company. 

• Shared Folder (B1_SHR) 

Shared folder contains central configuration data as well as installation files for various client components. It 

also stores the files used in business, for example, attachments, templates. 

• Database for SAP Business One integration framework 

The default database name is IFSERV. You can define a new name when installing the integration framework. 

 Exporting Configuration Files 

To secure your data, we recommend that you export your security configuration file right after you finish installing 

the license server and the SAP Business One server. 

The configuration file contains the following important information: 

• Site user password 

• Database information 

• Read-only database user information 

• Algorithm information 

Procedure 

To export the security configuration file, do the following: 

 To access the SLD service, in a Web browser, navigate to the following URL: 

https://<Server Address>:<Port>/ControlCenter 

 In the logon page, enter the site user name and password, and then choose Log On. 

 Note 

The site user name is case sensitive. 

 On the Security Settings tab, in the Encryption Key Management area, choose Export Dynamic Key. 

 Recommendation  

The site user password is required if you later import the security configuration file to restore the 

configured security settings. Thus, keep a record of the site user password when you are exporting the 

configuration file, especially if you want to change the site user password after the configuration file is 

exported. 
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 Importing Configuration Files 

If your license server crashes or is corrupted, you must set up a new license server. After the new license server is 

started up, to restore all the security settings you had before, you can import the security configuration file.  

Prerequisites 

• You have a record of your old security configuration file. For more information, see Exporting Configuration 

Files. 

• You have placed the appropriate configuration file on the server under the directory: C:\Program Files 

(x86)\SAP\SAP Business One ServerTools\System Landscape Directory\incoming. 

Procedure 

 To access the SLD service, in a Web browser, navigate to the following URL: 

https://<Server Address>:<Port>/ControlCenter 

 In the logon page, enter the site user name and password, and then choose Log On. 

 Note 

The site user name is case sensitive. 

 On the Security Settings tab, in the Encryption Key Management area, choose Import Dynamic Key. 

 In the Import Dynamic Key window, do the following: 

o Select the configuration file that you want to import. 

o In the Site User Password For Export field, specify the site user password you had when the configuration 

file was exported. 

o To import the file, choose OK. 

 Note 

The exported configuration files use hardware-specific encryption. Therefore, you cannot import the 

configuration file to another server. 

 Backing Up and Restoring the License Assignment 

To secure your data, we recommend that you back up your license assignment after you finish installing the 

server tools and the SAP Business One server. 

If the server on which you install the server tools crashes or is corrupted, you must restore the license assignment 

after the new license server is started. 
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Procedure 

Backing up the License Assignment 

 Stop the server tools. 

 Copy the license assignment file B1Upf.xml in the path C:\Program Files (x86)\SAP\SAP 

Business One ServerTools\LicenseHTTPS\webapps\lib to the backup storage. 

 Copy the license files, such as B1LicenseFile-<installation number>.txt in the path 

C:\Program Files (x86)\SAP\SAP Business One ServerTools\LicenseHTTPS\webapps\lib 

to the backup storage. 

 Start the server tools 

Restoring the License Assignment 

 Stop the server tools. 

 Copy the license assignment file B1Upf.xml from the backup storage to the installation folder 

C:\Program Files (x86)\SAP\SAP Business One 

ServerTools\LicenseHTTPS\webapps\lib. 

 Copy the license files, such as B1LicenseFile-<installation number>.txt from the backup 

storage to the installation folder C:\Program Files (x86)\SAP\SAP Business One 

ServerTools\LicenseHTTPS\webapps\lib. 

 Start the server tools 

 Configuration Logs and User Settings 

In SAP Business One, configuration changes are logged in files formatted as xxx.pidxxxxx (xxx after pid can be the 

date, such as 20100325, so that you can find the latest log file) under %ProgramData%\SAP\SAP Business 

One\Log\SAP Business One\%USERNAME%\BusinessOne. 

The configuration changes include: 

• Adding/Removing users 

• Changing a user to a superuser / non superuser 

• Changing user passwords 

• Changing user permissions 

• Changing password policy 

• Changing company details 

 Note  

To find the logs containing changes to company details, do the following: 

1. From the SAP Business One Main Menu, choose Administration → System Initialization → Company 

Details. 

2. In the menu bar, choose Tools → Change Logs. 



 

138 

CUSTOMER  

© 2019 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Managing Security in SAP Business One 

 

However, the following configurations cannot be logged: 

• Changing data ownership authorizations 

• Changing data ownership exceptions 

• Changing license settings 

• Setting Read-Only DB users 

If you fail to log on to SAP Business One, the log is recorded in the Event Viewer. 

As of SAP Business One 2007, any specific user settings are saved in a file named b1-current-user.xml under 

C:\Documents and Settings\XXX(user id)\Local Settings\Application Data\SAP\SAP 

Business One. In this situation, if a user changes his or her settings in SAP Business One, the changes are saved 

in this folder and do not affect other users' settings. 

The System Landscape Directory (SLD) logs on the Windows machine: C:\ProgramData\SAP\SAP Business 

One\Log\SAP Business One ServerTools\System Landscape Directory. 

10.6 Database Authentication 

The default user name of the database administrator is sa and it has full authorization. Therefore, you must 

assign a strong sa password, even on servers that are configured to require Microsoft Windows Authentication. 

This ensures that a blank or weak sa password is not exposed. 

A strong password is the first step to securing your system. A password that can be easily guessed or 

compromised using a simple dictionary attack makes your system vulnerable. A strong password has the 

following characteristics: 

• Contains alphabetic, numeric, and special characters 

• Is at least seven characters in length 

• Is NOT a common word or name 

• Does NOT contain a name or user name 

• Is significantly different from previous passwords 

Procedure 

To set the password for the sa logon, do the following: 

 Log on to the server as a domain or local Windows Administrator. 

 In Windows, choose Start → All Programs → Microsoft SQL Server <Version> → SQL Server Management 

Studio. Upon first logon, in the Connect to Server window, enter the server name (if required) and under 

Authentication, select Windows Authentication. 

 Note  

We recommend that you create another superuser account with the same authorization as the sa user. 

 In the Object Explorer window, under the SQL Server instance, expand Security →Logins. Right-click sa and 

choose Properties.  

 On the General page, enter and confirm the new password for the sa login. 

 Choose OK and close the SQL Server Management Studio window. 
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 Caution  

To prevent dictionary attacks, create a substitute user for sa that can take daily responsibility for the SQL 

Server database assessment. For more information, see Setting Up an Alternative Admin User.  

10.7 SAP Business One Authentication and Authorization 

SAP Business One has a mechanism to protect the database from easy changes through direct access. 

The advantages of restricting access to the SAP Business One database are: 

• End users are not exposed to database credentials and so cannot change the databases directly, which 

protects the databases from being changed or attacked. 

• Database credentials are stored in the license server and end users can access the database only after the 

application performs a successful site user authentication through the System Landscape Directory. 

 Restricting Database Access 

SAP Business One has a mechanism to protect the database from easy changes through direct access. 

The advantages of restricting access to the SAP Business One database are: 

• End users are not exposed to database credentials and so cannot change the databases directly, which 

protects the databases from being changed or attacked. 

• Database credentials are stored in the System Landscape Directory (SLD) database and end users can 

access the database only after the application performs a successful site user authentication through the 

System Landscape Directory. 

The System Landscape Directory is the central repository for credentials information, including the database user 

ID and password (one for all SAP Business One users). 

The database credentials are stored safely in the SLD database, with additional encryption. 

The security workflow is as follows: 

 Database consumers, such as the SAP Business One client, DI-API, and Services, provide their SAP Business 

One credentials (SAP Business One user ID and password) to authenticate against the SLD. 

 Following successful authentication, the SLD supplies its credentials and SAP Business One uses them to 

connect. 

For more information, see Technical Landscape.  

 Note 

You can use the SLD service to create different database user accounts for each company database. 

After creating accounts, SAP Business One does not access company databases using the database 

administrator account. Instead SAP Business One uses a different read-only account supplied by the SLD 

service to access each company database.  
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 Changing Security Levels 

You can apply different security levels to database access through the SLD: 

 To access the SLD service, in a Web browser, navigate to the following URL: 

https://<Server Address>:<Port>/ControlCenter 

 In the logon page, enter the site user name (B1SiteUser) and password, and then choose Log On. 

 Note 

The site user name is case sensitive. 

 On the DB Instances and Companies tab, select the appropriate server. 

 The companies that are registered on the server are displayed in the Companies area. 

 In the Companies area, select the company for which you want to define the security level and choose Edit. 

 In the Edit Company window, select one of the following options and choose OK: 

o Use Specified Database User: The system automatically generates a set of database users without 

administrator privileges. SAP Business One accesses the database using one of the database users, 

depending on the specific database transaction. 

o Use Specified Database User for Each Business One User: Most secure and recommended. The system 

automatically generates a set of database users without administrator privileges for each SAP Business 

One user. SAP Business One accesses the database using one of the database users, depending on the 

login SAP Business One user and the specific database transaction. 

o Whenever a new SAP Business One user is added, a set of corresponding database users is added.  

• For the second and third options, you do not have to manually create a read-only database user for queries.  

 Note 

If you select the second or the third option, the read-only database users that are automatically created 

by the System Landscape Directory do not have read-only authorization for the system database 

SBOCOMMON. 

But if you upgrade SAP Business One from a lower version to SAP Business One 9.3 PL00, the specific 

privileges for SBOCOMMON cannot be revoked automatically. For security reasons, we recommend that 

you delete the database user manually. Thus, the System Landscape Directory will create a new read-only 

database user. 

 Caution 

Do not change the names or system privileges of the automatically-created database users. 

 If you selected the second or third option, you can configure the SLD service to automatically change the 

password of the automatically-created database users on a regular basis, as follows: 

 On the Security Settings tab, in the Authentication area, select the checkbox Change Database User 

Password Every <Number> Days. 

 Enter the number of days between password resets. 

 Choose Update. 
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10.8 Application Security 

SAP Business One provides features to ensure that unauthorized access to the application does not occur. 

 B1_SHR Folder Permissions 

The SAP Business One server installation process creates the B1_SHR folder, which contains the SAP Business 

One client setup files. 

User SBO_SHR Permission 

Power User Modify and Write 

User Read and execute 

List folder contents 

Read 

 Queries 

The query wizard and query generator enable you to define queries on the SAP Business One database. These 

tools are designated for SELECT sentences only and cannot be used for any kind of update operation. To protect 

your data, we recommend that you make sure users have the appropriate permissions. However, the data results 

returned are not filtered according to the user’s authorization. 

Granting Read-Only Authorization for Query Results 

To enable an SAP Business One user to view the results of both system and user-defined queries, you can directly 

grant the user full authorization to the Execute Non-select SQL Statement permission item in the General 

Authorizations window in the SAP Business One client application (Main Menu → System Initialization → 

Authorizations → General Authorizations).  
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However, we recommend that you grant read-only authorization to all non-superusers in one of the following 

ways: 

• [Recommended] Do the following: 

 Configure SAP Business One to access your company using database users without administrator 

privileges. 

 Grant No authorization to all non-superusers in the General Authorizations window. 

This way, users with No authorization to the Execute Non-select SQL Statement authorization item can 

access the database only through a read-only database user. 

• If you configure SAP Business One to access your company using a database administrator user, do the 

following: 

 Apply No authorization to all users to the Execute Non-select SQL Statement item. 

 Create a read-only database user and define the user password. 

 Assign the database user to the company in the Read-Only DB User window in the SAP Business One 

client application. For more information, see the SAP Business One online help. 

 Add-On Access Protection 

When you install an add-on, SAP Business One creates a unique digital signature using the MD5 technique 

(message-digest algorithm). SAP Business One identifies the add-on by validating its digital signature. 

 Dashboards 

Dashboards are an element of the cockpit, which is delivered as part of SAP Business One. They present an easy-

to-understand visualization, such as a bar or pie chart, of transactional data from the SAP Business One database. 

With SAP Business One, SAP delivers predefined dashboards for financials, sales, and service. In addition, SAP 

Business One partners and customers can create their own dashboards. 
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 Recommendation  

When you receive dashboard content from your partner, we recommend that you copy this content to a 

computer that has a state-of-the-art virus scanning solution with the most current virus signature 

database installed and scan the file for infections before uploading it to the server. 

 Security Information for Integration Solutions 

The subsections below outline the security aspects related to the following solutions: 

• DATEV-HR solution 

• Mobile solution 

• Request for quotation (RFQ) 

10.8.5.1 Security Aspects Related to the DATEV-HR Solution 

This scenario requires maximum levels of data security and sensitivity, because it exports personal data. The 

DATEV-HR scenario generates employee data for DATEV eG using SAP Business One data. The integration 

framework writes the data to a specified directory in the file system. Make sure that only authorized persons have 

access to the folder. 

Ensure that only authorized persons have access to the integration framework administration user interfaces. 

Alternatively, collect confirmations from all users who have access that they are aware that this data is sensitive, 

and that they may not distribute any data to third parties or make data accessible to non-authorized persons. 

10.8.5.2 Security Aspects Related to the Mobile Solution 

After the mobile user enters the correct user name and password, the front-end application passes the mobile 

phone number and mobile device ID (MAC address), together with the user name and password, to the integration 

framework. 

After receiving the information, the integration framework verifies the following: 

• Whether the user is enabled as a mobile user 

• Whether the necessary license is assigned to the user 

• Whether it can find the telephone number and device ID pair in the SAP Business One user administration 

• Whether the user name matches the telephone number and the device ID 

• Whether the user has been blocked by the SAP Business One system 

• Whether the provided password is correct 

Only then is the user allowed to access the system. 

The password is encrypted while it is transmitted to the integration framework, which decrypts the password after 

receiving it. 
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Using HTTPS 

To make communication safer, you have the option to use HTTPS for the sessions in the integration framework. 

On the server side you can configure the communication protocol (HTTP or HTTPS). On the client side, you have 

the option to switch to the HTTPS protocol. By default, the solution runs with HTTPS, and the integration 

framework allows incoming calls through HTTPS only.  

SAP Business One mobile apps require a valid SSL certificate. For more information about obtaining and installing 

valid certificates, see SAP Note 2019275 . 

License Control 

All mobile users have to be licensed before being allowed to access the SAP Business One system through the 

mobile channel. License administration is integrated with the SAP Business One user and license. 

The mobile user also needs the assignment of the B1i license. Authorization within the SAP Business One 

application depends on the user’s SAP Business One application license. 

10.8.5.3 Security Aspects Related to the Integration with SAP 
Customer Checkout 

All connections between SAP Customer Checkout and the integration framework are http connections that can be 

secured. The system landscape directory entries related to SAP Customer Checkout are 001sap0011 and 

001sap0013, configured using basic authentication with user name and password. 

The technical connection to the SAP Customer Checkout monitor (001sap0013) is an http connection using basic 

authentication. 

10.8.5.4 Security Aspects Related to the RFQ Scenario with 
Online Quotation 

 Note 

The configuration information for the RFQ integration solution is available in the integration framework. 

To access the documentation, log on to the integration framework, choose Scenarios → Control, and for 

the sap.B1RFQ scenario package, choose Docu. 

You must provide vendors included in the RFQ process access to the online purchasing document on the 

integration framework server. 

You can accomplish this by restricting access to the server to a minimum. To restrict access to the server, 

configure the network (NAT) firewall as shown below: 

• Only allow external access to the particular hostname / IP-address 

• Only allow external access to the configured server port. 

Default: port 8080 for HTTP, or port 8443 for HTTPS 

https://launchpad.support.sap.com/#/notes/2019275
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• If applicable and available for the particular firewall, configure the restricting URL: 

http://<hostname>:<portnumber>/B1iXcellerator/exec/ipo/vP.0010000100.in_HCSX/com.sap.b1i.vplatfor

m.runtime/INB_HT_CALL_SYNC_XPT/INB_HT_CALL_SYNC_XPT.ipo/proc? 

10.9 Security Solutions for Microsoft SQL Server and Database 
Tips 

We recommend that you take the following actions to ensure the security of your Microsoft SQL Server. 

 Upgrading Microsoft SQL Server 

We recommend upgrading the SQL server to the latest service pack. Furthermore, administrators should 

regularly consult the SQL Server Security Center at www.microsoft.com. 

Note 

If the existing version of SAP Business One does not support the newer SQL version, you must upgrade 

SAP Business One before upgrading the Microsoft SQL Server.  

For information about the upgrade sequence for Microsoft SQL Server, see the following documents: 

•  SAP Note 928839 

• "Hardware and Software Requirements for Installing SQL Server 2014" as stipulated by Microsoft® Corp 

 Securing Microsoft SQL Server  

Since SAP Business One is a two-tier application, much of the application security depends on the database 

server security and on the authorization mechanism. Be aware that users can access the database using tools 

other than SAP Business One and, therefore, can modify the logon information. To secure your database, we 

recommend adhering to Microsoft security guidelines. For more information, see the Microsoft documents at 

www.microsoft.com. 

10.9.2.1 Setting Up an Alternative Admin User  

If you are using SQL authentication, when you register a database server in the SLD (9.0 and higher) or license 

server (release family 8.8), you need to specify a database admin user for the server. This alternative admin user 

can be used for creating and upgrading companies and performing other landscape management tasks in the 

SLD.   

http://www.microsoft.com/
https://launchpad.support.sap.com/#/notes/928839
http://msdn.microsoft.com/en-us/library/ms143506.aspx
http://www.microsoft.com/


 

146 

CUSTOMER  

© 2019 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Managing Security in SAP Business One 

 

Procedure 

To create an alternative admin user account for maintaining administration tasks for SAP Business One, do the 

following: 

 In Windows, choose Start → All Programs → Microsoft SQL Server <Version> → SQL Server Management 

Studio. 

 In the SQL Server Management Studio Object Explorer window, choose Security → Logins. 

 Right-click the Logins folder and choose New Login.  

The Login - New window appears. 

 On the General tab, select SQL Server authentication and enter a strong password. 

 On the Server Roles tab, select sysadmin. 

 Choose OK. 

When you create a company database, we recommend that you enable the database user per company in SLD. To 

do so, perform the following: 

 Log on to the SLD service. For more information, see Logging on to the System Landscape Directory Control 

Center. 

 Select the appropriate server and company and then choose Edit.  

 

 In the Edit Company window, select the Use Specified Database User radio button.  

 The SLD creates a database user for this company with the appropriate database roles, which is then used by 

the SAP Business One client to connect to the database.  

 Choose OK. 
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If you are using Microsoft Windows authentication, you must grant SAP Business One admin users the sysadmin 

and public server roles. When creating or upgrade companies, you must use this admin user to launch the SAP 

Business One client or setup wizard. 

For normal SAP Business One users, you need to grant admin users the following roles:  

• For the common database: db_datawriter and db_datareader  

• For the company database: db_owner  

 Note  

You cannot set up a local user that is not in the Active Directory. 

 Revoking Guest Access to the msdb Database 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

<Version>. 

 In the Connect to Server window, specify values in the Server name and Authentication fields, and choose 

Connect. 

 In the window SQL Server Management Studio Object Explorer, choose Databases → System Databases → 

msdb → Security → Users. 

 In the structure, right-click the Guest user and choose Delete. 

10.10 Data Protection and Privacy 

Data protection is associated with numerous legal requirements and privacy concerns. In addition to compliance 

with general data protection acts, it is necessary to consider compliance with industry-specific legislation in 

different countries. This section describes the specific features and functions that SAP provides to support 

compliance with the relevant legal requirements and data privacy. 

This section does not give any advice on whether these features and functions are the best method to support 

company, industry, regional or country-specific requirements. Furthermore, this guide does not give any advice or 

recommendations with regard to additional features that would be required in a particular environment; decisions 

related to data protection must be made on a case-by-case basis and under consideration of the given system 

landscape and the applicable legal requirements. 

 Note 

In the majority of cases, compliance with data privacy laws is not a product feature. 

SAP software supports data protection by providing security features and specific data-protection-

relevant functions such as functions for the simplified blocking and deletion of personal data. 

SAP does not provide legal advice in any form. 

SAP Business One provides the related functions to ensure that all users’ rights are protected and that customers 

are enabled to achieve data protection and privacy compliance. The following topics are related to data 

protection: 

Access control: Authentication features as described in the section User Administration and Authentication. 
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Authorizations control: As described in How to Manage the Protection of Personal Data in SAP Business One on 

SAP Help Portal. 

Communication security: As described in the Network and Communication Security section. 

Data storage security: We recommend that you use the high availability solution for the SQL server environment.  

 For more information about SAP Business One data protection and privacy, see How to Manage the Protection of 

Personal Data in SAP Business One on SAP Help Portal. 

10.11 Other Security Recommendations 

You can check the following information to identify if you securely operate the SAP Business One application. 

Demo Database 

The demo databases (schemas) provided are not for productive use. Do not use the demo databases (schemas) 

in a productive environment.  

If you install the demo databases (schemas), log on with manager account and change the default password 

immediately for each demo database (schema). 

Post-Uninstallation Activities 

Immediately after uninstalling SAP Business One, you are required to manually delete the SAP Business One 

folders on Windows to avoid leaking any data. 

Operating System 

• Keep the boundaries between client components. Restrict end user access to the operating system on 

servers. 

• Protecting the high privileged accounts of the operating system is top priority. 

Log Configuration 

For troubleshooting purposes, sometimes you need to turn on the detailed log or debugging log in configuration. 

Once the troubleshooting is completed, ensure that you change back the settings and delete the debugging logs. 

Turn off the Default UI API Connection String 

In a productive environment, we strongly recommend that you turn off the default UI API connection string on 

presentation servers (the terminal servers installed on the SAP Business One client). For more information, see 

SAP Note 2755830. 

https://help.sap.com/viewer/index
https://help.sap.com/viewer/index
https://launchpad.support.sap.com/#/notes/2755830
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Shared Folder 

We recommend that you provide anti-virus protection for the shared folder, either at the server-level or at the 

company-level. 
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11 Troubleshooting 

Delay in Establishing a Connection with the License Service 

Problem: 

You have difficulty establishing a connection with the license service. This issue may lead to the workflow service 

not working (error message: "Failed to connect company from workflow service"). For more information, see SAP 

Note 1135705. 

Solution 1: 

 Change the registry entry and add the IP address of the license server computer as follows:  

o For 32-bit operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\ACE\TAO 

o For 64-bit operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ACE\TAO 

 Use the IP address instead of the computer name for the license server address where required, such as for 

the SAP Business One client, DI API, B1i, and so on. 

Solution 2 

 In the Control Panel, disable additional network cards. 

 Ensure there is no dial-up interface or VPN interface configured. 

 Restart the server. 

Note that you can re-enable the additional network card after restart. This will resolve the issue until the next 

restart.  

https://launchpad.support.sap.com/#/notes/1135705
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12 Getting Support 

We recommend that you assign a contact person who can deal with issues concerning SAP Business One. This 

contact person should follow the support process described below.  

 Note  

Before you request support, check the version information of your SAP Business One application. 

To view the version number, from the SAP Business One Help menu, choose About. 

As a customer, you can get support from your partner either by creating an incident on the Support Launchpad 

for SAP Business One or by using the support channels provided by your partner. 

The partner support staff tries to solve your problem. If they are unsuccessful, they forward the incident that you 

have created on the Support Launchpad for SAP Business One to the SAP Support team, or create an incident for 

you if you used an alternative support channel. 

12.1 Using Online Help and SAP Notes 

If you have a question or problem concerning SAP Business One, check the online help by pressing F1 . Note that 

the Help menu in the application provides more help options. 

If online help does not provide an answer, search for corresponding SAP Notes, as follows: 

 Log on to the Support Launchpad for SAP Business One by any of the following options: 

o Go to the Website directly using https://apps.support.sap.com/B1support/index.html. 

o In the SAP Business One menu bar, choose Help →Support Desk → Support Launchpad and Note Search. 

 Note 

To gain access to the Support Launchpad for SAP Business One, you must be an SAP Business One 

customer or partner, and you need an S-user account. If you do not have an S-user account, contact your 

SAP Business One partner. 

 On the What are you looking for? area, choose SAP Notes Search. 

You can either display a note directly by providing the number of the note, or you can search for a note by 

entering key words. Think about the keywords to use and choose the application area. 

The application area for SAP Business One starts with “SBO”. 

 Example 

Problem Message: “The performance of the SAP Business One program is not acceptable. Executing all 

operations takes a long time. The problem occurs only on one front-end.” 

Use: Keywords Performance and SAP Business One. Specify the component SBO-BC*. 

Do not use: Phrases such as SAP Business One runs long or SAP Business One is too slow. 

 

 

https://apps.support.sap.com/B1support/index.html
https://apps.support.sap.com/B1support/index.html
https://apps.support.sap.com/B1support/index.html
https://apps.support.sap.com/B1support/index.html
https://apps.support.sap.com/B1support/index.html
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Appendix 

Appendix 1: List of Default Ports for Different Server Components 

The following table lists the default ports used for different server components. Ensure that you have kept the 

following ports available. 

Default Ports Server Components Remarks 

30000 or 30001 CORBA license server  

40000 Components in shared Tomcat, including: 

• System Landscape Directory 

• License Service (HTTPS) 

• Job Service 

• Extension Manager 

This port should be exposed to the 

Internet if you need to use some SAP 

Business One components on Internet. 

60000 Workflow  

443 Reverse proxy  

8080 (for HTTP) 

8443 (for HTTPS) 

Integration Framework  
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